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준비할 품목

본 제품을 사용하기 전에 다음을 준비하십시오.

• 보호 장비(안경 및 장갑)
유지보수를 수행할 때는 보호 장비를 사용하십시오. 꼭 자신에게 꼭 맞는 사이즈를 사용하십시오.

• 무수 에탄올 또는 이소프로필 알코올
인쇄물의 기름 제거 및 UV-LED 램프 청소에 사용됩니다.

• 천(솜털이 없는 것)
기기 청소, 인쇄물 기름 제거, UV-LED 램프 청소에 사용됩니다.

• 노즐 검사 시험지
프린트 헤드의 노즐 드롭아웃 테스트에 사용됩니다.

• 마스킹 테이프
물체를 고정하고 잉크 미스트를 방지하기 위한 마스킹 테이프로 사용됩니다. 스마트폰 카메라를 사용
하여 인쇄 위치를 지정할 때 정렬 마커를 인쇄하는 데에도 사용됩니다.

• 정전기 제거 브러시, 정전기 제거 천 및 기타 정전기 제거 도구
온도와 습도가 낮거나 보호 필름을 제거한 상태로 인쇄할 때 등 물체에 정전기가 있을 때 사용됩니다.

관련된 링크

・ P. 174 UV-LED 램프 청소
・ P. 27 노즐 드롭아웃 테스트
・ P. 77 정렬 마커 인쇄

소개
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이런 아이템에 인쇄 할 수 있습니다.

이 기기를 사용하여 아래와 같이 인쇄할 수 있습니다. 또한 인쇄 데이터 디자인부터 인쇄까지의 단계를 안
내해 드리므로 이 기기를 사용할 때 이 섹션을 참고로 참조하십시오.

화장품 케이스

인쇄까지의 절차: 화장품에 인쇄하기(P. 89)

골프공

인쇄까지의 절차: 골프공에 인쇄하기

스마트폰 케이스

인쇄까지의 절차: 스마트폰 케이스에 인쇄하기(P. 103)

아크릴 스탠드

인쇄까지의 절차: 아크릴 스탠드에 인쇄하기(P. 110)

소개
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본 기기의 특징

이 기기는 UV 잉크를 사용하며, 인쇄 후 UV 광선을 조사하여 잉크를 경화 및 접착시킵니다.
플랫 테이블을 사용하여 얇은 종이부터 두꺼운 물체까지 다양한 물체에 인쇄할 수 있습니다. 이 기기에는 
UV 잉크 냄새를 줄이기 위한 냄세제거제도 장착되어 있습니다.
일반 프린터와의 차이점은 다음과 같습니다.
• 프린트 헤드 캐리지와 플랫 테이블이 움직입니다.

프린트 헤드 캐리지(A)는 왼쪽에서 오른쪽으로(S: 스캔 방향) 이동하고 플랫 테이블(B)은 앞뒤로(F: 
피드 방향) 이동하여 인쇄합니다. 플랫 테이블이 상하로 움직여 인쇄면(높낮이 방향)을 조정합니다. 
단, 경사진 인쇄면에서는 높이를 변경하면서 인쇄할 수 없습니다.

• 인쇄면의 높이와 인쇄 위치를 설정할 수 있습니다.
헤드 갭 센서(A)는 플랫 테이블 위에 놓인 물체의 높이를 감지한 후 인쇄면의 높이(플랫 테이블의 높낮이 
위치)를 조정하여 고화질과 안전한 인쇄를 보장합니다. 포인터(B)를 사용하여 인쇄 영역을 정확하게 지
정할 수도 있습니다.

소개
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잉크의 특징

이 기기는 ECO-UV(EUV5) 잉크와 프라이머를 사용하여 인쇄합니다. 이 섹션에서는 해당 기능을 설명합니다.

ECO-UV(EUV5) 잉크의 특징
이 프린터는 ECO-UV(EUV5) 잉크를 사용합니다. ECO-UV(EUV5) 잉크는 자외선에 의해 물체에 순간
적으로 경화됩니다. 이를 통해 기존 잉크로는 인쇄하기 어려운 소재*1에 인쇄할 수 있습니다. 이 프린터에
는 5가지 색상(CYAN, MAGENTA, YELLOW, BLACK, WHITE)의 잉크 유형과 프라이머가 있습니다.

프라이머의 특징

프라이머는 잉크 베이스로 사용되는 무색 투명한 코팅제입니다. EUV-5 잉크로 인쇄하기 어려운 소재에도 
잉크 접착력이 향상될 수 있습니다.
일반적으로 잉크가 접착되기 어려운 소재는 다음과 같습니다.
• 금속
• PET (폴리에틸렌 테레프탈레이트)
• PP (폴리프로필렌)
• PE (폴리에틸렌)
• 실리콘
• 아크릴
• 유리

이 중 잉크는 프라이머를 사용하면 금속, PET, 아크릴, 유리에 더 잘 접착됩니다. 그러나 유리 코팅, 발수 
처리, 얼룩 방지 처리 등으로 표면을 코팅하거나 칠하면 접착력이 향상되기 어렵습니다.
프라이머가 효과적인 소재인 것처럼 보이더라도 소재 표면의 가공이나 처리를 식별하는 것은 어렵습니다. 
잉크 접착력을 확인하려면 반드시 실제 물체에 테스트 인쇄해 보십시오. 프라이머의 효과를 먼저 확인하지 
않고 실제 인쇄를 진행하지 마십시오.

*1 일부 소재 및 표면 마감재에는 인쇄할 수 없습니다.

소개

10 기본 정보 



각 부의 명칭 및 기능

전면

상단

No. 이름 기능 개요

전면 커버

기기가 작동 중일 때 프린트 헤드 캐리지 및 기타 빠르게 움직이
는 부품과의 신체의 충돌을 방지합니다.
이 커버는 또한 먼지 유입을 줄이고 자외선과 냄새를 차단합니
다. 물건을 놓거나 유지보수를 수행할 때를 제외하고는 닫아 두
십시오.

잉크 슬롯 잉크 카트리지가 이 슬롯에 삽입됩니다.

헤드 갭 센서 인쇄할 물체의 높이를 감지합니다.

냄세제거제 UV 잉크 냄새를 제거합니다.

유지보수 커버

드레인 팩 교체, UV-LED 램프 청소, 옵션 항목(OA-RA-8) 제
거 및 설치 시 유지보수 커버를 제거하십시오. 열어야 할 경우를 
제외하고는 닫아 두십시오.

서브 전원 버튼 기기의 서브 전원을 켜거나 끕니다.

긴급 정지 버튼 이 버튼을 사용하면 기기가 의도하지 않은 작업을 수행할 때 즉시
기기를 정지할 수 있습니다.

UV-LED 램프 잉크를 경화시키는 데 사용되는 UV 광선을 조사합니다.

프린트 헤드 캐리지 프린트 헤드는 이 캐리지 안에 있습니다.

포인터 인쇄 원점이나 인쇄 영역을 표시하는 LED 포인터로 플랫 테이블 
방향으로 조사됩니다.

소개
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하단

[A] [B]

[A]: 기본 위치 [B]: 수동 헤드 클리닝 위치

No. 이름 기능 개요

펠트 와이퍼 와이퍼 작동 후 프린트 헤드 가장자리를 청소합니다. 
프린트 헤드 가장자리의 잔여 잉크와 먼지를 흡수합니다.

와이퍼 프린트 헤드를 청소합니다.
프린트 헤드에서 먼지와 과도한 잉크를 제거합니다.

스크래퍼 와이퍼에 묻은 잉크와 먼지를 제거합니다.

캡탑 프린트 헤드가 건조되는 것을 방지합니다.
인쇄를 기다리는 등 프린트 헤드 캐리지가 기기 오른쪽에 있을 때 
잉크가 분사되는 표면을 보호하기 위해 프린트 헤드를 밀봉합니
다.

플랫 테이블 인쇄할 소재를 배치하는 테이블

드레인 카트리지 배출된 잉크가 모아지는 장소 입니다.
이 카트리지의 드레인 팩에 배출된 폐 잉크가 가득 차면 팩을 교
체하라는 메시지가 유틸리티 창에 나타납니다. 이 메시지가 나
타나면 드레인 카트리지의 드레인 팩을 교체하십시오.

플랫 테이블이나 기기 내부(카트리지 슬롯 제외)에 손을 놓거나 만지지 마십시오.
화상을 입을 수 있습니다.

주의

플랫 테이블 앞이나 뒤에 물건을 올려놓지 마십시오.
플랫 테이블은 수평 및 수직으로 움직입니다. 플랫 테이블과 기기 사이에 물체가 있을 경우, 이에 걸려 기기가 오작동할 
수 있습니다.

주의

소개
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측면

No. 이름 기능 개요

이더넷 연결부 이더넷 케이블을 연결하는 데 사용합니다.

메인 전원 스위치 기기의 메인 전원을 켜거나 끕니다.

전원 케이블 연결부 기기에 전원을 공급하는 전원 케이블을 연결하는 데 사용됩니다.

소개
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수동 헤드 클리닝 도구

No. 이름 기능 개요

수동 헤드 클리닝 도구 본체(고정부) 수동 헤드 클리닝 시 기기에 장착하십시오.

클리닝 부(움직이는 부분) 클리닝 스틱을 장착하여 수동 헤드 클리닝을 할 때 움직이는 부품
입니다.

패드 클리닝 스틱에서 떨어지는 클리닝 액이나 배출된 액체를 흡수합
니다.

수동 헤드 클리닝 도구 고정 나사 수동 헤드 클리닝 도구를 기기에 고정합니다.

물체에 부딪히거나 떨어져서 변형된 경우 수동 헤드 클리닝 도구를 사용하지 마십시오. 이런 경우에서는 이 도구를 교체
하십시오.
변형된 수동 헤드 클리닝 도구를 사용하면 수동 헤드 클리닝이 정상적으로 작동되지 않거나 기기가 손상될 수 있습니다.

IMPORTANT

• 사용하지 않을 때는 수동 헤드 클리닝 도구를 냄세제거제 앞에 두는 것이 좋습니다.
• 분실 방지를 위해 수동 헤드 클리닝 도구 고정 나사를 그림에 표시된 위치에 보관하는 것이 좋습니다.

MEMO

소개
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서브 전원 버튼의 램프로 표시되는 기기의 상태

기기 상태는 서브 전원 버튼 색상과 깜박이는 패턴으로 표시됩니다. 서브 전원 버튼을 이용하면 멀리서도 
기기의 상태를 확인할 수 있습니다.

램프 기기 상태

꺼짐 전원 꺼짐

녹색 점등 인쇄 중

파랑색 점등 유지보수 작업 중과 같이 소재가 설정되지 않았습니다.

파랑색 점멸
기기가 시작 중이거나 절전 모드에 있습니다.

노랑색 점등 소재 설정이 완료되었으며 인쇄할 준비가 되었습니다.

노랑색 점멸
기기가 일시 중지되었습니다.

빨강색 점등 기기에 이상이 발생하거나 비상정지 버튼을 눌렀을 때 점등됩니다.

소개

기본 정보  15



인쇄할 개체

본 설명서에서는 인쇄할 개체를 "소재" 또는 "미디어"라고 합니다. 이 기기는 얇은 종이부터 두꺼운 소재
까지 다양한 물체에 인쇄할 수 있지만, 물체와 관련하여 고려해야 할 몇 가지 사항이 있습니다.

설정할 수 있는 개체

기기에 설정할 수 있는 개체의 조건은 다음과 같습니다.

크기와 무게
인쇄 가능 범위는 설정하려는 인쇄 가능 개체와 다릅니다. 인쇄 가능 영역보다 큰 개체를 설정할 수 있습
니다.

W

L

최대 크기

너비 (W) 240 mm (9.45 in.)

길이 (L) 178 mm (7.01 in.)

두께 102 mm (4.02 in.)*1

최대 중량 3 kg (6.61 lb.)

*1 • 옵션인 로터리 축 유닛을 사용하는 경우는 제외됩니다.
• 물체에 따라 최대 107 mm (4.21 in.)까지 인쇄가 가능할 수 있습니다.

소재, 모양 및 유사 매개변수
이 기기는 다양한 소재에 인쇄할 수 있지만 최종 인쇄를 인쇄하기 전에 테스트 인쇄를 한 다음 잉크 접착력
을 확인하십시오. 또한, 프린트 헤드를 보호하고 인쇄 품질을 보장하기 위해 다음 물체에는 인쇄할 수 없습
니다.
• 거울, 스테인레스 스틸 등 자외선을 반사할 가능성이 있는 물체

이러한 물체는 프린트 헤드 표면의 경화를 촉진하므로 사용할 수 없습니다.
• 정전기가 발생하는 물체

정전기로 인해 잉크가 튀게 되어 인쇄 결과와 프린트 헤드에 부정적인 영향을 미칠 수 있습니다.
• 인쇄 표면의 요철이 심한 물체

프린트 헤드와 인쇄 표면 사이의 거리가 멀수록 인쇄 결과는 더 나빠집니다. 가장 높은 인쇄 표면과 가장
낮은 인쇄 표면의 차이는 약 2 mm (0.08 in.) 이하여야 합니다.

• 쉽게 움직이는 물체
물체(A)가 제자리에 단단히 고정되지 않으면 헤드 갭 센서(B)가 높이를 올바르게 감지할 수 없습니다.
인쇄할 물체를 제자리에 단단히 고정하십시오. 미디어가 움직이면 마스킹 테이프나 이와 유사한 것을 사
용하여 미디어를 제자리에 고정할 수 있습니다.

소개
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A B
• 부드러운 소재로 만들어진 물체

물체(A)가 부드러운 소재로 만들어진 경우 헤드 갭 센서(B)에 가해지는 압력이 너무 약합니다. 이로
인해 높이가 올바르게 감지되지 않습니다.

A B

인쇄할 물체의 종류와 설치 방법에 따라 높이가 올바르게 설정되지 않을 수 있습니다. 잘못된 설치 방법으로 인쇄를 하거
나, 부적절한 소재에 인쇄를 하면 기기가 오작동할 수 있습니다.

IMPORTANT

소개
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인쇄 가능 영역

최대 인쇄 가능 영역은 다음과 같습니다.

W

L

너비 (W) 210 mm (8.2 in.)

길이 (L) 148 mm (5.83 in.)

높이 0 - 102 mm (0 - 4.02 in.)*1

앞/뒤/왼쪽/오른쪽 인쇄 영역

플랫 테이블의 흰색 테두리 내의 영역은 대략적인 최대 인쇄 영역입니다. 기기는 플랫 테이블의 오른쪽 하단
을 0점(A)으로 사용하고 S: 스캔 방향으로 0 mm (0 in.), F: 피드 방향으로 0 mm (0 in.)를 사용합니다. 플
랫 테이블의 왼쪽 상단 모서리(B)는 S: 210 mm (8.26 in.), F: 148 mm (5.82 in.)이며, 이 두 지점 사이의 
영역이 최대 인쇄 영역입니다.

S:Scan

F:Feed

유틸리티에 설정된 S와 F는 플랫 테이블의 좌표를 나타냅니다. 인쇄 원점(C)과 왼쪽 위 모서리(D)를 기준으
로 설정된 인쇄 영역은 "W" (S 방향 길이)와 "L" (F 방향 길이)로 표시됩니다. 다음 그림의 경우 C (S: 110 
mm [4.33 in.], F: 70 mm [2.76 in.]) 및 D (S: 210 mm [8.27 in.], F: 148 mm [ 5.83 in.])을 사용하는 
경우 인쇄 영역은 W: 100 mm (3.93 in.) 및 L: 78 mm (3.07 in.)입니다. 설정 가능한 최소 인쇄 영역은 W: 
25.4 mm(1 in.) 및 L: 25.4 mm (1 in.)입니다.

소개
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W

L

높이 방향의 인쇄 영역

인쇄 영역은 개체의 가장 높은 인쇄 위치(a)에서 2 mm (0.08 in.)(b) 이내입니다. 2 mm (0.08 in.) 이하의 
인쇄 위치(c)는 인쇄 품질이 낮기 때문에 권장되지 않습니다.

ba

c

그러나 인쇄 시 설정에 따라 인쇄 품질이 향상될 수 있습니다. 인쇄면의 높이를 기준으로 다음을 설정합니다.

• [General] 또는 [Text Decoration]: 인쇄면의 높이 차이가 2 mm 이내입니다.
• [General Distance]: 인쇄된 표면 높이의 2 mm ~ 6mm (0.08 in. ~ 0.23 in.) 차이(인쇄에 Wh가 
    포함된 경우 2 mm ~ 4 mm [0.08 in. ~ 0.15 in.])

소개
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개체 및 인쇄 데이터의 방향

인쇄 데이터는 180˚회전된 데이터로 인쇄됩니다. 기기에 개체를 설치할 때 인쇄 데이터를 기준으로 개체를 
180˚회전시킵니다.

인쇄 데이터 개체 (인쇄 후)

소개
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지그 사용을 고려하기

물체와 프린트 헤드 사이의 거리가 멀어질수록 잉크 미스트가 날릴*1 가능성도 높아집니다. 따라서 인쇄할 
물체의 크기와 모양에 따라 지그가 필요할 수 있습니다. 다음 조건 중 하나를 충족하는 경우 지그를 준비하
십시오.
지그를 구하기 어려운 경우, 물체의 측면이 잉크 미스트로 오염되지 않도록 마스킹 테이프 등으로 덮어 주십
시오.

개체만 있는 경우 인쇄할 데이터 부분의 앞/뒤 및 왼쪽/오른쪽 모두 40 mm (1.57 in.) 영역에 여백이 확보되지 
않는 경우

프린트 헤드 데이터 영역

인쇄할 개체 여백: 40 mm (1.57 in.) 이상

지그 실제 인쇄 표면과 높이 차이가 2 mm (78.7 mil) 미만

물체 표면의 높이 변화가 2 mm (0.08 in.) 이상인 경우

프린트 헤드 데이터 영역

인쇄할 개체 여백: 40 mm (1.57 in.) 이상

지그 실제 인쇄 표면과 높이 차이가 2 mm (78.7 mil) 미만

*1 잉크의 미세한 입자가 인쇄 영역 이외의 영역에 뿌려집니다.

소개
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개체(미디어) 등록 항목
개체를 설정하려면 다음 항목을 설정하십시오.

개체 유형
[Transparent] 또는 [Opaque] 중에서 선택합니다. 유색 투명 물체의 경우 다음 기준에 따라 선택하십시오.

• [Transparent]: 물체의 반대편에 있는 손이 물체를 통해 보입니다.
• [Opaque]: 물체의 반대편에 있는 손은 물체를 통해 볼 수 없습니다.

[Transparent] 및 [Opaque] 선택은 자동 유지보수에 영향을 줍니다. 표준 설정 [Transparent]은 [Opaque]보다 프린트 
헤드를 보호하기 위해 더 자주 유지보수*1가 필요하므로 더 많은 잉크를 소모합니다. [Transparent]/[Opaque]를 적절하
게 선택하면 잉크 소모를 줄이고 인쇄 품질 저하를 방지할 수 있습니다.

IMPORTANT

플랫 테이블 높이
높이 방향으로 인쇄 위치를 설정합니다.

인쇄 원점
기준 인쇄 위치가 될 지점을 설정합니다. 다음 중 하나를 선택하십시오.
• [Origin Relative]: 인쇄 영역의 오른쪽 하단을 기준 인쇄 위치로 설정합니다.
• [Center Relative]: 인쇄 영역의 중앙을 기준 인쇄 위치로 설정합니다.

인쇄 영역

인쇄 영역은 플랫 테이블 높이를 설정한 후 설정해야 합니다. 인쇄 영역을 먼저 설정하려고 하면 물체가 헤드 갭 센서에 
접촉하여 헤드 갭 센서가 손상될 수 있습니다.

IMPORTANT

인쇄할 영역을 지정합니다. 인쇄 원본에 따라 영역을 설정하는 방법에는 두 가지가 있습니다.

• [Print Origin]이 [Origin Relative]으로 설정된 경우: 유틸리티에서 미리보기 창의 오른쪽 하단 모서리
(A)를 지정하면 끝점(B)*2 사이의 공간이 인쇄 영역으로 설정됩니다.

• [Print Origin]이 [Center Relative]으로 설정된 경우: 최대 인쇄 영역은 인쇄 가능 영역의 중앙 주위로
설정됩니다(S: 105 mm [4.13 in.], F: 74 mm [2.91 in.]).

[Center Relative] 위치를 변경하는 경우 위치를 변경하기 전에 인쇄 영역을 좁히십시오. 그런 다음 인쇄 데이터에 
따라 인쇄 영역을 지정합니다.

MEMO

*1 잉크를 사용하여 청소를 수행합니다.
*2 인쇄 가능 영역의 왼쪽 위 (S: 210 mm [8.27 in.], F: 148 mm [5.83 in.])

소개
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소개
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기기에 사용되는 소프트웨어 구성 및 역할

기기는 Roland DG Connect Hub에서 시작되는 유틸리티로 작동됩니다. 인쇄 데이터 생성, 가공(텍스트, 
패턴 등의 크기 조정, 장식), 세부 설정, 인쇄 등은 FlexiDESIGNER VersaSTUDIO Edition을 사용하여 수
행하지만, 실제 인쇄 데이터는 VersaWorks를 사용하여 생성됩니다.

구성

BD 유틸리티

FlexiDESIGNER 
VersaSTUDIO Edition

(VersaWorks)

Roland DG
Connect Hub

[Utility(유틸리티)]
이 소프트웨어는 프린터 상태를 표시하고 프린터 설정을 구성합니다. 주로 다음과 같은 작업을 수행합니다.
• 설정 및 조정 기능
• 잉크 잔량 관리
• 유지보수 기능
• 메시지 및 오류 메시지 표시

[FlexiDESIGNER VersaSTUDIO Edition]*1

이 소프트웨어는 인쇄 데이터 작성부터 인쇄까지 모든 작업을 처리합니다.

[VersaWorks]
이 소프트웨어는 인쇄 데이터를 프린터를 사용하여 인쇄할 수 있는 데이터로 변환합니다.
FlexiDESIGNER가 시작되면 VersaWorks가 함께 실행되지만 FlexiDESIGNER에서 인쇄할 때는 이 소프트
웨어가 직접 작동되지 않습니다. 그러나 VersaWorks는 인쇄 데이터를 생성하므로 인쇄 시에는 실행 상태를 
유지해야 합니다.

기존 데이터(.ai, .pdf 등)를 활용하거나 시판되는 응용 프로그램 소프트웨어*2를 사용하여 인쇄 데이터를 생성하는 경우 
VersaWorks를 사용하여 인쇄에 필요한 설정을 지정한 다음 인쇄를 수행합니다.

MEMO

관련된 링크

・ VersaWorks 도움말

*1 이하 "FlexiDESIGNER"라고 합니다.
*2 Adobe Illustrator 및 CorelDRAW와 같은 벡터 그래픽을 생성하기 위한 소프트웨어입니다.

소개
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헤드 갭 센서

헤드 갭 센서는 물체의 높이를 감지하는 중요한 센서입니다. 인쇄할 물체를 잘못 설정하거나 물체를 고정하
는 방법에 문제가 있으면 헤드 갭 센서가 손상될 수 있습니다.

물체 높이 감지 방법
플랫 테이블(A)이 뒤에서 앞으로 이동하고 헤드 갭 센서(B)가 물체(C)에 접촉하여 물체의 높이를 감지합니
다.

헤드 갭 센서 손상 위험
물체의 높이를 감지한 후 물체(A)와 헤드 갭 센서(B) 사이의 간격을 0.5 mm (0.02 in.)로 설정합니다.

그러나 다음과 같은 조작이나 상황에서는 물체가 헤드 갭 센서에 접촉하여 손상될 수 있으므로 주의하십
시오.

• 물체의 상단 지점이 헤드 갭 센서보다 높습니다.

• 물체의 높이를 설정하기 전 인쇄 영역을 설정하기 위해 플랫 테이블을 앞에서 뒤로 이동합니다.
• 설치된 물체보다 높이가 낮은 미디어를 선택하면 사용자가 선택 오류를 인지하지 못한 채 인쇄 영
역이 설정되고 인쇄가 시작됩니다.
• 물체가 플랫 테이블에 단단히 고정되지 않은 상태에서 플랫 테이블을 앞에서 뒤로 움직였습니다
(물체의 높이가 변할 수 있음).
• 휘어진 물체를 테이프로 고정하고 높이를 맞춘 후 휘어짐으로 인해 테이프가 부분적으로 벗겨지
고, 플랫 테이블이 움직일 때 물체가 헤드 갭 센서에 부딪히게 됩니다.

• 로터리 축 유닛이 인식되지 않습니다.

• 로터리 축 유닛이 플랫 테이블에 설치되어 있지만 로터리 축 유닛의 커넥터가 본체에 연결되지 않
았거나 올바르게 연결되지 않았습니다.

소개
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냄새제거제

UV 잉크에는 인체에 영향을 미칠 수 있는 냄새가 있으므로 이 기기에는 냄세제거제가 장착되어 있습니다.
냄세제거제는 아래 표와 같이 4가지 모드가 있습니다. 필터의 수명과 탈취 성능 사이에는 트레이드 오프가 
있으므로 사용 상황에 맞게 필터를 사용하십시오.
탈취 성능은 모드와 흡입력에 따라 달라집니다. 각 모드에는 기본 흡입력 설정이 있으며, 20%에서 100%까
지 10% 단위로 설정할 수 있습니다.
필터 구입에 대한 자세한 내용은 공인 대리점에 문의하거나 당사 웹사이트를 방문하십시오.

모드 탈취 성능 흡입력 기본 설정

[Strong]

메인 전원이 켜져 있거나 서브 전원이 켜져 있거나 인쇄 중일 때 활성화
됩니다. 이 설정은 기기 외부로 냄새를 최소한으로 방출합니다. 이 모드
는 기기를 사용하지 않을 때에도 기기의 개구부에서 나오는 냄새를 줄여
줍니다.
이 모드에서는 냄세제거제의 정지 시간을 설정할 수 있습니다.

• [When Printing]: 50%
• [When Sub Power On]: 40%
• [When Main Power On]: 20%

[Medium]
서브 전원이 켜져 있거나 인쇄 중일 때 활성화됩니다. 물건을 적재하는 
등의 작업 중 전면 커버를 열 때 냄새를 줄여주는 모드입니다.

• [When Printing]: 50%
• [When Sub Power On]: 40%

[Weak]*1 인쇄 중에만 활성화됩니다. 이 모드는 일반적으로 사람이 없고 통풍이 
잘 되는 뒷마당 및 기타 공간의 사용자를 위한 것입니다.

• [When Printing]: 50%

[Off] 탈취가 활성화되지 않았습니다. －

*1 기본 설정

• 권장 필터 교체 시기

• 연 1회
그러나 사용 횟수에 따라 탈취 성능이 저하됩니다. 기기 근처에서 냄새가 나기 시작하면 사용 기간이 1년 미만이더
라도 필터를 교체하십시오.

MEMO

관련된 링크

・ P. 132 냄세제거제 모드 설정
・ P. 133 냄세제거제 일시 정지 시간 설정(Strong 모드만 해당)
・ P. 202 냄세제거기 필터 교체
・ Roland DG 웹사이트

소개

26 기본 정보 

https://www.rolanddg.com/


노즐 드롭아웃 테스트

테스트 패턴 및 세부 사항 확인

인쇄하기 전에 노즐 드롭아웃 테스트를 수행하십시오(테스트 패턴 인쇄). 테스트 패턴의 인쇄 크기는 약 90 
× 51 mm (3.54 in. × 2.01 in.)(가로 방향)입니다.
가로 A5 크기(210 mm × 148 mm (8.27 in. × 5.83 in.)) 미디어를 준비하는 경우 한 장의 최대 4개 위치
에서 노즐 드롭아웃 테스트를 수행할 수 있습니다.
아래 순서에 표시된 대로 잉크를 사용하여 테스트 패턴을 인쇄합니다. 프린트 헤드가 정상적으로 작동하는지 
확인할 수 있습니다.

본 그림의 프라이머(Pr)와 화이트(Wh)는 의도적으로 회색으로 제작되었으나, 실제 테스트 패턴 Pr은 투명하게 인쇄되고 
Wh는 흰색으로 인쇄됩니다. 이 두 개는 흰색 미디어에 인쇄할 때 다음 그림보다 보기가 더 어렵습니다.

MEMO

Wh Pr WhPrY M K C

각 색상의 선이 명확하고 고르게 정렬되어 있는지 확인하십시오. 테스트 패턴에서 누락된 부분은 "노즐 막
힘"을 나타내고, 축소되거나 기울어진 테스트 패턴은 "노즐 변형"을 나타냅니다. 이러한 문제는 노즐 막힘을 
제거함으로써 개선될 수 있습니다. 이러한 이유로 여러 가지 헤드 클리닝 메뉴가 제공되었습니다.

테스트 용지

노즐 드롭아웃 테스트는 자주 수행해야 하는 작업입니다. 테스트 패턴을 확인하여 문제가 발견되면 헤드 
클리닝을 수행한 후 노즐 드롭아웃 테스트를 다시 수행합니다. 이 때문에 미디어 확인의 용이성이 중요합
니다. 확인의 용이성은 미디어의 색상에 따라 다릅니다.

미디어를 제거하지 않고 테스트 패턴을 확인하고 헤드 클리닝 후 다시 노즐 드롭아웃 테스트를 수행하려면 
[Print Origin]을 다시 설정해야 합니다.

미디어 색상

미디어 색상 특징

투명
플랫 테이블은 검은색이므로 노즐 드롭아웃 시험지를 들고 테스트 패턴을 확인하십시오. Pr은 투명하지만 
빛의 투과 상태로 확인할 수 있습니다. 미디어를 제거하면 모든 색상을 쉽게 확인할 수 있습니다.
일부 미디어는 접착력이 약하여 쉽게 다시 적용할 수 있습니다.

화이트 플랫 테이블에 미디어를 부착한 상태에서 CMYK 잉크를 확인할 수 있습니다. Wh와 Pr는 미디어를 들고 빛에 
노출되는 각도를 변경하여 확인할 수 있습니다.

소개

기본 정보  27



미디어 색상 특징

검정 플랫 테이블에 미디어를 부착한 상태에서 Wh를 확인할 수 있습니다. Wh를 제외한 모든 부분은 미디어를 들고 
빛에 노출되는 각도를 변경하여 확인할 수 있습니다.

실버 플랫 테이블에 미디어를 부착하여 모든 색상에 대한 테스트 패턴을 확인하는 것이 비교적 쉽습니다. 무광택 
마감으로 확인이 더욱 쉽습니다.

미디어를 보호하는 방법

미디어를 보호하는 
방법

특징

테이프

마스킹 테이프 등을 사용하여 미디어의 네 모서리 또는 전체 둘레를 고정합니다. 미디어가 느슨해지지 않도록 
미디어를 플랫 테이블에 가깝게 테이프로 붙입니다. 테이프 자체가 들뜨거나 겹쳐서 높이 차이가 생기지 않도록 
붙여주세요.
미디어를 제거한 후 테스트 패턴을 확인하면 다시 장착하는 데 처음과 동일한 시간과 노력이 필요합니다.

양면 테이프

미디어의 모든 면에 얇은 양면 테이프를 붙이고 플랫 테이블에 고정합니다. 미디어가 구겨지거나 느슨해지지 
않도록 가장자리부터 양면 테이프를 붙입니다.
미디어를 제거할 때 양면 테이프를 플랫 테이블 위에 두지 않도록 주의하세요. 일반 테이프보다 다시 장착하는 
것이 더 쉽습니다.

약한 접착력이 있는 
미디어

장착과 제거 모두 쉽게 수행할 수 있습니다.

소개
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카메라 이미지에 따른 정렬

인쇄하기 전에 스마트폰의 카메라를 사용하여 개체의 인쇄 위치를 지정할 수 있습니다. 이 작업의 워크플로
우는 다음과 같습니다.

1. 플랫 테이블의 위치 감지를 위한 인쇄 마커를 인쇄합니다.
2. 플랫 테이블 위에 물건을 올려놓고 스마트폰으로 사진을 찍어주세요.
3. 캡처한 이미지 데이터를 컴퓨터로 전송한 다음 FlexiDESIGNER로 가져옵니다.
4. 이미지 데이터 위에 인쇄 데이터를 배치하고 인쇄합니다.

플랫 테이블의 흰색 테두리를 기준으로 개체를 배치하여 인쇄 영역을 설정하는 일반적인 인쇄 방법에 비해 
가져온 이미지 데이터에서 위치를 지정하므로 정렬이 더 쉽습니다. 또한 완제품의 이미지를 염두에 두고 인
쇄 데이터를 생성할 수 있습니다.
단, 두꺼운 물체에 인쇄할 경우나 카메라로 사진을 촬영하는 각도에 따라 인쇄 위치가 어긋날 수 있습니다. 
따라서 전체 인쇄 영역에 걸쳐 인쇄하는 데는 적합하지 않습니다. 큰 인쇄 영역에 작은 단일 지점을 인쇄하려
면 이 방법을 사용하는 것이 좋습니다.

이 작업에 대한 자세한 내용은 "캡처한 이미지를 사용하여 인쇄 위치 결정"을 참조하십시오.

소개
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권장 설정

소개

• 언어 설정 및 날짜/시간 설정
• 언어 설정: 언어 설정(P. 136)
• 날짜/시간 설정: 날짜 및 시간 조정(P. 135)

• 냄세제거제 설정
• 인쇄 일시 중지 및 다시 시작(P. 59)

• 길이 및 온도 단위
• 측정 단위 변경(P. 142)

• 노즐드롭아웃 시험지 등록
• 노즐 드롭아웃 테스트 시험지 등록 및 설정(P. 31)

사용해본 후

• 인쇄 이동 범위
• 프린트 헤드 캐리지 이동 최소화(P. 120)

• 클리어런스 모드
• 개체와 프린트 헤드 사이의 거리를 더 멀게 설정(P. 126)
• 인쇄 중 높이 재조정(P. 123)

• 잉크 순환 주기
• 잉크 순환[Ink Circulation] 주기 설정하기(P. 129)

• 절전 시간
• 슬립 모드 활성화 간격 설정(절전 기능)(P. 134)

소개
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노즐 드롭아웃 테스트 시험지 등록 및 설정

기기를 효율적으로 작동하려면 노즐 드롭아웃 테스트에 사용할 미디어를 등록하는 것이 좋습니다.

가로 A5 크기(210 mm × 148 mm [8.27 in. × 5.83 in.]) 용지를 미디어로 등록하는 경우 [Print Origin].

절차

1. 서브 전원 버튼을 누릅니다.

P. 51 서브 전원 켜기

2. 전면 커버를 엽니다.

3. 화이트 잉크 카트리지를 꺼내서 흔들어 줍니다.

50회 정도(약 20초 동안) 흔든 후 다시 삽입하십시오.
P. 163 잉크 카트리지 유지보수

4. 노즐 드롭아웃 테스트 시험지를 장착합니다.
흰색 라인(A) 내부 영역은 대략적인 최대 인쇄 영역입니다. 흰색 프레임에 맞춰 미디어를 배치하고
고정합니다. 이때 테이프로 고정하십시오.

5. 전면 커버를 닫습니다.

6. 유틸리티 홈 화면에서 [Setup]을 클릭합니다.

7. 를 클릭합니다.

소개
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유틸리티에서는 객체를 등록/관리하는 창에서 "media"라는 명칭을 사용합니다.

MEMO

8. 노즐 드롭아웃 테스트용으로 인식할 수 있는 이름을 입력한 후 [OK]를 클릭합니다.

이전에 등록된 미디어 이름은 사용할 수 없습니다.

9. [Object Type] 창에서 [Opaque]를 선택한 후 [OK]를 클릭하십시오.

10. [Flat Table Height] 옆의 [Change]을 클릭한 후 노즐 드롭아웃 시험지의 높이를 설정합니다.

(1) 창 오른쪽에 있는 또는 를 클릭하여 플랫 테이블에 있는 노즐 드롭아웃 시험지를 헤드 갭

      센서의 전후 위치에 맞춥니다.

한 번의 클릭으로 이동 거리를 0.1 mm (0.004 in.), 1 mm (0.04 in.), 10 mm (0.39 in.) 또는 50 mm 
(1.97 in.) 중에서 선택할 수 있습니다.

MEMO

(2) 창 왼쪽의            를 클릭하면 플랫 테이블 위의 노즐 드롭아웃 시험지가 헤드 갭 센서에 더 가깝게 이동

됩니다.
헤드 갭 센서와 접촉하지 않고 헤드 갭 센서에서 몇 mm 떨어진 위치(a)까지 개체의 가장 높은
인쇄 위치를 이동합니다.

a

(3) [Automatic Setup]를 클릭합니다.

플랫 테이블이 움직이고 헤드 갭 센서가 노즐 드롭아웃 시험지를 감지합니다.
(4) [OK]를 클릭합니다.

소개
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11. [Print Origin] 및 [Printing Area] 옆의 [Change]를 클릭하고 노즐 드롭아웃 테스트 범위를 설정합니다.

노즐 드롭아웃 테스트의 인쇄 크기는 약 90 mm × 51 mm (3.54 in. × 2.01 in.)(가로 방향)입니다.

[Printing Area] 설정이 완료되면 프린트 헤드가 마르는 것을 방지하기 위해 프린트 헤드 캐리지를 같은 위치에 
약 3분 동안 방치한 후 원래 위치로 돌아갑니다. 절차를 다시 수행하십시오.

MEMO

(1) [Position Specification]에서 [Pointer]를 선택합니다.
프린트 헤드 캐리지가 이동한 다음 프린트 헤드 캐리지의 오른쪽에 있는 포인터가 최대 인쇄
영역의 오른쪽 하단(S: 0 mm [0 in.], F: 0 mm [0 in.])을 지시합니 다.

(2) ,           , 또는 을 클릭한 후 포인터를 이동하여 인쇄 원점(인쇄 영역 오른쪽

하단)을 지정합니다.

(3) [OK]를 클릭합니다.

[Flat Table Height], [Print Origin], [Printing Area] 설정 창으로 돌아갑니다.

[Printing Area]에 대하여
[Print Origin]은 변경되지 않고 여기에서 [Origin Relative]이 지정되므로 인쇄 영역의 왼쪽 상단이 자동으로 
최대 위치로 설정됩니다(S: 210 mm [8.26 in.], F: 148 mm [5.82 in.]).

MEMO

12. [OK]를 클릭합니다.

[Setup in progress.]가 표시됩니다. 설정이 완료되면 홈 화면으로 돌아가며, 등록된 개체 이름과
설정된 [Flat Table Height], [Print Origin], [Printing Area]이 표시됩니다.

이제 노즐 드롭아웃 시험지가 등록 및 설정되었습니다.

노즐 드롭아웃 테스트를 수행하고 클리닝을 수행한 후 다른 노즐 드롭아웃 테스트를 수행할 때와 같이 동일한 미디어에 
계속 인쇄하는 경우         를 클릭한 다음 [List of Media Settings]에 등록된 인쇄 원점을 변경합니다.

MEMO

소개
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프린트 헤드 캐리지는 왼쪽-오른쪽 방향으로 이동하고 플랫 테이블은 앞뒤 방향으로 이동합
니다. 포인터가 빛나는 위치가 인쇄 원점 역할을 합니다.



관련된 링크
・ P. 27 노즐 드롭아웃 테스트
・ P. 64 노즐 드롭아웃 테스트 수행

소개
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유틸리티 시작/종료

유틸리티 시작

절차

1. 알림 영역에서 Roland DG Connect Hub 아이콘을 클릭합니다.

2. 사용할 기기를 클릭합니다.

선택한 기기에서 사용할 수 있는 애플리케이션이 화면 오른쪽에 표시됩니다.

3. 유틸리티에서 [Open]을 클릭합니다.

유틸리티가 시작되고 다음 창이 표시됩니다.

유틸리티
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유틸리티
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유틸리티 종료

절차

1. 유틸리티 창의 오른쪽 상단에 있는 를 클릭하십시오.

2. 확인창에서 [OK]를 클릭합니다.

유틸리티를 종료합니다.

유틸리티
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유틸리티 홈 화면

유틸리티는 프린터 상태를 표시하고, 프린터 설정을 구성하고, 프린터 작업을 수행하는 소프트웨어입니다.

No. 이름 설명

상태 바 프린터 상태를 표시하고 다음 작업을 나타냅니다.

알림 중요한 정보를 표시합니다.
알림이 있으면 해당 번호가 아이콘에 표시됩니다.

매뉴 이를 사용하여 프린터 설정을 구성합니다.

미디어 정보 개체 정보를 표시합니다.
개체가 설정되면*1 개체 이름이 표시됩니다.

잉크 잔량 및 배출된 잉크량 각 잉크 카트리지에 남아 있는 잉크의 양과 드레인 
팩에서 배출되는 잉크의 양을 표시합니다.
잉크를 교체할 때가 되면 해당 잉크 카트리지 옆에

이 표시됩니다. 이 아이콘을 클릭하면 잉크에
대한 자세한 정보가 표시됩니다.

인쇄 영역 및 높이 개체가 설정되면 설정된 인쇄 영역(W: 너비, L: 길이, 
H: 높이*2)이 표시됩니다.

[Setup]/[Cancel Setup] 인쇄할 개체의 설정을 시작/취소합니다.

[Cleaning] 노즐 드롭아웃 테스트 및 클리닝과 관련된 메뉴를 
표시합니다.

서브 전원 유틸리티를 사용하여 기기의 서브 전원 공급 장치
를 작동합니다.

*1 설정이란 플랫 테이블 위에 개체를 올려놓고, 인쇄 영역과 인쇄 높이를 설정하고, 개체를 인쇄할 수 있도록 준비하는 것을 의미
       합니다.

유틸리티
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*2 [Flat Table Height] (H) 및 [Object Thickness] (T)에서 플랫 테이블 위치를 선택할 수 있습니다.

유틸리티
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매뉴 목록

     을 클릭하면 [Menu] 창이 표시됩니다.

[List of Media Settings]

유틸리티에서는 개체의 설정 값을 나열하는 창을 [List of Media Settings]이라고 합니다.

MEMO

이 창에는 설정된 개체의 설정 정보가 표시됩니다. 개체가 설정되지 않은 경우 이 창이 표시되지 않습니다.
개체를 등록할 때 설정 값을 확인하고 변경할 수 있습니다*1. [Print Origin] 오른쪽에는 [Origin Relative] 
변경 시 설정할 항목이 있습니다. 이 미디어에 대한 설정이 아닙니다.
자세한 내용은 개체(미디어) 등록 항목을 참고하십시오.

[Printing Zone]
[Flat Table Height]
인쇄할 높이 방향 위치가 표시됩니다.
[Print Origin]
인쇄 위치의 기준이 되는 지점은 플랫 테이블의 오른쪽 하단 기준점(S: 0 mm [0 in.], F: 0 mm [0 in.])으
로부터의 거리로 표시됩니다.
[Printing Area]
인쇄 원점을 기준으로 인쇄할 영역이 W:S 방향의 거리(mm)로 표시되고 L:F 방향의 거리(mm)로 표시됩니
다.

[Flat Table Lowering Amount]
기준 평판 위치에서 인쇄할 위치까지의 거리에 대한 설정 값이 표시됩니다.

[Object Type]
[Transparent] 또는 [Opaque]이 표시됩니다.

[Printing Movement Range]
인쇄 시 프린트 헤드 캐리지의 작업 너비는 [Output Data Width], [Media Width] 또는 [Full Width]로 표시
됩니다.

*1 [Flat Table Height] 및 [Flat Table Lowering Amount]은 변경할 수 없습니다.

유틸리티

40 기본 정보 



[Media Width]는 인쇄 영역에 설정된 너비입니다.

MEMO

관련된 링크
・ P. 126 개체와 프린트 헤드 사이의 거리를 더 멀게 설정
・ P. 120 프린트 헤드 캐리지 이동 최소화

유틸리티
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[Media Management]

유틸리티에서는 개체를 관리하는 창을 [Media Management], 개체를 "미디어"라고 합니다.

MEMO

최대 50개의 개체를 저장할 수 있습니다.      아이콘은 일반 개체를 나타내고       아이콘은 로터리축 유닛
에 대한 개체를 나타냅니다.

등록된 미디어를 선택하여 검토, 복제, 삭제 등 세부 설정 작업을 수행할 수 있습니다.

:[Display Media Settings]

등록된 미디어에 설정된 세부 정보를 표시합니다.

: [Duplicate Media]

등록된 미디어의 설정 내용을 복제한 후 별도의 미디어로 등록하는 기능입니다.

: [Change Media Name]

등록된 미디어의 이름을 변경합니다.

: [Delete Media]

선택된 등록 미디어를 삭제합니다.

검색 기능 및 즐겨찾기 기능
검색창을 이용해 미디어 이름을 검색할 수 있습니다. 또한 자주 사용하는 미디어를 즐겨찾기로 설정하고 해
당 즐겨찾기만 표시할 수도 있습니다. 즐겨찾기가 표시되는 동안에도 검색할 수 있습니다.

1. 미디어 이름 옆에 있는       을 클릭하면 이 아이콘이       로 변경됩니다.

2. 검색창 옆에 있는           을 클릭하십시오.

아이콘이           로 변경되고, 즐겨찾기로 설정된 미디어 목록이 나타납니다.

모든 미디어 목록을 표시하려면 "1"을 다시 클릭하십시오.

유틸리티
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[Maintenance]

이를 사용하여 소모성 부품을 교체하고 기타 유지보수를 수행합니다.
관련 영상을 보시려면       을 클릭하십시오. 전반적인 워크플로우를 이해하려면 이 비디오를 시청하는 
것이 좋습니다. 

[Cleaning]
[UV Lamp Manual Cleaning]
[Execute]를 클릭하면 [UV Lamp Manual Cleaning] 실행 화면으로 전환됩니다. UV 램프를 청소하려면 
화면에 표시된 지침을 따르십시오.

[Parts Replacement]
[Wiper]
[Execute]를 클릭하면 [Wiper Replacement] 실행 화면으로 전환됩니다. 화면의 지시에 따라 와이퍼를 교
체하십시오.
[Felt Wiper]
[Execute]를 클릭하면 [Felt Wiper Replacement] 실행 화면으로 전환됩니다. 펠트 와이퍼를 교체하려면 
화면의 지시를 따르십시오.
[Cap Top]
[Execute]를 클릭하면 [Cap Top Replacement] 실행 화면으로 전환됩니다. 화면의 지시에 따라 캡탑을 
교체하십시오.

[Ink]
[Ink Circulation]
화이트 잉크의 색상 불균일 문제를 방지하기 위해 잉크를 순환시킵니다. [Execute]를 클릭하여 [Ink 
Circulation]을 시작합니다.
[Ink Renewal]
잉크 순환으로 화이트 잉크 색상의 불균일성이 해결되지 않으면 프린터 내(잉크 튜브)의 화이트 잉크를 교
체(새로 고침)하십시오. [Execute]를 클릭하여 [Ink Renewal]을 시작합니다.

[Ink Discharge]
정기적으로 수행되는 잉크 배출을 미리 수행합니다. 일반적인 사용에서는 사용자가 이를 실행할 필요가 없
습니다. [Execute]를 클릭하여 [Ink Discharge]를 시작합니다.

관련된 링크
・ P. 174 UV-LED 램프 청소
・ P. 192 와이퍼 교체
・ P. 194 펠트 와이퍼 교체

유틸리티
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・ P. 196 캡탑 교체
・ P. 182 잉크 리뉴얼
・ P. 183 잉크 배출
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[Preferences]
사용 환경에 맞게 기기의 작동 설정을 변경하십시오.
관련 영상을 보시려면       를 클릭하십시오. 전반적인 워크플로우를 이해하려면 이 비디오를 시청하는 
것이 좋습니다.

[Clearance Settings]
인쇄 중 높이 오류가 발생할 경우 취할 조치를 설정합니다. [Stop] 또는 [Readjust] 중에서 선택합니다. 
[Readjust]을 선택한 경우 [Maximum Value (Threshold)]에서 플랫 테이블을 낮추는 양을 설정합니다.

[Deodorizer Settings]
탈취 모드를 변경합니다. [Strong], [Medium], [Weak], [Off] 중에서 선택하십시오.
모드별로 흡입력을 설정할 수도 있습니다.

[Flat Table Height/Object (Media) Thickness]
높이 방향 참조를 변경합니다. [Height (Lowered Flat Table Treated as Height of 0)] 또는 [Thickness 
(Raised Flat Table Treated as Thickness of 0)] 중에서 선택합니다.

[Operation before Printing]
물체를 설치한 후 인쇄를 시작하기 전에 물체의 높이를 확인할지 여부를 설정합니다.

[Ink Circulation Interval]
균일하지 않은 색상 문제를 방지하기 위해 화이트 잉크 순환 주기를 설정합니다. 30분부터 360분까지 30분 
단위로 선택할 수 있습니다.

[Sleep Time]
슬립 모드(절전 기능이 작동하는 상태)가 활성화될 때까지의 시간을 설정합니다. 15분부터 120분까지 15분 
단위로 선택할 수 있습니다.

[Date and Time]
노즐 드롭아웃 테스트에 인쇄된 날짜와 시간을 변경합니다.

유틸리티
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[Alignment Marker Printing]
플랫 테이블 위에 정렬 마커를 인쇄합니다. [Execute]를 활성화하려면 정렬 마커 또는 이와 유사한 테이프
를 설정하십시오.

[Rotary Unit Attachment/Removal]
로터리 축 유닛을 장착/제거할 때 사용됩니다.

[Initialize Settings]
[Execute]를 클릭하면 [List of Media Settings], [Preferences] 및 [Network]가 공장 기본값으로 돌아갑
니다. 단, [Position Adjustment]는 초기화되지 않습니다.

[Position Adjustment]

• [Adjust Manual Cleaning Tool Position]

수동 헤드 클리닝 도구를 교체할 때 위치를 조정합니다.
개체가 Setup되면 [Execute]가 활성화되지 않습니다. Setup을 취소한 후 개체를 제거하십시오.

• [Adjust Pointer Position]

인쇄 영역과 포인터 위치 사이의 정렬 불량을 조정합니다.
[Execute]를 활성화하려면 포인터 위치 조정용 미디어를 Setup 하십시오.

관련된 링크
・ P. 122 플랫 테이블 높이 설정
・ P. 132 냄세제거제 모드 설정
・ P. 129 잉크 순환[Ink Circulation] 주기 설정하기
・ P. 135 날짜 및 시간 조정
・ P. 77 정렬 마커 인쇄
・ P. 131 옵션 품목 제거/장착(OA-RA-8)
・ P. 137 수동 헤드 클리닝 도구의 베이스 위치 설정

유틸리티
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[System Information]

이 창을 사용하여 기기 및 네트워크 정보를 확인할 수 있습니다.

[Machine Information]
다음 정보를 확인할 수 있습니다.

• [Model]

• [Nickname]

• [Serial Number]

• [Ink Type]

• [Firmware Version]

• [MAC Address]

[Network]
연결된 기기의 네트워크 설정을 확인하고 편집할 수 있습니다.
기기의 IP 주소, 서브넷 마스크 및 기본 게이트웨이를 자동으로 얻으려면 [Obtain IP Address Automatically]
를 켜십시오.

• [IP Address]

• [Subnet Mask]

• [Default Gateway]

[Units]
[Length]와 [Temperature]를 설정합니다.

[Language]
표시 언어를 설정합니다.

[Version]
유틸리티 버전 정보를 표시합니다.

유틸리티

기본 정보  47



이 섹션에서는 일상적인 작업 흐름을 설명합니다.
적절한 시기에 적절한 유지보수를 수행하면 오작동을 방지하고 기기의 성능을 최대한 활용할 수 있습니다.

워크플로우

이 섹션에서는 주문 후 즉시 인쇄하는 매장의 워크플로 예시를 제공합니다.

개장 전
1. 화이트 잉크를 순환합니다. 잉크 카트리지 유지보수(P. 163)
2. 본체의 서브 전원을 켜십시오. 서브 전원 켜기(P. 51)
3. 유틸리티를 시작합니다.  유틸리티 시작(P. 35)
4. 알림을 확인하십시오.

알림에 따라 유지보수를 수행합니다.  알림(P. 228)
5. 노즐 드롭아웃 테스트를 수행합니다.  Step 1: 노즐 드롭아웃 테스트 수행(P. 64)
6. 테스트 패턴 결과에 따라 적절한 조치를 취하십시오.

• 양호: 인쇄 대기 완료
• 불량: 이란 헤드 클리닝을 수행합니다.  Step 2: 일반 헤드 클리닝 수행(P. 66)

영업시간
인쇄 주문이 들어오면 인쇄합니다.  Step 4: 인쇄 수행(P. 76)
유틸리티에 메시지가 표시되면 창에 표시된 대로 조치를 취하세요. 다음은 알림에 자주 나타나는 메시지입니
다.

• [The time for ink mixing has arrived.]

이 메시지는 사용자에게 화이트 잉크 카트리지를 순환하라는 메시지를 표시합니다.  잉크 카트리지 유지
보수(P. 163)

• [The time for manual cleaning has arrived.]
수동 헤드 클리닝 도구를 사용하여 청소할 때가 되면 이 메시지가 나타납니다.  수동 헤드 클리닝(P. 168)

그 외 몇 가지 유지 관리 알림이 있습니다. 항상 유틸리티에서 알림을 확인하십시오.: . 

폐장 후

1. 유지보수 알림이 없는지 확인하십시오. 알림(P. 228)
2. 기기를 청소합니다. 기기 청소(P. 164)
3. 서브 전원을 끄십시오. 서브 전원 끄기(P. 53)
4. 유틸리티 종료하기. 유틸리티 종료(P. 37)

일일 전체 흐름
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항상 메인 전원을 켜두십시오. 사용하기 전에 서브 전원을 켜고 사용 후에는 끄십시오. 
메인 전원 켜기

서브 전원을 켠 후 일정 기간 동안 사용하지 않으면 기기가 절전 모드로 전환됩니다. 절전 모드에서 복구
하는 방법에 대한 자세한 내용은 다음을 참조하십시오.

P. 54 슬립 모드 (절전 기능)

• 항상 메인 전원을 켜두십시오.
절대로 메인 전원을 끄지 마십시오. 메인 전원을 차단하면 자동 유지보수가 주기적으로 수행될 수 없습니다. 자동 유지
보수를 수행하지 않으면 프린트 헤드 고장과 같은 기기 고장이 발생할 수 있습니다.

• 작업이 진행되는 동안 갑자기 메인 전원을 끄거나 전원 코드를 뽑지 마십시오.
작업이 진행되는 동안 갑자기 메인 전원을 끄거나 전원 코드를 뽑으면 프린트 헤드가 손상되거나 기기 고장이 발생할 수
있습니다.

IMPORTANT

메인 전원을 끄면?

기기 이동 등 메인 전원을 꺼야 하는 경우에는 메인 전원을 끄기 전에 반드시 서브 전원을 끄십시오. 그런 다음 이동이 
완료되면 즉시 메인 전원을 켜십시오.

MEMO

전원 공급
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서브 전원 켜기

기기의 버튼이나 유틸리티의 아이콘을 사용하여 서브 전원을 켤 수 있습니다.

기기의 버튼으로 서브 전원 켜기

절차

1. 유지보수 커버와 전면 커버가 닫혀 있고 메인 전원이 켜져 있는지 확인하십시오.

2. 서브 전원 버튼을 누르십시오.

서브 전원이 켜져 있습니다. 서브 전원 버튼이 파란색으로 점멸되다가 파란색으로 점등되면 시동이
완료된 것입니다.

메인 전원이 꺼진 경우 메인 전원을 켜서 펌웨어 초기화를 시작하십시오. 초기화가 완료될 때까지 서브 전원 버튼
을 눌러도 반응이 없습니다. 이 경우 서브 전원 버튼을 누르기 전에 잠시 기다리십시오.

MEMO
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유틸리티를 사용하여 기기의 서브 전원 켜기

절차

1. 유지보수 커버와 전면 커버가 닫혀 있고 메인 전원이 켜져 있는지 확인하십시오.

2. 유틸리티를 시작합니다.

P. 35 유틸리티 시작

3. 를 클릭합니다.

서브 전원이 켜집니다. 기기의 서브 전원이 켜지면 아이콘이          로 변경됩니다.

메인 전원이 꺼진 경우 메인 전원을 켜서 펌웨어 초기화를 시작하십시오. 초기화가 완료될 때까지 을  

눌러도 응답이 없습니다. 이런 경우 서브 전원 버튼을 누르기 전에 잠시 기다리십시오.

MEMO

서브 전원을 켜면 유틸리티 홈 화면이 표시됩니다.

전원 공급
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서브 전원 끄기

기기의 버튼과 유틸리티 창의 아이콘을 사용하여 서브 전원을 끌 수 있습니다.

기기의 버튼으로 서브 전원 끄기

절차

1. 작업이 끝나면 서브 전원 버튼을 1초 이상 길게 누르십시오.

서브 전원 버튼의 램프가 꺼지면 서브 전원이 꺼진 것입니다.

유틸리티를 사용하여 기기의 서브 전원 끄기

절차

1. 작업이 완료되면 유틸리티에서           을 클릭하십시오.

2. [Turn off sub power.] 창이 나타나면 [OK]를 클릭하십시오.

잠시 후 유틸리티 상태 표시줄에 [The sub power is off.]가 표시되고 서브 전원 아이콘이          로 

변경됩니다.

전원 공급

기본 조작 53



슬립 모드 (절전 기능)

이 기기에는 아무런 조작 없이 일정 시간이 지나면 저전력 "슬립 모드"로 전환되는 절전 기능이 작동 됩니
다.
기기가 절전 모드에 있으면 서브 전원 버튼이 파란색으로 천천히 점멸합니다. 다음 작업 중 하나를 수행하
여 절전 모드에서 복구하십시오.

• 서브 전원 버튼을 누르십시오.
• 전면 커버를 엽니다.
• 유틸리티에서 [Recover]를 클릭하십시오.
• 컴퓨터에서 인쇄 데이터를 보냅니다.(개체가 Setup된 상태인 경우)

• 기본 설정 : [30 min]

MEMO

관련된 링크
・ P. 134 슬립 모드 활성화 간격 설정(절전 기능)

전원 공급
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긴급 상황 발생 시 전원 끄기

프린트 헤드 캐리지와 플랫 테이블은 기기의 전면 커버가 열려 있어도 Setup, 유지보수 또는 기타 작업 중에 
자동으로 작동할 수 있습니다.
프린트 헤드 캐리지나 플랫 테이블이 예기치 않게 움직이기 시작하고 손이나 물체가 끼일 위험이 있는 경우 
긴급 정지 버튼을 눌러 프린터 작동을 중지하십시오.

긴급 정지 버튼이 활성화되면 유틸리티에 [Emergency Stop Error]가 표시됩니다.
프린트 헤드가 프린트 헤드 캡에서 분리된 위치에 정지된 경우 건조를 방지하기 위해 10분 이내에 원래 위치
로 복원되어야 합니다.
프린트 헤드를 원래 위치로 복원하는 방법에 대한 자세한 내용은 [Emergency Stop Error]를 참조하십시오.

전원 공급
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전면 커버 열기/닫기

개체 설치, 잉크 카트리지 제거 및 장착, 유지보수 등 대부분의 작업은 전면 커버를 연 상태에서 수행됩니
다. 냄새를 줄이고 프린트 헤드가 마르는 것을 방지하려면 전면 커버를 열어야 하는 경우를 제외하고는 닫
아 두십시오.

절차

1. 전면 커버 상단에 이물질이 없는지 확인하십시오.

전면 커버를 열 때 그림에 표시된 부분에 손이나 물건을 넣지 마십시오.
손가락이 끼어 부상을 입거나 전면 커버가 손상될 수 있습니다.

주의

2. 그림과 같은 위치를 잡고 전면 커버를 엽니다.

3. 필요한 작업을 수행합니다.

4. 전면 커버를 닫기 전에 다음 사항을 확인하십시오.

• A: 전면 커버와 기기 사이에 이물질이 없어야 합니다.

커버 열기/닫기
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• B: 유지보수 커버가 설치되어 있어야 합니다.

5. 전면 커버를 닫습니다.

전면 커버 열기/닫기
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유지보수 커버 장착/제거

유지보수 커버를 제거한 상태에서 수행되는 작업에는 배출된 드레인 팩 교체, 옵션 품목 및 보관된 리테이너 
제거 및 설치 등의 작업이 포함됩니다. 필요한 경우를 제외하고는 유지보수 커버를 단단히 장착해 두십시오.

절차

1. 전면 커버를 엽니다.

P. 56 전면 커버 열기/닫기

2. 다음 절차에 따라 유지보수 커버를 제거하십시오.

(1) 유지보수 커버의 아래쪽을 잡고 사용자 방향으로 약 30 mm (1.18 in.) 정도 당깁니다.

(2) 유지보수 커버를 들어 올려 제거합니다.

3. 필요한 작업을 수행합니다.

4. 다음 절차에 따라 유지보수 커버를 장착하십시오.

(1) 유지보수 커버의 후크(B)를 왼쪽과 오른쪽(A)의 홈에 삽입합니다.

(2) 유지보수 커버를 기기에 대고 누릅니다.

유지보수 커버가 자석(C)으로 고정되어 있는지 확인하십시오.

5. 전면 커버를 닫습니다.

커버 열기/닫기
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인쇄 도중에 인쇄를 일시 중지하거나 정지할 수 있지만, 일시 중지 후 다시 시작하면 인쇄 품질에 영향을 
미칩니다.

인쇄 일시 중지 및 다시 시작

인쇄가 일시 중지된 위치에 가로 줄무늬가 나타나는 등 인쇄 품질에 영향을 미칠 수 있으므로 일시 중지한 후 인쇄를 재개
하지 않는 것이 좋습니다.

IMPORTANT

절차

1. 인쇄하는 동안 유틸리티 홈 화면에서 [Pause]를 클릭하십시오.

인쇄가 일시 중지됩니다.

메뉴 화면이 표시된 동안에는 홈 화면을 조작할 수 없습니다. 메뉴 화면을 닫습니다.

MEMO

2. [Resume]을 클릭합니다.

인쇄가 재개됩니다.

인쇄 일시 중지 및 취소
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인쇄 취소

유틸리티로 인쇄 취소

절차

1. 인쇄하는 동안 유틸리티 홈 화면에서 [Pause]를 클릭하십시오.

인쇄가 일시 중지됩니다.

메뉴 화면이 표시된 동안에는 홈 화면을 조작할 수 없습니다. 메뉴 화면을 닫습니다.

MEMO

2. [Cancel Output]을 클릭합니다.

3. 확인창에서 [OK]를 클릭합니다.

인쇄가 취소됩니다.

프린터에서 인쇄 취소

절차

1. 인쇄하는 동안 서브 전원 버튼을 1초 이상 길게 누르십시오.

인쇄가 취소되고 기기의 서브 전원이 자동으로 꺼집니다. 취소된 시점부터 인쇄를 재개할 수 없습
니다.

2. 서브 전원 버튼을 누르면 서브 전원이 켜집니다.

인쇄 일시 중지 및 취소
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출력 방법
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유틸리티 준비

컴퓨터를 시작하고 유틸리티를 사용할 수 있도록 구성합니다.

절차

1. 유틸리티가 설치된 컴퓨터를 시작합니다.

2. 유틸리티를 시작합니다.

P. 35 유틸리티 시작

인쇄 빈도와 주변 환경에 맞게 냄세제거제 모드를 설정하십시오. 이때 냄세제거제의 모드를 확인해 보시길 권장
합니다.

P. 26 냄새제거제

MEMO

관련된 링크
・ P. 24 기기에 사용되는 소프트웨어 구성 및 역할

컴퓨터 준비
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Step 1: 노즐 드롭아웃 테스트 수행

노즐 드롭아웃 테스트(테스트 패턴 인쇄)를 수행하고 인쇄를 시작하기 전에 테스트 패턴을 확인하십시오. 
오류가 발생하면 프린트 헤드를 청소하십시오(일반 헤드 클리닝). 그 후, 노즐 드롭아웃 테스트를 다시 수행
하십시오.

이 절차에 대한 참조 비디오를 보려면 다음 링크를 사용하십시오. 전반적인 작업 흐름을 이해하려면 이 비디오를 시청하는
것이 좋습니다.
https://youtu.be/qQr12nDO6Qw

MEMO

절차

1. 노즐 드롭아웃 테스트용 미디어를 Setup 합니다.

2. 유틸리티 홈 화면에서           [Cleaning]을 클릭합니다.

3. [Nozzle Drop-out Test]에서 [Output]을 클릭합니다.

테스트 패턴 인쇄가 시작됩니다.

4. 테스트 패턴에 노즐 막힘이나 노즐 변형이 있는지 확인하십시오.
테스트 패턴에서 누락된 부분은 "노즐 막힘"을 나타내고, 접혀 있거나 기울어진 테스트 패턴은
"노즐 변형"을 나타냅니다. 테스트 패턴이 잘 보이지 않는 경우 전면 커버를 열거나 노즐 드롭아웃
테스트지를 제거한 후 각도를 변경하여 패턴을 확인하십시오.

• 노즐 막힘이나 노즐 변형이 발생하지 않는 경우: 다음 단계로 진행합니다.
• 노즐 막힘 또는 노즐 변형 발생하는 경우 : Step 2: 일반 헤드 클리닝 수행으로 진행하십시오.

프린터 준비
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5. 노즐 드롭아웃 테스트지를 제거한 후 전면 커버를 닫습니다.

6. [Close]를 클릭하면 원래 화면으로 돌아갑니다.

관련된 링크
・ P. 31 노즐 드롭아웃 테스트 시험지 등록 및 설정
・ P. 27 노즐 드롭아웃 테스트

프린터 준비
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Step 2: 일반 헤드 클리닝 수행

Step 1에서 노즐 막힘 또는 노즐 변형이 발생한 경우 일반 헤드 클리닝을 수행하십시오. 

절차

1. [Head Cleaning]에서 [Normal Cleaning]를 선택한 후 [Execute]를 클릭합니다.

[Cleaning in progress.] 및 남은 청소 시간 예상 시간이 유틸리티 홈 화면에 표시됩니다.

2. 노즐 드롭아웃 테스트용 미디어를 다시 Setup하십시오.

• 노즐 드롭아웃 테스트 미디어를 제거하고 테스트 패턴을 확인한 경우 프린터를 다시 Setup 하십
시오.

• 노즐 드롭아웃 테스트 미디어를 제거하지 않고 테스트 패턴을 확인한 경우       를 클릭하고
[List of Media Settings]에서 지정한 [Print Origin]을 변경합니다.

3. [Nozzle Drop-out Test]에서 [Output]을 클릭합니다.

4. 인쇄가 완료되면 전면 커버를 엽니다.

5. 테스트 패턴에 노즐 막힘이나 노즐 변형이 있는지 확인하십시오.

누락된 블록은 노즐 막힘을 나타냅니다. 접혀 있거나 기울어진 블록은 노즐 변형을 나타냅니다.

프린터 준비
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• 문제가 지속되면 일반 헤드 클리닝을 다시 수행해 보십시오.
• 일반 헤드 클리닝을 여러 번 수행한 후에도 노즐 막힘, 노즐 변형 등의 문제가 지속되면 다른 헤드 클리닝 방법

을 사용하십시오.

MEMO

노즐 막힘이나 노즐 변형이 발생하지 않으면 인쇄 준비가 완료된 것입니다.

6. 전면 커버를 닫습니다.

7. [Close]를 클릭하면 원래 화면으로 돌아갑니다.

관련된 링크
・ P. 31 노즐 드롭아웃 테스트 시험지 등록 및 설정
・ P. 160 노즐 막힘이나 노즐 변형이 발생한 경우

프린터 준비
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인쇄 시작
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이 절차에 대한 참조 비디오를 보려면 다음 링크를 사용하십시오. 전반적인 작업 흐름을 이해하려면 이 비디오를 시청하는
것이 좋습니다.
https://youtu.be/XtlasiJZ5sM

MEMO

Step 1: 인쇄 데이터 만들기

인쇄 데이터를 생성하기 위해 인쇄할 개체와 영역을 결정합니다.

절차

1. 인쇄할 개체와 영역을 결정합니다.

2. FlexiDESIGNER를 시작하려면 아래 절차를 따르십시오.

(1) Roland DG Connect Hub를 시작합니다.

• Windows 11
i. [시작] > [모든 앱]을 클릭합니다.
ii. 앱(프로그램) 목록에서 [Roland DG Corporation] > [Roland DG Connect Hub]를

클릭합니다.
• Windows 10

i. [Start]를 클릭합니다.
ii. 앱(프로그램) 목록에서 [Roland DG Corporation] > [Roland DG Connect Hub]를

클릭합니다.
(2) 사용할 기기(BD-8)를 클릭합니다.

(3) FlexiDESIGNER의 [Open]을 클릭합니다.

시중에서 판매되는 응용 프로그램 소프트웨어를 사용하여 인쇄 데이터를 생성한 경우 데이터 생성부터 인쇄까지
의 프로세스가 다릅니다.

MEMO

3. 인쇄 데이터를 생성하고 저장합니다.

"FlexiDESIGNER 소개"를 참조하십시오.

관련된 링크

・ FlexiDESIGNER 소개
・ P. 226 시판하는 애플리케이션 소프트웨어를 사용하여 인쇄하기

인쇄 위치를 수동으로 결정하는 경우
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Step 2: 개체 배치

플랫 테이블 위에 개체를 올려 놓습니다. 

절차

1. 서브 전원 버튼을 누릅니다.

2. 전면 커버를 엽니다.

3. 플랫 테이블에 이물질이나 기타 이물질이 붙어 있지 않은지 확인하십시오.

4. 플랫 테이블 위에 인쇄할 개체를 제자리에 고정합니다.

• 권장 사항
접착 시트로 개체를 고정합니다.

제공된 접착 시트의 크기는 A5 (210 mm × 148 mm (8.27 in. × 5.83 in.))입니다. 최대 인쇄 영역의 흰색 
테두리에 접착 시트를 맞추는 것이 바람직합니다.

MEMO

• 불안정하거나 다루기 힘든 개체
마스킹 테이프를 사용하여 접혀서 주름이 있는 미디어나 말려서 컬이 발생하기 쉬운 미디어를
고정하십시오. 개체의 형상으로 인해 고정하기 어려운 경우에는 지그를 사용하십시오.

마스킹 테이프 지그

인쇄 위치를 수동으로 결정하는 경우
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접착 시트의 접착력이 약해진 경우, 물로 깨끗하게 헹구면 접착력이 좋아집니다. 접착 시트를 물로 
깨끗하게 헹군 후에도 접착력이 회복되지 않으면 접착 시트를 교체하십시오. 접착 시트 구입에 대
한 자세한 내용은 공인 대리점에 문의하거나 당사 웹사이트(https://www.rolanddg.kr/)를 방문하
십시오.

두꺼운 물체의 인쇄 영역 외부 영역을 보호하십시오.
인쇄 영역 이외의 영역에 흩날리는 잉크의 미세한 입자를 "잉크 미스트"라고 합니다. 이 잉크 미스트가 개체에 
오염되면 제거하기가 어려워집니다. 인쇄 영역 외부 영역과 개체의 측면을 마스킹 테이프(A)로 덮거나 지그(B)
를 사용합니다.

IMPORTANT

5. 필요한 경우 다음 작업을 수행하십시오.

• 정전기 제거 브러시나 정전기 방지 천을 사용하여 개체의 정전기를 제거하십시오.
• 무수에탄올이나 이소프로필알코올을 사용하여 개체의 인쇄 부분의 유분을 제거하십시오.

6. 전면 커버를 닫습니다.

관련된 링크

・ P. 21 지그 사용을 고려하기
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Step 3: 개체 설정

개체를 배치한 다음 인쇄할 준비를 합니다.

전면 커버를 연 상태로 눈으로 확인하면서 플랫 테이블 높이, 인쇄 원점 등을 설정할 수 있습니다.
그러나 이러한 설정에서 [OK]를 클릭하면 플랫 테이블이 움직이기 시작할 수 있습니다. 따라서 전면 커버를 열었을 때 
움직이는 부품에 손이 닿지 않도록 주의하여 작업하십시오.

IMPORTANT

절차

1. 유틸리티 홈 화면에서 [Setup]을 클릭합니다.

2. 개체를 등록/선택합니다.

유틸리티에서는 객체를 등록/관리하는 창에서 "media"라는 명칭을 사용합니다.

MEMO

• 처음으로 개체에 인쇄하는 경우

a. 를 클릭합니다.

b. 새 개체의 이름을 입력한 후 [OK]를 클릭합니다.
이전에 등록된 미디어 이름은 사용할 수 없습니다. 새 미디어 이름을 입력합니다.

• 자주 사용하는 개체는 즐겨찾기로 설정하는 것이 좋습니다.

1. 등록된 개체 이름 옆의       을 클릭하면 이 아이콘이        로 변경됩니다.

2. 검색창 옆의        을 클릭하십시오.

MEMO

인쇄 위치를 수동으로 결정하는 경우
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아이콘이 로 변경되고, 즐겨찾기로 설정된 미디어 목록이 나타납니다.

• 등록된 모든 개체를 표시할 수 있습니다.
로터리 유닛이 장착되지 않은 경우 일반적인 개체가 표시됩니다. 로터 유닛이 장착된 경우 이 유닛과 함께 
사용할 개체가 표시됩니다.
              또는               를 클릭하면 등록된 모든 개체가 표시됩니다.

• 사전 등록된 개체의 경우
개체를 선택하고 [OK]를 클릭합니다.

즐겨찾기 기능과 검색 기능을 이용하여 등록된 개체를 쉽게 찾을 수 있습니다.

MEMO

Step 3~5는 필수가 아닙니다. Step 6로 진행하십시오.

고정 방법이나 흡착 매트 등의 변경으로 인해 높이가 변경된 경우 높이를 설정합니다(Step 4).

IMPORTANT

3. [Object Type] 창에서 다음 중 하나를 선택하고 [OK]를 클릭합니다.

• [Transparent]: 투명한 개체를 사용하는 경우.
• [Opaque]: 불 투명한 개체를 사용하는 경우.

개체에 대한 자세한 내용은 개체(미디어) 등록 항목 을 참조하하십시오.

4. [Flat Table Height] 옆의 [Change]를 클릭하여 개체의 높이를 설정하십시오.

(1) 창 오른쪽에 있는             또는            를 클릭하여 개체의 가장 높은 지점을 헤드 갭 센서의 전후

      위치에 맞춥니다.

한 번의 클릭으로 이동 거리를 0.1 mm(0.004 in.), 1 mm(0.04 in.), 10 mm(0.39 in.) 또는 50 mm(1.97 
in.) 중에서 선택할 수 있습니다.

MEMO

(2) 창 왼쪽의            를 클릭하면 개체의 가장 높은 지점이 헤드 갭 센서에 접근하도록 조정합니다.

헤드 갭 센서와 접촉하지 않고 헤드 갭 센서에서 몇 mm 떨어진 위치(a)까지 개체의 가장 높은 
인쇄 위치를 이동합니다.
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a

(3) 인쇄면 높이가 일정하지 않거나 물체가 들려 있거나 뒤틀린 경우에는 [Flat Table Lowering Amount]를
설정하십시오.

P. 126 개체와 프린트 헤드 사이의 거리를 더 멀게 설정
(4) [Automatic Setup]을 클릭합니다.

플랫 테이블이 움직이고 헤드 갭 센서가 개체의 높이를 감지합니다.
(5) [OK]를 클릭합니다.

5. [Origin Relative] 또는 [Center Relative]에서 [Print Origin]을 선택합니다.

[Print Origin]에 대한 자세한 내용은 개체(미디어) 등록 항목을 참조하십시오.

6. [Print Origin] 및 [Printing Area] 옆에 있는 [Change]를 클릭한 후 인쇄 가능 영역을 설정하십시오.
이 섹션에서는 [Origin Relative]를 선택한 경우 설정을 구성하는 방법에 대해 설명합니다. 최대
인쇄 영역의 오른쪽 하단(S: 0 mm [0 in.], F: 0 mm [0 in.]*1)으로부터의 거리가 명확한 경우
[Numeric Input]을 사용하여 숫자 값을 입력합니다.

[Printing Area] 설정이 완료되면 프린트 헤드가 마르는 것을 방지하기 위해 프린트 헤드 캐리지를 같은 위치에 
약 3분 동안 방치되는 경우 원래 위치로 돌아갑니다. 절차를 다시 수행하십시오.

MEMO

(1) [Position Specification]에서 [Pointer]를 선택합니다.

프린트 헤드 캐리지가 이동하고 프린트 헤드 캐리지의 오른쪽에 있는 포인터가 최대 인쇄 영역
의 오른쪽 하단(S: 0 mm [0 in.], F: 0 mm [0in.])을 지시합니다.

(2) " ,           ,           또는 를 클릭한 후 포인터를 이동하여 인쇄 원점(인쇄 영역 오른쪽

      하단)을 지정합니다.
프린트 헤드 캐리지는 좌 우 방향으로 이동하고 플랫 테이블은 앞 뒤 방향으로 이동합니다. 
포인터가 지시하는 위치가 [Print Origin]을 뜻합니다.

(3) [OK]를 클릭합니다.

테이블 높이, 인쇄 원점, 인쇄 영역 설정 창으로 돌아갑니다.

*1 "S"는 스캔 방향(왼쪽/오른쪽)을 나타내고 "F"는 피드 방향(앞/뒤)을 나타냅니다.
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[Printing Area]에 대하여
여기에서 [Origin Relative]가 지정되었으므로 [Printing Area]의 왼쪽 상단이 자동으로 최대 위치(S: 210 mm 
[8.26 in.], F: 148 mm [5.82 in.])로 설정됩니다.

IMPORTANT

7. [OK]를 클릭합니다.

[Setup in progress.]가 표시됩니다. 설정이 완료되면 홈 화면으로 돌아가며, 등록된 개체 이름과
설정된 [Flat Table Height], [Print Origin], [Printing Area]이 표시됩니다.
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Step 4: 인쇄 수행

FlexiDESIGNER에서 인쇄합니다. FlexiDESIGNER를 시작하면 VersaWorks도 시작됩니다. VersaWorks는 
인쇄 데이터를 처리하는 데 사용되므로 실행 상태를 유지해야 합니다.

컴퓨터 디스플레이 설정에 따라 [Send to Device] 또는 [Print parameters] 창이 모니터에 맞지 않을 수 있습니다. 
이 경우 디스플레이 설정에서 배율과 레이아웃을 조정하십시오.

MEMO

절차

1. 저장된 인쇄 데이터를 엽니다.

2. 를 클릭합니다.

[Send to Device] 대화 상자가 나타납니다.

3. [Device]에서 프린터(BD-8)를 선택합니다.

4. [Print parameters]를 클릭하고 인쇄 세부 사항을 설정합니다.

5. [Send]를 클릭합니다.

인쇄가 시작됩니다.

시판하는 응용 프로그램 소프트웨어(예. Adobe Illustrator)를 사용하여 인쇄 데이터를 생성한 경우 VersaWorks에서 인쇄
됩니다. 자세한 내용은 VersaWorks 도움말을 참조하십시오.

MEMO

관련된 링크
・ FlexiDESIGNER 소개
・ P. 87 인쇄 파라메터(FlexiDESIGNER)
・ VersaWorks 도움말
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먼저 정렬 마커를 인쇄합니다. 마커를 인쇄한 후 평평한 테이블 위에 개체를 놓고 스마트폰을 사용하여 사진
을 촬영합니다. 캡처한 사진 데이터를 FlexiDESIGNER로 가져와 인쇄 데이터를 만듭니다.

단일 지점으로 인쇄하는 경우와 같이 실제로 많은 인쇄 위치나 인쇄 크기가 필요하지 않은 인쇄에 이 인쇄 
방법을 사용합니다.

• 높이가 있는 물체에는 적합하지 않습니다.
인쇄된 표면의 높이를 감지할 수 없기 때문에 두께가 3 mm (0.12 in.) 이상인 물체의 경우 인쇄 위치가 크게 어긋나
게 됩니다.
이는 인쇄면이 두께로 인해 정렬 마커보다 카메라에 더 가까운 위치에 있고, 근접성으로 인해 물체의 면적이 더 크기
때문입니다. 따라서 두꺼운 물체에 인쇄하면 약간 더 크게 인쇄됩니다.

• 물체의 가장자리까지 끝까지 인쇄하는 데에는 적합하지 않습니다.
물체의 가장자리를 감지하기 어렵기 때문에 인쇄 위치 어긋남이 심각할 수 있습니다.

IMPORTANT

이 절차에 대한 참조 비디오를 보려면 다음 링크를 사용하십시오. 전반적인 워크플로우를 이해하려면 이 비디오를 시청하는
것이 좋습니다.
https://youtu.be/e7o7rG--i_s

MEMO

Step 1: 정렬 마커 인쇄

최대 인쇄 영역의 네 모서리 근처에 정렬 마커(10 mm × 10 mm [0.39 in. × 0.39 in.])를 인쇄합니다.

절차

1. 서브 전원 버튼을 누르십시오.

2. 전면 커버를 엽니다.

3. 플랫 테이블 위의 그림과 같은 위치에 단색 테이프를 부착합니다.

정렬 마커의 인쇄 시간을 줄이기 위해 흰색 테이프를 권장합니다.

MEMO

• 부착 영역(A)은 흰색 라인에서 최소 12 mm (0.48 in.) 떨어져 있어야 합니다.

캡처한 이미지를 사용하여 인쇄 위치 결정
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• 최대 인쇄 영역의 흰색 라인이 투명할 경우 더 이상 투명하지 않을 때까지 흰색 라인 위에 테
이프를 붙이거나 불투명 테이프를 사용하십시오.

AA

A

4. 전면 커버를 닫습니다.

5. 최대 인쇄 영역에 3단계에서 붙인 테이프를 설정합니다.
[Origin Relative]에서 인쇄 원점을 S: 0 mm (0 in.), F: 0 mm (0 in.)로 지정합니다. 인쇄 영역을 
지정-하지 않으면 W: 210 mm (8.27 in.), L: 148 mm (5.83 in.)로 설정됩니다.

6. 유틸리티 홈 화면에서        를 클릭합니다.

7. [Preferences]를 클릭한 후 [Alignment Marker Printing]의 [Execute]를 클릭합니다.

8. 3단계의 테이프가 흰색인 경우 [Print White Alignment Marker Background] 확인란의 선택을 취소하십시오.

9. [OK]를 클릭합니다.

인쇄가 시작됩니다.

10. 인쇄가 끝나면 [Close]를 클릭합니다.

11. [Cancel Setup]을 클릭합니다.

12. [OK]를 클릭합니다.

관련된 링크

・ P. 18 인쇄 가능 영역
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Step 2: 개체 배치 및 이미징

절차

1. 전면 커버를 엽니다.

2. 플랫 테이블의 인쇄 영역(흰색 라인 내부) 내에 개체를 놓습니다.

(1) 개체를 배치합니다.
제공된 접착 시트는 정렬 마커를 가리기 때문에 사용할 수 없습니다. 사용하기 전에 자르거나 
개체가 움직이지 않도록 고정하십시오.

(2) 필요한 경우 다음 작업을 수행하십시오.

• 정전기 제거 브러시나 정전기 방지 천을 사용하여 개체의 정전기를 제거하십시오.
• 무수에탄올이나 이소프로필알코올을 사용하여 개체의 인쇄 부분의 그리스를 제거하십시

오.

3. 스마트폰으로 이미징을 수행할 때는 다음 사항에 유의하십시오.

• 정렬 마커에 초점을 맞춥니다.
개체가 아닌 정렬 마커에 초점을 맞춰 이미징을 수행합니다.

• 네 모서리의 모든 정렬 마커가 캡처된 이미지에 포함되어야 합니다.
정렬 마커가 숨겨져 있거나 누락된 경우 위치를 감지할 수 없습니다. 캡처된 이미지에 4개의 정
렬 마커가 모두 포함되도록 이미징을 수행합니다.

좋은 포지셔닝의 예

잘못된 위치 지정의 예

•  물체 바로 위에서 이미징을 수행합니다.

캡처한 이미지를 사용하여 인쇄 위치 결정
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물체의 가장자리를 보다 쉽게 감지할 수 있도록 다음 그림과 같이 이미징을 수행하십시오. 특히 
두꺼운 물체의 경우 물체의 측면이 캡처되지 않도록 이미징을 수행하십시오.

Good

No
Good

• 이미지 데이터를 JPEG 또는 HEIC 형식으로 저장합니다.
.jpeg 또는 .HEIC 사진 데이터 형식*1을 지원하지 않는 모델을 사용하는 경우 가져오기 전에 
저장 형식을 jpeg 또는 HEIC로 변경하거나 데이터를 jpeg 또는 HEIC로 변환하십시오.

4. 이미징 데이터를 컴퓨터에 저장합니다.

관련된 링크
・ P. 212 정렬 마커를 사용한 인쇄 위치가 잘못 정렬되는 경우
・ P. 214 정렬 마커를 읽을 수 없는 경우

*1 일부 Apple 제품에는 HEIC의 기본 저장 형식이 있습니다.
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Step 3: 개체 Setup

개체를 배치한 다음 인쇄할 준비를 합니다.

전면 커버를 연 상태로 눈으로 확인하면서 플랫 테이블 높이, 인쇄 원점 등을 설정할 수 있습니다.
그러나 이러한 설정에서 [OK]를 클릭하면 플랫 테이블이 움직이기 시작할 수 있습니다. 따라서 전면 커버를 열었을 때 
움직이는 부품에 손이 닿지 않도록 주의하여 작업하십시오.

IMPORTANT

절차

1. 유틸리티 홈 화면에서 [Setup]을 클릭합니다.

2. 개체를 등록/선택합니다.

유틸리티에서는 객체를 등록/관리하는 창에서 "media"라는 명칭을 사용합니다.

MEMO

• 처음으로 개체에 인쇄하는 경우

a. 를 클릭합니다.

b. 새 개체의 이름을 입력한 후 [OK]를 클릭합니다.
이전에 등록된 미디어 이름은 사용할 수 없습니다. 새 미디어 이름을 입력합니다.

• 자주 사용하는 개체는 즐겨찾기로 설정하는 것이 좋습니다.

1. 등록된 개체 이름 옆의       을 클릭하면 이 아이콘이        로 변경됩니다.

2. 검색창 옆에 있는         을 클릭하십시오.

MEMO

캡처한 이미지를 사용하여 인쇄 위치 결정
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아이콘이          로 변경되고, 즐겨찾기로 설정된 미디어 목록이 나타납니다.

• 등록된 모든 개체를 표시할 수 있습니다.
로터리축 유닛이 장착되지 않은 경우 일반적인 개체가 표시됩니다. 로터리축 유닛이 장착된 경우 이 유닛
과 함께 사용할 개체가 표시됩니다.

또는 를 클릭하면 등록된 모든 개체가 표시됩니다.

• 사전 등록된 개체의 경우
개체를 선택한 후 [OK]를 클릭합니다.

즐겨찾기 기능과 검색 기능을 이용하여 등록된 개체를 쉽게 찾을 수 있습니다.

MEMO

3단계와 4단계는 필수가 아닙니다. 5단계를 진행합니다.

석션 매트의 변경 등으로 인해 높이가 변경된 경우 높이를 설정합니다(4단계).

IMPORTANT

3. [Object Type] 창에서 다음 중 하나를 선택한 후 [OK]를 클릭합니다.

개체에 대한 자세한 내용은 ECO-UV(EUV5) 잉크의 특징을 참조하십시오.

4. [Flat Table Height] 옆의 [Change]를 클릭하여 개체의 높이를 설정합니다.

(1) 창 오른쪽에 있는 "          또는           를 클릭하여 물체의 가장 높은 지점을 머리 간격 센서의 전후 

위치에 맞춥니다.

한 번의 클릭으로 이동 거리를 0.1 mm (0.004 in.), 1 mm (0.04 in.), 10 mm (0.39 in.) 또는 50 mm 
(1.97 in.) 중에서 선택할 수 있습니다.

MEMO

(2) 물체의 가장 높은 지점이 헤드 갭 센서에 접근하도록 하려면 창 왼쪽의            을 클릭합니다.

헤드 갭 센서와 접촉하지 않고 헤드 갭 센서에서 몇 mm 떨어진 위치(a)까지 개체의 가장 높은
인쇄 위치를 이동합니다.

캡처한 이미지를 사용하여 인쇄 위치 결정
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• [Transparent]: 물체의 반대편에 있는 손이 물체를 통해 보입니다.
• [Opaque]: 물체의 반대편에 있는 손은 물체를 통해 볼 수 없습니다.



a

(3) 인쇄면 높이가 일정하지 않거나 물체가 들리거나 휘어진 경우에는 아래를 참조하여 [Flat Table
Lowering Amount]을 설정하십시오.

P. 126 개체와 프린트 헤드 사이의 거리를 더 멀게 설정
(4) [Automatic Setup]를 클릭합니다.

플랫 테이블이 움직이고 헤드 갭 센서가 물체의 높이를 감지합니다.
(5) [OK]를 클릭합니다.

5. [OK]를 클릭합니다.

[Printing Area]가 설정되지 않은 경우 기본적으로 최대 인쇄 영역(W: 210 mm × L: 148 mm [W:
8.26 in. × L: 5.82 in.])가 [Printing Area]가 됩니다. 정렬 마커를 사용하여 인쇄하는 경우 최대
인쇄 영역으로 설정하십시오.

[Setup in progress.]가 표시됩니다. Setup이 완료되면 홈 화면으로 돌아가며, 등록된 미디어 이름
과 설정된 [Flat Table Height], [Print Origin], [Printing Area]가 표시됩니다.

캡처한 이미지를 사용하여 인쇄 위치 결정
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Step 4: 위치를 확인하면서 데이터 만들기

절차

1. FlexiDESIGNER를 시작하려면 아래 절차를 따르십시오.

(1) Roland DG Connect Hub를 시작하십시오.

• Windows 11
i. [시작]>[모든 앱]을 클릭합니다.
ii. 앱(프로그램) 목록에서 [Roland DG Corporation] > [Roland DG Connect Hub]를

클릭합니다.
• Windows 10

i. [Start]를 클릭합니다.
ii. 앱(프로그램) 목록에서 [Roland DG Corporation] > [Roland DG Connect Hub]를

클릭합니다.
(2) 사용할 기기(BD-8)를 클릭합니다.

(3) FlexiDESIGNER의 [Open]을 클릭합니다.

2. 아래 절차에 따라 Step 1: 정렬 마커 인쇄에서 저장한 사진 파일을 FlexiDESIGNER로 가져옵니다.

(1) [File]>[Open AR Photo]를 클릭합니다.

파일 선택 창이 열립니다.
(2) 촬영된 이미지 파일을 선택한 후 [Import...]를 클릭합니다.

캡처된 이미지는 4개의 정렬 마커 크기(210 mm × 148 mm[8.27 in. × 5.83 in.])로 잘려
디자인 영역에 표시됩니다.

캡처한 이미지를 사용하여 인쇄 위치 결정
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정렬 마커를 읽을 수 없으면 [Conversion failed the original image will be used.]가 표시됩니다. 이
미징을 다시 수행하고 다시 읽으려면 정렬 마커를 읽을 수 없는 경우를 참조하십시오.

MEMO

3. 인쇄 데이터를 생성하고 저장합니다.

인쇄 데이터는 개체를 배경으로 생성되므로 인쇄 후 어떻게 보일지 시각화하면서 작업할 수 있습
니다.
인쇄 데이터 생성에 대한 자세한 내용은 "FlexiDESIGNER 소개"를 참조하십시오.

관련된 링크
・ FlexiDESIGNER 소개
・ P. 212 정렬 마커를 사용한 인쇄 위치가 잘못 정렬되는 경우
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Step 5: 인쇄 수행

컴퓨터 디스플레이 설정에 따라 [Send to Device] 또는 [Print parameters] 창이 모니터에 맞지 않을 수 있습니다. 
이 경우 디스플레이 설정에서 배율과 레이아웃을 조정하십시오.

MEMO

절차

1. 저장된 인쇄 데이터를 엽니다.

2. 를 클릭합니다.

[Send to Device] 대화 상자가 나타납니다.

3. 다음 사항을 확인하십시오.

• [Device]: BD-8
• [Number of prints]: 1
• [Output]: Page

4. [Print parameters]를 클릭하고 인쇄 세부 사항을 설정합니다.
[Quality] 탭에서 [Media Type]와 [Mode]를 설정하십시오. Pr 또는 Wh의 사용 여부와 인쇄 데이
터에 따라 적절하게 설정합니다.

5. [Send]를 클릭합니다.

인쇄가 시작됩니다.

6. 인쇄가 완료되면 개체를 제거하고 유틸리티 설정을 종료합니다.

관련된 링크

・ FlexiDESIGNER 소개
・ P. 87 인쇄 파라메터(FlexiDESIGNER)
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[Media Type] 및 [Mode] 인쇄 파라메터에 대해 서로 다른 옵션을 선택하면 다양한 인쇄 유형이 가능해집
니다. 이러한 다양한 유형이 아래에 나열되어 있습니다.

[Media Type] [Quality] [Mode] 설명

[General] [High Speed]
[Standard]
[High Quality]

[CMYK]
[White->CMYK]
[CMYK->White]
[White]

일반 개체나 인쇄면이 매끄러운 개체에 사용
됩니다.

[Text Decoration] [High Speed]
[Standard]

[CMYK]
[White->CMYK]
[CMYK->White]
[White]

이니셜이나 모양을 한 점으로 인쇄하거나 작은 
면적에 인쇄하는 등 간단한 인쇄에 적합합니다.

[Generic Distance] [High Speed]
[Standard]

[CMYK]
[White->CMYK]
[CMYK->White]
[White]

인쇄 표면이 2 mm (0.08 in.) 이상 고르지 않거나 
구형인 개체에 사용됩니다.
[General]에 비해 인쇄 시간이 더 깁니다.

[Generic with Primer] [High Speed]
[Standard]
[High Quality]

[Primer->CMYK]
[Primer->White->CMYK]
[Primer->CMYK->White]
[Primer->White]

[General]에서 인쇄용 프라이머에 사용됩니다.

[Text Decoration with Primer] [High Speed]
[Standard]

[Primer->CMYK]
[Primer->White->CMYK]
[Primer->CMYK->White]
[Primer->White]

[Text Decoration]에서 인쇄용 프라이머에 
사용됩니다.

[Generic Distance with 
Primer]

[High Speed]
[Standard]

[Primer->CMYK]
[Primer->White->CMYK]
[Primer->CMYK->White]
[Primer->White]

[Generic Distance]에서 프라이머 인쇄에 사용
됩니다.
[Generic with Primer]에 비해 인쇄 시간이 더 
깁니다.

[Media Type] 및 [Mode] 선택의 예

Wh에 CMYK를 인쇄하는 경우
[General], [Wh->CMYK]를 선택하고 [White Plate Generation] 확인란을 선택합니다.

←Wh
←CMYK

CMYK에 Wh를 인쇄하는 경우
[General], [CMYK->Wh]를 선택하고 [White Plate Generation] 확인란을 선택합니다.

←Wh
←CMYK

Pr에 CMYK를 인쇄하는 경우
[Generic with Primer] 및 [Pr->CMYK]를 선택합니다.

←Pr
←CMYK

Pr에 Wh 및 CMYK를 인쇄하는 경우
[Generic with Primer] 및 [Pr->Wh->CMYK]를 선택하고 [White Plate Generation] 확인란을 
선택합니다. ←Wh

←Pr

←CMYK

Pr에 CMYK 및 Wh를 인쇄하는 경우
[Generic with Primer] 및 [Pr->CMYK->Wh]를 선택하고 [White Plate Generation] 확인란을 
선택합니다.

←Wh

←Pr
←CMYK

인쇄 파라메터(FlexiDESIGNER)
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파우더 파운데이션 케이스에 텍스트를 인쇄해 보세요.

Step 1: 인쇄 데이터 만들기

개체의 인쇄 크기를 측정하고 인쇄 영역을 설정한 후 인쇄 데이터를 생성합니다.

아래 절차에 따라 FlexiDESIGNER Ver. 22.0.0, 빌드 번호 4176을 작동합니다. 작동 방법은 FlexiDESIGNER 버전에 따라 
달라질 수 있습니다.

MEMO

절차

1. 인쇄 영역(개체의 인쇄 표면)을 측정합니다.
인쇄 영역을 설정하는 데 필요합니다. 측정할 때 측정값을 기록해 두십시오. 이 경우 인쇄할 파우더 
파운데이션 케이스의 인쇄면은 너비가 111 mm (4.37 in.)이고 길이가 71 mm (2.79 in.)입니다.

2. 아래 절차에 따라 FlexiDESIGNER를 시작하십시오.

(1) Roland DG Connect Hub를 시작합니다.

• Windows 11
i. [시작]>[모든 앱]을 클릭하십시오.
ii. 앱(프로그램) 목록에서 [Roland DG Corporation]>[Roland DG Connect Hub]를  

클릭합니다.
• Windows 10

i. [시작]을 클릭합니다.
ii. 앱(프로그램) 목록에서 [Roland DG Corporation]>[Roland DG Connect Hub]를  

클릭하십시오.
(2) 사용할 기기(BD-8)를 클릭합니다.

(3) FlexiDESIGNER의 [Open]을 클릭하십시오.

3. 아래 절차에 따라 인쇄 데이터의 크기를 설정하십시오.

(1)          아이콘(A)을 클릭합니다.

[DesignCentral] 대화상자(B)가 열립니다.

(2)          탭(C)에서 풀다운 메뉴 [▼]를 클릭한 후 [Custom]을 선택합니다.

(3) 1단계에서 측정한 인쇄 크기(111 mm, 71 mm[4.37 in., 2.79 in.])를 입력합니다.

화장품에 인쇄하기
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디자인 영역에 인쇄 크기 프레임(D)이 생성됩니다.

4. 인쇄할 데이터를 생성합니다.

여기에 이름을 입력하고 텍스트에 색상을 적용합니다.

(1)     [Text Tool]을 클릭합니다.

(2) 문자를 입력하려는 위치와 가까운 위치를 클릭한 후 문자를 입력하십시오.

(3)     [Select Tool]을 클릭합니다.

(4) 입력한 텍스트를 선택한 후 [DesignCentral] 대화상자의         탭을 클릭하여 글꼴과 크기를 조정
      하십시오.

(5) 텍스트를 선택한 다음 원하는 위치에 배치합니다.

(6)          아이콘을 클릭합니다.

[Fill/Stroke Editor] 대화 상자가 열립니다.

(7) 텍스트를 선택한 상태에서         탭의 풀다운 메뉴 [▼]를 클릭한 후 [Silid fill]를 선택합니다.

(8)  색상 선택 풀다운 메뉴[▼]에서 원하는 색상을 선택합니다.

5. [File]>[Save]를 클릭하여 데이터를 저장합니다.

관련된 링크

화장품에 인쇄하기
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・ FlexiDESIGNER 소개
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Step 2: 개체 배치 및 설정

개체를 배치한 다음 인쇄할 준비를 합니다.

전면 커버를 연 상태로 눈으로 확인하면서 플랫 테이블 높이, 인쇄 원점 등을 설정할 수 있습니다.
그러나 이러한 설정에서 [OK]를 클릭하면 플랫 테이블이 움직이기 시작할 수 있습니다. 따라서 전면 커버를 열었을 때 
움직이는 부품에 손이 닿지 않도록 주의하여 작업하십시오.

IMPORTANT

절차

1. 유틸리티를 시작합니다.

P. 35 유틸리티 시작

2. 개체를 배치합니다.

(1) 필요한 경우 다음 작업을 수행하십시오.

• 정전기 제거 브러시나 정전기 방지 천을 사용하여 개체의 정전기를 제거하십시오.
• 무수 에탄올이나 이소프로필 알코올을 사용하여 개체의 인쇄부분의 그리스를 제거하십시

오.
• 마스킹 테이프로 인쇄 영역 이외의 영역을 보호하십시오.

(2) 전면 커버를 엽니다.

(3) 플랫 테이블에 이물질이나 기타 이물질이 붙어 있지 않은지 확인하십시오.

(4) 플랫 테이블 위에 접착 시트를 놓습니다.

(5) 개체를 배치합니다.

• 인쇄 데이터는 180도 회전된 데이터로 인쇄됩니다.
• 흰색 테두리 안에 개체를 흰색 테두리와 평행하게 배치합니다.

(6) 전면 커버를 닫습니다.

3. 개체를 Setup합니다.

(1) 유틸리티 홈 화면에서 [Setup]을 클릭합니다.

(2) 를 클릭합니다.

이전에 등록된 미디어 이름은 사용할 수 없습니다. 새 미디어 이름을 입력합니다.

화장품에 인쇄하기
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(3) 개체 이름을 입력한 후 [OK]를 클릭합니다.

(4) [Object Type] 창에서 [Opaque]을 선택한 후 [OK]를 클릭하십시오.

(5) [Flat Table Height] 옆의 [Change]를 클릭하여 개체의 높이를 설정하십시오.

i. 창 오른쪽에 있는           또는         를 클릭하여 물체의 가장 높은 지점을 헤드 캡 센서의

전후 위치에 맞춥니다.

한 번의 클릭으로 이동 거리를 0.1 mm (0.004 in.), 1 mm (0.04 in.), 10 mm (0.39 in.) 또는 
50 mm (1.97in.) 중에서 선택할 수 있습니다.

MEMO

ii. 물체의 가장 높은 지점이 헤드 갭 센서에 접근하도록 하려면 창 왼쪽의          을 클릭

합니다.
헤드 갭 센서와 접촉하지 않고 헤드 갭 센서에서 몇 mm 떨어진 위치(a)까지 개체의 가장
높은 인쇄 위치를 이동합니다.

a

iii. [Automatic Setup]를 클릭합니다.
플랫 테이블이 움직이고 헤드 갭 센서가 개체의 높이를 감지합니다.

iv. [OK]를 클릭합니다.
(6) [Print Origin] 및 [Printing Area]에 대해 [Change]를 클릭한 다음 [Print Origin]을 클릭합니다.

[Printing Area] 설정이 완료되면 프린트 헤드가 마르는 것을 방지하기 위해 프린트 헤드 캐리지를 같은 
위치에 약 3분 동안 방치한 후 원래 위치로 돌아갑니다. 절차를 다시 수행하십시오.

MEMO

i. [Position Specification]에서 [Pointer]를 선택합니다.
인쇄 헤드 캐리지가 이동한 다음 인쇄 헤드 캐리지의 오른쪽에 있는 포인터가 최대 인쇄 영
역의 오른쪽 하단 (S: 0 mm [0 in.], F: 0 mm [0 in.])을 비춰줍니다.

ii. ,         ,          또는          를 클릭한 다음 포인터를 이동하여 인쇄 원점(인쇄 영역

 오른쪽 하단)을 지정합니다.
프린트 헤드 캐리지는 왼쪽-오른쪽 방향으로 이동하고 플랫 테이블은 앞뒤 방향으로 이동
합니다. 포인터가 비춰지는 위치가 [Print Origin] 역할을 합니다.

화장품에 인쇄하기

인쇄 예시 93



iii. [OK]를 클릭합니다.
[Flat Table Height], [Print Origin], [Printing Area] 설정 창으로 돌아갑니다.

[Printing Area]에 대하여
여기에서 [Origin Relative]가 지정되었으므로 인쇄 영역의 왼쪽 상단이 자동으로 최대 위치(S: 210 
mm [8.26 in.], F: 148 mm [5.82 in.])로 설정됩니다.

MEMO

4. [OK]를 클릭합니다.

[Setup in progress.]가 표시됩니다. 설정이 완료되면 홈 화면으로 돌아가며, 등록된 개체 이름
과설정된 [Flat Table Height], [Print Origin], [Printing Area]가 표시됩니다.

화장품에 인쇄하기
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Step 3: 인쇄 수행

컴퓨터 디스플레이 설정에 따라 [Send to Device] 또는 [Print parameters] 창이 모니터에 맞지 않을 수 있습니다. 
이 경우 디스플레이 설정에서 배율과 레이아웃을 조정하십시오.

MEMO

절차

1. FlexiDESIGNER에서 생성된 인쇄 데이터를 엽니다.

[File]>[Open]를 클릭하면 저장된 인쇄 데이터가 열립니다.

2.           를 클릭합니다.

[Send to Device] 대화 상자가 열립니다.

3. 다음을 확인하십시오.

• [Device]: BD-8
• [Number of prints]: 1
• [Output]:[Page]

4. [Print parameters]를 클릭합니다.

5. [Quality] 탭에서 다음을 선택합니다.

• [Media Type]:[Text Decoration]
• [Print Quality]:[Standard]
• [Mode]: [CMYK (v)]

6. [OK]를 클릭합니다.

인쇄 파라메터 창이 닫힙니다.

7. [Send]를 클릭합니다.

인쇄가 시작됩니다.

8. 인쇄가 완료되면 개체를 제거하고 유틸리티 설정을 종료합니다.

관련된 링크
・ P. 87 인쇄 파라메터(FlexiDESIGNER)
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골프공에 텍스트와 모양을 인쇄합니다.

이 절차에 대한 참조 비디오를 보려면 다음 링크를 사용하십시오. 전반적인 워크플로우를 이해하려면 이 비디오를 시청하는
것이 좋습니다.
https://youtu.be/loKdOoNH2vw

MEMO

Step 1: 인쇄 데이터 만들기

인쇄 크기를 설정한 후 인쇄 데이터를 생성합니다.

FlexiDESIGNER Ver. 22.0.0, 빌드 번호 4176을 작동하려면 아래 절차를 따르십시오. FlexiDESIGNER 버전에 따라 작동 
방법이 다를 수 있습니다.

MEMO

절차

1. FlexiDESIGNER를 시작하려면 아래 절차를 따르십시오.

(1) Roland DG Connect Hub를 시작하십시오.

• Windows 11
i. [시작]>[모든 앱]을 클릭합니다.
ii. 앱(프로그램) 목록에서 [Roland DG Corporation]>[Roland DG Connect Hub]를

클릭합니다.
• Windows 10

i. [시작]을 클릭합니다.
ii. 앱(프로그램) 목록에서 [Roland DG Corporation]>[Roland DG Connect Hub]를

클릭합니다.
(2) 사용할 기기(BD-8)를 클릭하십시오.

(3) FlexiDESIGNER의 [Open]을 클릭합니다.

2. 아래 절차에 따라 인쇄 데이터의 크기를 설정하십시오.

(1) 아이콘(A)을 클릭합니다.

[DesignCentral] 대화상자(B)가 열립니다.

(2) 탭(C)에서 풀다운 메뉴 [▼]를 클릭한 후 [Custom]을 선택합니다.

골프공에 인쇄하기
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(3) 골프공의 인쇄 크기를 입력합니다.

골프공에 인쇄할 경우 인쇄 영역에 맞게 [Media Type]을 다음과 같이 설정하십시오.

• [General]: 인쇄 영역 직경 최대 18 mm (0.7 in.)
• [Generic Distance]: 인쇄 영역 직경 18 mm ~ 29 mm (0.71 in. ~ 1.14 in.)

IMPORTANT

디자인 영역에 인쇄 크기 프레임(D)이 생성됩니다.

3. 인쇄할 데이터를 생성합니다.

이 섹션에서는 메시지와 모양을 디자인합니다. 텍스트의 서체와 각도, 모양의 크기 및 기타 파라메터
를 지정합니다.

(1)     [Text Tool]을 클릭합니다.

(2) 문자를 입력하려는 위치와 가까운 위치를 클릭한 후 문자를 입력합니다.

(3)          [Select Tool]을 클릭하고 텍스트 항목을 선택합니다.

(4) [DesignCentral] 대화상자에서         탭을 클릭한 후 서체와  크기를 조정하십시오.

(5) 텍스트를 선택한 다음 원하는 위치에 배치합니다.

(6) 각도를 조정하려면         탭을 클릭합니다.

(7)           아이콘을 클릭합니다.

(8) 텍스트를 선택한 상태에서         탭의 풀다운 메뉴를 클릭한 후 [Silid fill]를 선택합니다.

(9) 풀다운 메뉴에서 원하는 색상을 선택하십시오.

(10)  "     [Rectangle Tool]을 누르고        [Starburst Tool]을 선택합니다.

(11) 도형을 추가하려는 위치 근처로 드래그합니다.

드래그 길이에 따라 별 모양이 그려집니다.

(12) 모양을 선택한 상태에서         탭의 풀다운 메뉴를 클릭한 후 [Silid fill]을 선택합니다.

(13) 풀다운 메뉴에서 원하는 색상을 선택합니다.

(14) (11)~(13)단계를 반복하여 모양을 배치합니다.

골프공에 인쇄하기
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4. [File]>[Save]를 클릭하여 데이터를 저장합니다.

관련된 링크
・ FlexiDESIGNER 소개
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Step 2: 개체 배치 및 설정

개체를 배치한 다음 인쇄할 준비를 합니다.

작업 중에 더 가까이 보기 위해 플랫 테이블의 높이, 인쇄 원본 또는 기타 설정을 설정할 때 전면 커버를 열어 둘 수 있습니
다.
그러나 이러한 설정이 구성된 상태에서 [OK]를 클릭하면 인쇄 헤드 캐리지 또는 플랫 테이블이 움직이기 시작할 수 있습
니다. 따라서 전면 커버가 열려 있을 때는 작업 중 움직이는 부품이 닿지 않도록 주의해야 합니다.

IMPORTANT

절차

1. 유틸리티를 시작합니다.

P. 35 유틸리티 시작

2. 약 30 mm × 30 mm (1.18 in. × 1.18 in.)의 인쇄 영역을 고정하는 지그를 준비합니다.

A

B

C

A: 약 30 mm (1.18 in.) B: 약 40 mm (1.57 in.) C: 약 100 mm (3.94 in.)

3. 개체를 배치합니다.

(1) 필요한 경우 다음 작업을 수행하십시오.

• 정전기 제거 브러시나 정전기 방지 천을 사용하여 물체의 정전기를 제거하십시오.
• 무수 에탄올이나 이소프로필 알코올을 사용하여 대상물의 인쇄부분의 그리스를 제거하십

시오.
(2) 전면 커버를 엽니다.

(3) 플랫 테이블에 이물질이나 기타 이물질이 붙어 있지 않은지 확인하십시오.

(4) 플랫 테이블 위에 접착 시트를 놓습니다.

(5) 개체를 놓고 지그를 장착합니다.

• 인쇄 데이터는 180도 회전된 데이터로 인쇄됩니다.
• 종이와 같은 가벼운 소재로 만든 지그 자체도 고정되어야 합니다.

(6) 전면 커버를 닫습니다.

4. 개체를 Setup합니다.

(1) 유틸리티 홈 화면에서             [Setup]을 클릭합니다.

(2)      를 클릭합니다.

골프공에 인쇄하기
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유틸리티에서는 객체를 등록/관리하는 창에서 "media"라는 명칭을 사용합니다.

MEMO

(3) 개체 이름을 입력한 후 [OK]를 클릭합니다.

이전에 등록된 미디어 이름은 사용할 수 없습니다. 새 미디어 이름을 입력하십시오.

(4) [Object Type] 창에서 [Opaque]를 선택한 후 [OK]을 클릭합니다.

(5) [Flat Table Height] 옆의 [Change]를 클릭하여 개체의 높이를 설정합니다.

i. 창 오른쪽에 있는           또는          를 클릭하여 개체의 가장 높은 지점을 헤드 갭 센서의

    전후 위치에 맞춥니다.

한 번의 클릭으로 이동 거리를 0.1 mm (0.004 in.), 1 mm (0.04 in.), 10 mm (0.39 in.) 또는 50 mm 
(1.97 in.) 중에서 선택할 수 있습니다.

MEMO

ii. 물체의 가장 높은 지점이 헤드 갭 센서에 접근하도록 하려면 창 왼쪽의           클릭합니다.

헤드 갭 센서와 접촉하지 않고 헤드 갭 센서에서 몇 mm 떨어진 위치(a)까지 개체의 가장 
높은 인쇄 위치를 이동합니다.

a

iii. [Automatic Setup]를 클릭합니다.
플랫 테이블이 움직이고 헤드 갭 센서가 개체의 높이를 감지합니다.

iv. [OK]를 클릭합니다.
(6) [Print Origin]에서 [Center Relative]를 선택하고 [Change]를 클릭한 후 인쇄 가능 영역을 설정하십시오.

골프공에 인쇄하기
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[Printing Area] 설정이 완료되면 프린트 헤드가 마르는 것을 방지하기 위해 프린트 헤드 캐리지를 같은 
위치에 약 3분 동안 방치한 후 원래 위치로 돌아갑니다. 절차를 다시 수행하십시오.

MEMO

골프공의 중심을 [Print Origin]으로 [Printing Area]를 지정합니다.
i. [Position Specification]에서 [Pointer]를 선택합니다.

프린트 헤드 캐리지와 플랫 테이블이 이동한 후 프린트 헤드 캐리지 오른쪽에 있는 포인터
가 최대 인쇄 영역의 중앙을 비춥니다.

ii. [Printing Area]를 선택합니다.
프린트 헤드 캐리지와 플랫 테이블이 이동한 후 포인터가 최대 인쇄 영역의 왼쪽 상단을 비
춥니다.

iii. ,           ,           또는           를 클릭한 후 포인터를 이동하여 [Printing Area]를 

인쇄 데이터 크기로 변경합니다.

• 프린트 헤드 캐리지는 왼쪽-오른쪽 방향으로 이동하고 플랫 테이블은 앞뒤 방향으로
이동합니다.

• 인쇄 영역을 좁히면 중앙 위치를 이동할 수 있습니다.
iv. [Center Position]을 선택합니다.

v. "        ,          ,            또는           를 클릭한 다음 포인터를 이동하여 골프공의 노드

(인쇄 영역의 중심)를 지정합니다.
프린트 헤드 캐리지는 왼쪽-오른쪽 방향으로 이동하고 플랫 테이블은 앞뒤 방향으로 이동
합니다. 포인터가 비춰지는 위치는 인쇄 영역의 중심 역할을 합니다.

vi. [Printing Area]의 너비와 길이가 인쇄 데이터 크기와 동일한지 확인하십시오.
vii. [OK]를 클릭합니다.

[Flat Table Height], [Print Origin], [Printing Area] 설정 창으로 돌아갑니다.

5. [OK]를 클릭합니다.

[Setup in progress.]가 표시됩니다. Setup이 완료되면 홈 화면으로 돌아가며, 등록된 개체 이름과
설정된 [Flat Table Height], [Print Origin], [Printing Area]이 표시됩니다.
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Step 3: 인쇄 수행

컴퓨터 디스플레이 설정에 따라 [Send to Device] 또는 [Print parameters] 창이 모니터에 맞지 않을 수 있습니다. 
이 경우 디스플레이 설정에서 배율과 레이아웃을 조정하십시오.

MEMO

절차

1. FlexiDESIGNER에서 생성된 인쇄 데이터를 엽니다.

[File]>[Open]을 클릭하면 저장된 인쇄 데이터가 열립니다.

2.  를 클릭합니다.

[Send to Device] 대화 상자가 열립니다.

3. 다음 사항을 확인하십시오.

• [Device]: BD-8
• [Number of prints]: 1
• [Output]:[Page]

4. [Print parameters]를 클릭합니다.

5. [Quality] 탭에서 다음을 선택합니다.

• [Media Type]: [General] 또는 [Generic Distance]*1

• [Print Quality]:[Standard]
• [Mode]: [CMYK (v)]

6. [OK]를 클릭합니다.

인쇄 파라메터 창이 닫힙니다.

7. [Send]를 클릭합니다.

인쇄가 시작됩니다.

8. 인쇄가 완료되면 개체를 제거하고 유틸리티 설정을 종료합니다.

관련된 링크
・ P. 87 인쇄 파라메터(FlexiDESIGNER)

*1 인쇄 데이터의 직경이 18 mm (0.70 in.) 미만인 경우 [General]을 선택합니다. 인쇄 데이터의 직경이 18 mm (0.70 in.) 이상인 경우
       [Generic Distance]를 선택합니다.
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스마트폰으로 촬영한 사진을 스마트폰 케이스에 인쇄해 보십시오.

이 절차에 대한 참조 비디오를 보려면 다음 링크를 사용하십시오. 전반적인 작업 흐름을 이해하려면 이 비디오를 시청
하는것이 좋습니다.
https://youtu.be/731hOx8RR0A

MEMO

Step 1: 인쇄 데이터 만들기

개체의 인쇄 크기를 측정하고 인쇄 영역을 설정한 후 인쇄 데이터를 생성합니다.

FlexiDESIGNER Ver. 22.0.0, 빌드 번호 4176을 작동하려면 아래 절차를 따르십시오. FlexiDESIGNER 버전에 따라 작동 
방법이 다를 수 있습니다.

MEMO

절차

1.  인쇄 영역(물체의 인쇄 표면)을 측정합니다.
인쇄 영역을 설정하는 데 필요합니다. 측정할 때 측정값을 기록해 두십시오. 스마트폰 케이스의 인쇄
면은 가로로 놓을 때 너비가 134 mm (5.28 in.), 길이가 67 mm (2.64 in.)입니다. 이번에는 케이스 
전면에 인쇄하기 위해 인쇄 영역을 인쇄면보다 크게 설정합니다. 인쇄된 표면의 가장자리 외부에 인
쇄하면 낭비되지만 가장자리까지 인쇄할 수 있습니다.

2. FlexiDESIGNER를 시작합니다.

(1) Roland DG Connect Hub를 시작하십시오.

• Windows 11
i. [시작]>[모든 앱]을 클릭합니다.
ii. 앱(프로그램) 목록에서 [Roland DG Corporation]>[Roland DG Connect Hub]를  

클릭합니다.
• Windows 10

i. [시작]을 클릭합니다.
ii. 앱(프로그램) 목록에서 [Roland DG Corporation]>[Roland DG Connect Hub]를  

클릭합니다.
(2) 사용할 기기(BD-8)를 클릭합니다.

(3) FlexiDESIGNER의 [Open]을 클릭합니다.

스마트폰 케이스에 인쇄하기
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3. 아래 절차에 따라 인쇄 영역을 설정하십시오.

(1)         아이콘(A)을 클릭합니다.

[DesignCentral] 대화상자(B)가 열립니다.

(2)         탭(C)에서 풀다운 메뉴 [▼]를 클릭한 후 [Custom]을 선택합니다.

(3) 1단계에서 측정한 인쇄 면적보다 좌우, 위아래로 1 mm (0.04 in.) 큰 인쇄 면적 (136 mm × 69 mm
      (5.35 in. × 2.72 in.)으로 입력합니다.

디자인 영역에 인쇄 영역 프레임(D)이 생성됩니다.

4. 인쇄할 데이터를 생성합니다.
여기서 사진을 가져오고 크기를 조정하고 다듬습니다. 그 후 접착력을 높이기 위해 프라이머 레이어
를 제작하고, 출력물의 색상이 비쳐지는 것을 방지하기 위해 흰색 레이어를 삽입합니다.

(1) 사진 데이터를 컴퓨터에 저장합니다.

(2) [File]>[Import...]를 클릭하고 저장된 사진 데이터를 선택한 후 [Import...]를 클릭합니다.

사진 데이터 크기의 파란색 점선 프레임이 창에 표시됩니다.
(3) 원하는 위치를 클릭한 후 사진 데이터를 디자인 영역에 붙여넣습니다.

사진 데이터의 크기가 큰 경우          [Zoom Out] 또는 "Ctrl + 스크롤"을 사용하여 전체 사진 데이터를 
볼 수 있습니다.

IMPORTANT

(4) 사진 데이터를 선택한 후 크기를 조정하십시오.

i. 로딩된 사진 데이터를 선택합니다.

ii. [DesignCentral] 대화상자에서       탭을 선택하고       를 클릭합니다.

로딩된 사진은 시계 반대 방향으로 90° 회전합니다.
iii. [DesignCentral] 대화 상자에서 [Proportional] 확인란을 선택하십시오.
iv. 인쇄 영역에 가까운 크기를 입력한 다음 Enter를 누르십시오.

잘라낼 이미지의 크기에 따라 크기를 조정합니다. 여기에서는 인쇄 영역 (136 mm, 69 mm 
[5.35in., 2.72 in.])에 대한 너비를 145 mm (5.71in.)로 설정합니다.
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(5) 트리밍을 수행합니다.

i.     [Rectangle Tool]를 선택하고 인쇄 영역(136  mm × 69 mm [5.35 in. × 2.72 in.])에 
   대한 프레임을 만듭니다.

이 프레임은 트리밍을 위한 외부 프레임으로 사용되므로        을 클릭한 후 다음과 같이 설정을 

구성합니다.

• 탭:[No fill]

• 탭: 선 유형: 실선; 선 색상: 빨간색

ii.       [Select Tool]을 선택한 후 프레임을 이동하여 트리밍 할 위치를 결정합니다.

iii.  선택 도구로 이미지와 프레임을 선택한 상태에서 [Arrange]>[Mask]>[Mask]를 클릭합니다.

이미지가 빨간색 선으로 트리밍 됩니다.
(6) 이미지와 프레임을 선택한 상태에서 [Arrange]>[Align]>[Both Centers to Page]를 클릭하십시오.

선택한 이미지가 인쇄 영역 중앙에 배치됩니다.

5. [File]>[Save]를 클릭하여 데이터를 저장합니다.
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Step 2: 개체 배치 및 설정

개체를 배치한 다음 인쇄할 준비를 합니다.

전면 커버를 연 상태로 눈으로 확인하면서 플랫 테이블 높이, 인쇄 원점 등을 설정할 수 있습니다.
그러나 이러한 설정에서 [OK]를 클릭하면 플랫 테이블이 움직이기 시작할 수 있습니다. 따라서 전면 커버를 열었을 때 
움직이는 부품에 손이 닿지 않도록 주의하여 작업하십시오.

IMPORTANT

절차

1. 유틸리티를 시작합니다.

P. 35 유틸리티 시작

2. 개체를 배치합니다.

(1) 필요한 경우 다음 작업을 수행하십시오.

• 정전기 제거 브러시나 정전기 방지 천을 사용하여 물체의 정전기를 제거하십시오.
• 무수 에탄올이나 이소프로필 알코올을 사용하여 대상물의 인쇄부분의 그리스를 제거하십

시오.
• 마스킹 테이프로 인쇄 영역 이외의 영역을 보호하십시오.

이 경우 개체의 가장자리까지 인쇄하기 위해 인쇄 영역을 개체보다 넓게 설정합니다. 개체의 
측면과 인쇄 영역의 구멍이 잉크 미스트에 노출되지 않도록 보호하십시오.

(2) 전면 커버를 엽니다.

(3) 플랫 테이블에 이물질이나 기타 이물질이 붙어 있지 않은지 확인하십시오.

(4) 플랫 테이블 위에 접착 시트를 놓습니다.

(5) 개체를 배치합니다.

• 인쇄 데이터는 180도 회전된 데이터로 인쇄됩니다.
• 흰색 테두리 안에 개체를 흰색 테두리와 평행하게 배치합니다.

(6) 전면 커버를 닫습니다.

3. 개체를 Setup합니다.

유틸리티에서는 객체를 등록/관리하는 창에서 "media"라는 명칭을 사용합니다.

MEMO

(1) 유틸리티 홈 화면에서              [Setup]을 클릭합니다.

(2)      를 클릭합니다.
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(3) 개체 이름을 입력한 후 [OK]를 클릭합니다.

이전에 등록된 미디어 이름은 사용할 수 없습니다. 새 미디어 이름을 입력합니다.

(4) [Object Type] 창에서 [Opaque]를 선택한 후 [OK]를 클릭하십시오.

(5) [Flat Table Height] 옆의 [Change]를 클릭하면 개체의 높이를 설정할 수 있습니다.

i. 창 오른쪽에 있는           또는          를 클릭하여 개체의 가장 높은 지점을 헤드 갭 센서의

    전후 위치에 맞춥니다.

한 번의 클릭으로 이동 거리를 0.1 mm (0.004 in.), 1 mm (0.04 in.), 10 mm (0.39 in.) 또는 
50 mm (1.97 in.) 중에서 선택할 수 있습니다.

MEMO

ii. 물체의 가장 높은 지점이 헤드 갭 센서에 접근하도록 하려면 창 왼쪽의           를 클릭

    합니다.

헤드 갭 센서와 접촉하지 않고 헤드 갭 센서에서 몇 mm 떨어진 위치(a)까지 개체의 가장 
높은 인쇄 위치를 이동합니다.

a

iii. [Automatic Setup]를 클릭합니다.
플랫 테이블이 움직이고 헤드 갭 센서가 물체의 높이를 감지합니다.

iv. [OK]를 클릭합니다.
(6) [Print Origin] 및 [Printing Area]에 대해 [Change]를 클릭하고 [Print Origin]을 클릭합니다.

[Printing Area] 설정이 완료되면 프린트 헤드가 마르는 것을 방지하기 위해 프린트 헤드 캐리지를 같은 
위치에 약 3분 동안 방치한 후 원래 위치로 돌아갑니다. 절차를 다시 수행하십시오.

MEMO
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i. [Position Specification]에서 [Pointer]를 선택합니다.

프린트 헤드 캐리지가 이동한 다음 프린트 헤드 캐리지의 오른쪽에 있는 포인터가 최대
인쇄 영역의 오른쪽 하단(S: 0 mm [0 in.], F: 0 mm [0 in.])을 비춰줍니다.

ii. ,           ,           또는          를 클릭한 후 포인터를 이동하여 인쇄 원점(인쇄 

    영역 오른쪽 하단)을 지정합니다.

프린트 헤드 캐리지는 왼쪽-오른쪽 방향으로 이동하고 플랫 테이블은 앞뒤 방향으로 이동
합니다. 포인터가 비춰지는 위치가 인쇄 원점 역할을 합니다.
이번 인쇄 데이터는 인쇄 영역보다 각 방향으로 1 mm (0.04 in.)씩 커지므로 아래 그림에
서 "a"가 1 mm (0.04 in.)인 인쇄 영역 외부의 인쇄 원점을 지정합니다.

a

a

iii. [OK]를 클릭합니다.
[Flat Table Height], [Print Origin], [Printing Area] 설정 창으로 돌아갑니다.

인쇄 영역
여기에서 [Origin Relative]가 지정되었으므로 인쇄 영역의 왼쪽 상단이 자동으로 최대 위치(S: 210 mm 
[8.26 in.], F: 148 mm [5.82 in.])로 설정됩니다.

MEMO

4. [OK]를 클릭합니다.

[Setup in progress.]가 표시됩니다. 설정이 완료되면 홈 화면으로 돌아가며, 등록된 개체 이름과
설정된 [Flat Table Height], [Print Origin], [Printing Area]가 표시됩니다.
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Step 3: 인쇄 수행

컴퓨터 디스플레이 설정에 따라 [Send to Device] 또는 [Print parameters] 창이 모니터에 맞지 않을 수 있습니다. 
이 경우 디스플레이 설정에서 배율과 레이아웃을 조정하십시오.

MEMO

절차

1. FlexiDESIGNER에서 생성된 인쇄 데이터를 엽니다.

[File]>[Open]을 클릭하면 저장된 인쇄 데이터가 열립니다.

2. 를 클릭합니다.

[Send to Device] 대화 상자가 열립니다.

3. 다음 사항을 확인하십시오.

• [Device]: BD-8
• [Number of prints]: 1
• [Output]:[Page]

4. [Print parameters]를 클릭합니다.

5. [Quality] 탭에서 다음을 선택합니다.

• [Media Type]:[General]
• [Print Quality]:[High Quality]
• [Mode]: [White->CMYK (v)]
• [Special Color Plate Generation]

• [White Plate Generation]: 확인란을 선택합니다.
• [Generated Pattern]:[Print Area]
• [Size Correction]:[No]

6. [OK]를 클릭합니다.

인쇄 파라메터 창이 닫힙니다.

7. [Send]를 클릭합니다.

인쇄가 시작됩니다.

8. 인쇄가 완료되면 개체를 제거하고 유틸리티 설정을 종료합니다.

관련된 링크
・ P. 87 인쇄 파라메터(FlexiDESIGNER)
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투명 아크릴 쉴드 뒷면에 사진과 텍스트를 거꾸로 인쇄합니다. 인쇄 데이터의 색상을 적절하게 표현하기 위해 
사진과 텍스트 뒤에 흰색이 인쇄됩니다.

이 절차에 대한 참조 비디오를 보려면 다음 링크를 사용하십시오. 전반적인 작업 흐름을 이해하려면 이 비디오를 시청하는
것이 좋습니다.
https://youtu.be/ud6ygZ9zvbc

MEMO

Step 1: 인쇄 데이터 만들기

개체의 인쇄 크기를 측정하고 인쇄 영역을 설정한 후 인쇄 데이터를 생성합니다.

FlexiDESIGNER Ver. 22.0.0, 빌드 번호 4176을 작동하려면 아래 절차를 따르십시오. FlexiDESIGNER 버전에 따라 작동 
방법이 다를 수 있습니다.

MEMO

절차

1. 인쇄 영역(물체의 인쇄 표면)을 측정합니다.
인쇄 영역을 설정하는 데 필요합니다. 측정할 때 측정값을 기록해 두십시오. 아크릴 스탠드의 인쇄
영역은 수평으로 놓을 때 너비 130 mm (5.12 in.), 길이 90 mm (3.54 in.)입니다. 인쇄 소재에 잘
라낸 사진과 메시지를 넣고 미러링한 후 인쇄해 보십시오.

2. FlexiDESIGNER를 시작합니다.

(1) Roland DG Connect Hub를 시작하십시오.

• Windows 11
i. [시작]>[모든 앱]을 클릭합니다.
ii. 앱(프로그램) 목록에서 [Roland DG Corporation]>[Roland DG Connect Hub]를

클릭합니다.
• Windows 10

i. [시작]을 클릭합니다.
ii. 앱(프로그램) 목록에서 [Roland DG Corporation]>[Roland DG Connect Hub]를

클릭합니다.
(2) 사용할 기기(BD-8)를 클릭하십시오.

(3) FlexiDESIGNER의 [Open]을 클릭하십시오.
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3. 아래의 절차에 따라 인쇄 영역을 설정하십시오.

(1) 아이콘(A)을 클릭합니다.

[DesignCentral] 대화상자(B)가 열립니다.

(2) 탭(C)에서 풀다운 메뉴 [▼]를 클릭한 후 [Custom]을 선택합니다.

(3) 인쇄 영역(130 mm × 90 mm [5.12 in. × 3.54 in.])을 입력합니다.

디자인 영역에 인쇄 영역 프레임(D)이 생성됩니다.

4. 인쇄할 데이터를 생성합니다.
여기서 사진을 가져오고 크기를 조정하고 다듬습니다. 그런 다음 메시지를 추가하고 사진과 텍스
트를 대칭시킨 다음 인쇄된 개체의 색상이 비치는 것을 방지하기 위해 화이트 레이어를 만듭니다.

(1) 사진 데이터를 컴퓨터에 저장합니다.

(2) [File]>[Import...]를 클릭하고 저장된 사진 데이터를 선택한 후 [Import...]를 클릭하십시오.

사진 데이터 크기의 파란색 점선 프레임이 창에 표시됩니다.
(3) 원하는 위치를 클릭한 후 사진 데이터를 디자인 영역에 붙여넣습니다.

사진 데이터의 크기가 큰 경우에는          [Zoom Out] 또는 "Ctrl + 스크롤" 등의 방법을 사용하여 전체 

사진 데이터를 볼 수 있습니다.

MEMO

(4) 사진 데이터를 선택한 후 크기를 조정하십시오.

i. 로드된 사진 데이터를 선택합니다.
ii. [DesignCentral] 대화 상자에서 [Proportional] 확인란을 선택하십시오.
iii. 인쇄 영역에 가까운 크기를 입력한 다음 Enter를 누르십시오.

잘라낼 이미지의 크기에 따라 크기를 조정합니다. 여기에서는 인쇄 영역 (130 mm ×
90 mm [5.12 in., 3.54 in.])의 너비를 150 mm (5.90 in.)로 설정합니다.
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(5) 트리밍을 수행합니다.

i. [Rectangle Tool]을 누른 상태에서        [Oval Tool]을 선택합니다. 

ii. 이 프레임은 트리밍을 위한 외부 프레임으로 사용되므로        을 클릭한 후 다음과 같이 

설정하십시오.

• 탭:[No fill]

• 탭: 라인 유형: 실선; 라인 색상:빨간색

ii. [Select Tool]을 선택한 후 프레임을 이동하여 잘라낼 위치를 결정합니다.

iii. 선택 도구로 이미지와 프레임을 선택한 상태에서 [Arrange]>[Mask]>[Mask]를 클릭하십
시오.
이미지가 빨간색 라인으로 잘립니다.

iv. [Select Tool]을 사용하여 사진을 인쇄 영역의 프레임으로 이동하여 크기에 문제가 없는지
확인하십시오.
[DesignCentral] 대화상자나 선택한 사진 주변의 인터페이스 항목을 이용하여 확대/축소
합니다.

(6) 메시지를 입력합니다.

i. [Text Tool]을 선택합니다.

ii. 문자를 입력하려는 위치와 가까운 위치를 클릭한 후 문자를 입력하십시오.

iii. [Select Tool]을 클릭하고 텍스트 항목을 선택합니다.

iv. [DesignCentral] 대화상자에서        탭을 클릭한 후 글꼴과 크기를 조정하십시오.

v. [Select Tool]을 사용하여 메시지를 선택한 후 [Arrange]>[Convert to Outlines]을

 클릭합니다.
메시지 텍스트는 모양의 상태(모양이 변하지 않음)로 변환되어 미러링이 가능합니다.

vi. [Fill/Stroke Editor] 대화 상자의 색상과 선을 변경합니다.
(7) 사진과 메시지를 미러링합니다.

i. [Select Tool]에서 사진과 메시지를 선택하십시오.

ii. [Arrange]>[MIrror...]를 클릭한 후 Enter 키를 누릅니다.
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사진이 오른쪽을 중심으로 반전됩니다.
(8) 이미지와 메시지를 선택한 상태에서 [Arrange]>[Align]>[Vertical Center to Page]를 클릭합니다.

선택한 사진과 메시지가 인쇄 영역의 세로 중앙에 배치됩니다.

5. [File]>[Save]를 클릭하여 데이터를 저장합니다.
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Step 2: 개체 배치 및 설정

개체를 배치한 다음 인쇄할 준비를 합니다.

전면 커버를 연 상태로 눈으로 확인하면서 플랫 테이블 높이, 인쇄 원점 등을 설정할 수 있습니다.
그러나 이러한 설정에서 [OK]를 클릭하면 플랫 테이블이 움직이기 시작할 수 있습니다. 따라서 전면 커버를 열었을 때 
움직이는 부품에 손이 닿지 않도록 주의하여 작업하십시오.

IMPORTANT

절차

1. 유틸리티를 시작합니다.

P. 35 유틸리티 시작

2. 개체를 배치합니다.

(1) 필요한 경우 다음 작업을 수행하십시오.

• 정전기 제거 브러시나 정전기 방지 천을 사용하여 물체의 정전기를 제거하십시오.
• 무수 에탄올이나 이소프로필 알코올을 사용하여 물체의 인쇄 부분의 그리스를 제거하십시오.
• 마스킹 테이프로 인쇄 영역 이외의 영역을 보호하십시오.

(2) 전면 커버를 엽니다.

(3) 플랫 테이블에 이물질이나 기타 이물질이 붙어 있지 않은지 확인하십시오.

(4) 플랫 테이블 위에 접착 시트를 놓습니다.

(5) 개체를 배치합니다.

• 인쇄 데이터는 180도 회전된 데이터로 인쇄됩니다.
• 흰색 테두리 안에 개체를 흰색 테두리와 평행하게 배치합니다.

(6) 전면 커버를 닫습니다.

3. 개체를 설정합니다.

유틸리티에서는 객체를 등록/관리하는 창에서 "media"라는 명칭을 사용합니다.

MEMO

(1) 유틸리티 홈 화면에서             [Setup]을 클릭합니다.

(2)      를 클릭합니다.

(3) 개체 이름을 입력한 후 [OK]를 클릭합니다.
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이전에 등록된 미디어 이름은 사용할 수 없습니다. 새 미디어 이름을 입력합니다.

(4) [Object Type] 창에서 [Transparent]를 선택한 후 [OK]를 클릭합니다.

(5) [Flat Table Height] 옆의 [Change]를 클릭하여 개체의 높이를 설정하십시오.

i. 창 오른쪽에 있는           또는           를 클릭하여 물체의 가장 높은 지점을 헤드 갭 센서의

전후 위치에 맞춥니다.

한 번의 클릭으로 이동 거리를 0.1 mm (0.004 in.), 1 mm (0.04 in.), 10 mm (0.39 in.) 또는 50 mm 
(1.97 in.) 중에서 선택할 수 있습니다.

MEMO

ii. 물체의 가장 높은 지점이 헤드 갭 센서에 접근하도록 하려면 창 왼쪽의          을 클릭합니다.

헤드 갭 센서와 접촉하지 않고 헤드 갭 센서에서 몇 mm 떨어진 위치(a)까지 개체의 가장 
높은 인쇄 위치를 이동합니다.

a

iii. [Automatic Setup]를 클릭합니다.
플랫 테이블이 움직이고 헤드 갭 센서가 물체의 높이를 감지합니다.

iv. [OK]를 클릭합니다.
(6) [Print Origin] 및 [Printing Area]에 대해 [Change]를 클릭하고 [Print Origin]을 클릭합니다.

[Printing Area] 설정이 완료되면 프린트 헤드가 마르는 것을 방지하기 위해 프린트 헤드 캐리지를 같은 
위치에 약 3분 동안 방치한 후 원래 위치로 돌아갑니다. 절차를 다시 수행하십시오.

MEMO

i. [Position Specification]에서 [Pointer]를 선택합니다.
프린트 헤드 캐리지가 이동한 다음 프린트 헤드 캐리지의 오른쪽에 있는 포인터가 최대 인쇄
영역의 오른쪽 하단(S: 0 mm [0 in.], F: 0 mm [0 in.])을 비춥니다.

ii. ,          ,           또는          를 클릭하고 포인터를 이동하여 인쇄 원점(인쇄 영역의

 오른쪽 하단)을 지정합니다.
프린트 헤드 캐리지는 왼쪽-오른쪽 방향으로 이동하고 플랫 테이블은 앞뒤 방향으로 이동
합니다. 포인터가 비춰지는 위치가 [Print Origin] 역할을 합니다.

아크릴 스탠드에 인쇄하기

인쇄 예시 115



iii. [OK]를 클릭합니다.
[Flat Table Height], [Print Origin], [Printing Area] 설정 창으로 돌아갑니다.

[Printing Area]에 대하여
여기에서 [Origin Relative]가 지정되었으므로 인쇄 영역의 왼쪽 상단이 자동으로 최대 위치(S: 210 mm 
[8.26 in.], F: 148 mm [5.82 in.])로 설정됩니다.

MEMO

4. [OK]를 클릭합니다.

[Setup in progress.]가 표시됩니다. 설정이 완료되면 홈 화면으로 돌아가며, 등록된 개체 이름과 
설정된 [Flat Table Height], [Print Origin], [Printing Area]이 표시됩니다.

아크릴 스탠드에 인쇄하기

116 인쇄 예시



Step 3: 인쇄 수행

컴퓨터 디스플레이 설정에 따라 [Send to Device] 또는 [Print parameters] 창이 모니터에 맞지 않을 수 있습니다. 
이 경우 디스플레이 설정에서 배율과 레이아웃을 조정하십시오.

MEMO

절차

1. FlexiDESIGNER에서 생성된 인쇄 데이터를 엽니다.

[File]>[Open]을 클릭하면 저장된 인쇄 데이터가 열립니다.

2.          를 클릭합니다.

[Send to Device] 대화 상자가 열립니다.

3. 다음 사항을 확인하십시오.

• [Device]: BD-8
• [Number of prints]: 1
• [Output]:[Page]

4. [Print parameters]를 클릭합니다.

5. [Quality] 탭에서 다음을 선택합니다.

• [Media Type]:[General]
• [Print Quality]:[High Quality]
• [Mode]: [CMYK->White]
• [Special Color Plate Generation]

• [White Plate Generation]: 확인란을 선택합니다.
• [Generated Pattern]:[Print Area]
• [Size Correction]:[No]

6. [OK]를 클릭합니다.

인쇄 파라메터 창이 닫힙니다.

7. [Send]를 클릭합니다.

인쇄가 시작됩니다.

8. 인쇄가 완료되면 개체를 제거하고 유틸리티 설정을 종료합니다.

관련된 링크
・ P. 87 인쇄 파라메터(FlexiDESIGNER)
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프린트 헤드 캐리지 이동 최소화

이렇게 하면 프린트 헤드 캐리지 이동을 인쇄 데이터 너비로 좁혀 인쇄 시간이 단축됩니다. 이 기능은 인쇄 
영역이나 인쇄 데이터의 너비가 작은 경우에 효과적입니다.
기본 설정은 [Output Data Width]이므로 이 설정을 변경하지 않으면 아무런 효과가 없습니다.

절차

1. 개체를 Setup합니다.

P. 72 개체 설정

2. 유틸리티 홈 화면에서        을 클릭합니다.

3. [List of Media Settings]>[Printing Movement Range] 풀다운 메뉴를 클릭합니다.

4. [Output Data Width]를 선택합니다.
[Printing Movement Range]에는 다음 세 가지 설정을 사용할 수 있습니다. 이 설정은 인쇄 시
간과 인쇄 품질에 영향을 미치므로 상황에 맞게 설정해야 합니다.

설정 기능

[Output Data Width] 프린트 헤드 캐리지 이동 범위를 인쇄 데이터와 일치시킵니다. 이동은 필요한 최소한의 양으
로 제한되며, 이는 가장 빠른 인쇄를 기대할 수 있습니다. 이 기능을 사용하면 잉크가 굳는 
데 필요한 시간이 일정하지 않아 색상이 고르지 않을 수 있습니다.

[Media Width] 프린트 헤드 캐리지 이동 범위를 설정된 인쇄 영역에 일치시킵니다.

[Full Width] 프린트 헤드 캐리지는 기기의 한쪽 끝에서 다른 쪽 끝으로 이동합니다. 이 설정을 사용하면 
프린트 헤드 캐리지 이동 속도가 항상 일정해지며 가장 안정적인 인쇄 결과를 얻을 수 있습
니다.

5. [Apply]를 클릭하여 입력을 확인하십시오.

6. [Close]를 클릭하면 원래 화면으로 돌아갑니다.

• 기본 설정: [Output Data Width]

MEMO
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다음과 같은 경우에는 플랫 테이블 높이와 관련된 설정을 구성해야 합니다.

• 레이어 인쇄(즉, 인쇄 표면이 점차 높아짐)를 하는 경우.
• 인쇄 도중 출력물의 들어올림이나 뒤틀림으로 인해 출력물의 높이가 변하는 경우.
• 등록된 미디어의 높이를 변경하지 않고 개별 개체의 차이로 인해 높이가 달라지는 개체를 대량 생산

하는 경우.
플랫 테이블에는 두 가지 높이 설정이 있습니다.

• [Readjust]
플랫 테이블의 높이는 인쇄 중에 프린트 헤드가 물체에 닿으면 조정됩니다.

P. 123 인쇄 중 높이 재조정
• [Flat Table Lowering Amount]

사전에 플랫 테이블을 지정된 값 이하로 낮추어 인쇄합니다.
P. 126 개체와 프린트 헤드 사이의 거리를 더 멀게 설정
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인쇄 중 높이 재조정

이 설정을 사용하면 다음과 같은 경우 물체가 헤드 갭 센서에 접촉하더라도 인쇄를 계속하도록 높이를 재조
정할 수 있습니다.

• 인쇄 중에 물체가 뜨거나 휘어지는 경우
• 레이어링 인쇄를 하여 인쇄면이 올라간 경우

이 기능은 재인쇄할 수 없는 개체를 사용할 때 효과적입니다. 그러나 이 설
정에는 다음과 같은 단점이 있습니다.

• 재조정에 소요되는 시간으로 인해 인쇄 시간이 길어집니다.
• 인쇄면이 헤드 갭 센서에 닿습니다.

따라서 시간이 오래 걸리더라도 이미지 품질을 보장하려는 인쇄 또는 다시 실행할 수 없는 인쇄에는 
[Readjust]을 사용해야 합니다.

• 높이가 자동으로 재조정되고 인쇄가 계속되면 높이 설정이 변경됩니다. 따라서 인쇄 품질이 변경될 수 있습니다. 따라서
적절한 인쇄를 위해서는 인쇄하기 전에 인쇄할 개체를 적절하게 고정하여 위치가 벗어나거나 들리는 것을 방지해야 합니
다.

• [Readjust]를 선택하면 헤드 갭 센서가 개체에 닿을 때 높이가 자동으로 조정됩니다.
• [Readjust]를 선택하더라도 다음과 같은 경우에는 인쇄 및 설정이 취소됩니다.

• 높이가 자동 조정의 [Maximum Value (Threshold)]에 도달한 경우
• 플랫 테이블이 아래쪽으로 이동한 경우에도 자동 재조정 중에 인쇄할 개체가 헤드 갭 센서에 닿는 경우

• 이 기능을 사용하지 않는 경우 ([Operation on Height Error Detection]:[Stop]), 인쇄 중에 높이 오류가 감지되면 인쇄
가 중지되고 [Flat Table Height Error]가 표시됩니다.

MEMO

절차

1. 유틸리티 홈 화면에서        를 클릭합니다.

2. [Preferences]를 클릭합니다.

3. [Clearance Settings]에서 [Operation on Height Error Detection]에 대해 [Readjust]를 선택합니다.

4. [Maximum Value (Threshold)] 옆의 [▲][▼]를 클릭하면 높이 오류 감지 시 플랫 테이블이 하강하는 최대량을 
설정할 수 있습니다.
개체가 더 이상 헤드 갭센서에 닿지 않을 때까지 높이 조정이 점진적으로 이루어집니다. 개체의 높이 
변화 등 높이 변화를 예상하여 설정합니다.

인쇄 표면과 프린트 헤드 사이의 거리가 멀수록 인쇄 품질이 떨어지는 경향이 있습니다. 더 좁게 조정하는 것이 
좋습니다. [Maximum Value (Threshold)]을 결정할 때 다음 사항에 유의하십시오.

• 만족스러운 이미지 품질을 얻으려면 인쇄 이미지 품질에 미치는 영향을 고려하십시오.
• 인쇄면 전체의 높이 변화(인쇄 대상 영역이 아니라 인쇄되지 않는 부분 포함)

MEMO

5. [Apply]를 클릭하여 입력을 확인하십시오.

6. [Close]를 클릭하면 원래 화면으로 돌아갑니다.
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• 기본 설정

• [Operation on Height Error Detection]:[Stop]
• [Readjust] 선택 시 [Maximum Value (Threshold)]: 10 mm(0.39 in.)

MEMO
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미디어 설정 값에 재조정된 플랫 테이블 높이 반영

이 섹션에서는 미디어 설정에서 [Readjust]가 수행된 플랫 테이블 높이를 반영하는 방법에 대해 설명합니
다. 등록된 미디어의 플랫 테이블 높이를 덮어쓸 수 있습니다.

동일한 개체에 인쇄할 경우 등록된 미디어 설정 값이 사용됩니다. 물체의 높이가 변하거나 레이어링 인쇄로 
인해 물체의 높이가 변하는 경우 이 설정을 켜면 [Readjust] 시간을 줄일 수 있습니다.

인쇄 시간은 단축되지만, 프린트 헤드와 물체 사이의 거리가 멀어지기 때문에 인쇄 품질이 떨어지는 경향이 
있습니다. 인쇄하는 데 시간이 더 걸리는지 여부에 관계없이 인쇄 품질이 중요한 경우에는 이 설정을 꺼야 
합니다.

절차

1. 유틸리티 홈 화면에서        를 클릭합니다.

2. [Preferences]를 클릭합니다.

3. [Clearance Settings] - [Operation on Height Error Detection]에서 [Maintain Height after 
Readjustment] 확인란을 선택합니다.

4. [Apply]를 클릭하여 입력을 확인하십시오.

5. [Close]를 클릭하면 원래 화면으로 돌아갑니다.

• 기본 설정

• [Maintain Height after Readjustment]: Cleared

MEMO
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개체와 프린트 헤드 사이의 거리를 더 멀게 설정

개체가 Setup되면 프린트 헤드와 개체 사이의 거리가 1.0 mm (0.04 in.)로 설정됩니다. 그러나 다음과 
같은 경우 개체와 프린트 헤드가 서로 접촉할 수 있습니다.
• 출력 중 물체가 들뜨거나 뒤틀려 물체의 높이가 변하는 경우
• 등록된 미디어의 높이를 변경하지 않고, 개체별 차이로 인해 높이가 달라지는 개체를 대량으로 생산하는 

경우

헤드 갭 센서가 물체에 닿으면 [Flat Table Height Error]가 나타납니다. 따라서 [Flat Table Lowering 
Amount]를 사용하여 인쇄 대상과 프린트 헤드 사이의 거리를 미리 늘릴 수 있으며, 이는 표준 1.0 mm 
(0.04 in.)보다 멀 수 있습니다.

플랫 테이블은 미리 [Flat Table Lowering Amount]만큼 낮아지므로 물체와 프린트 헤드 사이의 거리가 길
어집니다. 이로 인해 인쇄 품질이 낮아지는 경향이 있지만 인쇄 시간은 동일하게 유지됩니다. 그러나 [Flat 
Table Lowering Amount]의 최대값은 2.0mm이므로 물체의 높이가 2.0mm 이상 변하는 경우에는 필요에 
따라 높이 설정을 조정하거나 [Readjust] 작업을 시작합니다.

[Flat Table Lowering Amount]은 인쇄 시간이 우선인 경우에 사용해야 합니다.

• 이 설정은 인쇄할 개체의 높이가 자동으로 설정될 때 활성화됩니다.
• 거리가 너무 멀면 인쇄 품질이 저하되고 프린트 헤드의 노즐이 막힐 수 있습니다.
• 개체의 가장 높은 인쇄 위치와 인쇄 표면의 가장 낮은 인쇄 위치 간의 차이가 2 mm (0.08 in.) 이내가 되도록 인쇄 영역

을 설정합니다([Generic Distance] 제외).

IMPORTANT

절차

1. 플랫 테이블 위에 높이가 일정하지 않은 개체를 올려 놓습니다.

2. 유틸리티 홈 화면에서             [Setup]을 클릭합니다.

3. 개체를 등록합니다.

이미 등록된 개체의 높이를 변경하려면 (4)단계부터 진행하십시오.

(1)  를 클릭합니다.

(2) 개체 이름을 입력한 후 [OK]를 클릭합니다.

(3) [Object Type] 창에서 [Transparent] 또는 [Opaque]를 선택한 후 [OK]를 클릭하십시오.

(4) [Flat Table Height] 옆의 [Change]를 클릭하여 개체의 높이를 설정하십시오.

(5) [Flat Table Lowering Amount] 옆의 [▲] 버튼을 클릭한 후 플랫 테이블이 하강되는 양을 설정합니다.

[Flat Table Lowering 
Amount]*1

프린트 헤드와 개체 사이의 거리*2

0.0 mm (0.0 in.) 1.0 mm (39.4 mil)

0.1 mm (3.94 mil) 1.1 mm (0.04 in.)

: :

1.9 mm (0.07 in.) 2.9 mm (0.11 in.)

2.0 mm (0.08 in.) 3.0 mm (0.12 in.)

*1 0.1 mm (3.94 mil) 단위로 설정할 수 있습니다.
*2 가장 높은 위치
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(6) [OK]를 클릭합니다.

4. 인쇄 원점을 설정합니다.

5. [OK]를 클릭합니다.
[Setup in progress.]가 표시된 후 지정된 [Flat Table Lowering Amount]으로 설정이 수행됩니다.

• 기본 설정: 0.0 mm (0.0 in.)

MEMO
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플랫 테이블의 수직 방향 기준 위치 설정

플랫 테이블 높이 방향의 베이스 위치(0 mm [0 in.])를 '최저 위치: 높이(H)'로 설정할지, '최고 위치: 두께
(T)'로 설정할지 선택합니다.

절차

1. 유틸리티 홈 화면에서        를 클릭합니다.

2. [Preferences]를 클릭합니다.

3. [Flat Table Height/Object (Media) Thickness]에서 다음 중 하나를 선택합니다.

[Height] (H)

0

A
베이스 위치(0 mm [0 in.])를 플랫 테이블의 가장 낮은 위치
로 설정합니다. 개체를 했을 때 플랫 테이블이 얼마나 상승
하는지를 나타냅니다. (플랫 테이블 높이: H)

[Thickness] (T)

0
A

플랫 테이블의 가장 높은 위치를 0mm로 설정합니다. 체를 
설치할 때 플랫 테이블이 얼마나 낮아지는지를 나타냅니다
(개체 두께: T).

A: 프린트 헤드

4. [Apply]를 클릭하여 입력을 확인하십시오.

5. [Close]를 클릭하면 원래 화면으로 돌아갑니다.

• 기본 설정: [Height (Lowered Flat Table Treated as Height of 0)]

MEMO
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화이트 잉크의 성분은 침전되는 경향이 있습니다. 화이트 잉크 카트리지는 정기적으로 흔들어 잉크를 혼합
할 수 있지만, [Ink Circulation]을 수행하면 프린터 내부의 잉크 경로를 혼합할 수 있습니다. 화이트 잉크 
색상이 고르지 않은 경우 [Ink Circulation] 빈도를 설정하여 화이트 잉크 농도를 보장합니다.

잉크 순환[Ink Circulation] 주기 설정하기

[Ink Circulation] 간격을 30분에서 360분까지 30분 단위로 설정할 수 있습니다. 그러나 간격을 너무 짧게 
설정하면 잉크가 순환하는 동안 더 자주 기다려야 합니다.

절차

1. 유틸리티 홈 화면에서        를 클릭합니다.

2. [Preferences]를 클릭합니다.

3. [Ink Circulation Interval]에서 [Ink Circulation] 수행 간격을 설정합니다.
[Ink Circulation] 작업은 몇 분 정도 걸립니다. 상황에 맞게 간격을 설정하십시오.

4. [Apply]를 클릭하여 입력을 확인하십시오.

5. [Close]를 클릭하면 원래 화면으로 돌아갑니다.

• 기본 설정: 360 minutes

MEMO

화이트 잉크 농도 유지보수 설정
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옵션 품목 제거/장착(OA-RA-8)

OA-RA-8 제거/설치에 대한 자세한 내용은 OA-RA-8 사용자 설명서를 참조하십시
오. https://downloadcenter.rolanddg.com/BD-8

이 절차에 대한 참조 비디오를 보려면 다음 링크를 사용하십시오. 전반적인 작업 흐름을 이해하려면 이 비디오를 시청하는
것이 좋습니다.
https://youtu.be/g5oVgQ9NXdI

MEMO
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냄세제거제 모드 설정

절차

3. [Deodorizer Settings]에서 다음을 설정합니다.

1. 유틸리티 홈 화면에서        를 클릭합니다.

2. [Preferences]를 클릭합니다.

• 모드

모드 탈취 성능 흡입력 기본 설정

[Strong]

메인 전원이 켜져 있거나 서브 전원이 켜져 있거나 인쇄 중일 때 
활성화됩니다. 이 설정은 기기 외부로 냄새가 가장 적게 방출됩
니다. 이 모드는 기기를 사용하지 않을 때에도 기기의 개구부에
서 나오는 냄새를 줄여줍니다. 이 모드에서는 냄세제거제의 정
지 시간을 설정할 수 있습니다.

• [When Printing]: 50%
• [When Sub Power On]: 

40%
• [When Main Power On]: 

20%

[Medium]
서브 전원이 켜져 있거나 인쇄 중일 때 활성화됩니다. 개체를 
장착하는 등의 작업 중 전면 커버를 열 때 냄새를 줄여주는 모
드입니다.

• [When Printing]: 50%
• [When Sub Power On]: 

40%

[Weak]*1
인쇄 중에만 활성화됩니다. 이 모드는 일반적으로 사람이 없고 
환기가 잘 되는 전용 및 기타 공간의 사용자를 위한 것입니다.

• [When Printing]: 
50%

[Off] 냄세제거제가 활성화되지 않았습니다. －

*1 기본 설정

• 흡입력 

상태별 흡입력을 설정할 수 있습니다. 20%에서 100% 사이에서 10% 단위로 설정할 수 있습니
다.

4. [Apply]를 클릭하여 입력을 확인하십시오.

5. [Close]를 클릭하면 원래 화면으로 돌아갑니다.

관련된 링크

・ P. 26 냄새제거제
・ P. 133 냄세제거제 일시 정지 시간 설정(Strong 모드만 해당)
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냄세제거제 일시 정지 시간 설정(Strong 모드만 해당)

필터의 조기 막힘 방지, 대기전력 절약, 심야 운전 시 소음 감소 등을 위해 냄세제거제 작동을 일시 정지하는 
시간을 지정할 수 있습니다.
냄세제거제가 일시정지되는 조건은 다음과 같습니다.
• [Strong] 모드
• 메인 전원이 켜져 있거나 절전 모드인 경우

절차

1. 유틸리티 홈 화면에서        를 클릭합니다.

2. [Preferences]를 클릭합니다.

3. [Deodorizer Settings]에서 [Suspension Time Settings] 확인란을 선택하십시오.

4. [Suspension Period] 및 [Resume At]을 지정합니다.

5. [Apply]를 클릭하여 입력을 확인하십시오.

6. [Close]를 클릭하면 원래 화면으로 돌아갑니다.

• 기본 설정: Cleared

MEMO
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슬립 모드 활성화 간격 설정(절전 기능)

서브 전원이 켜져 있고 인쇄 데이터가 수신되지 않았거나 유틸리티에서 오랫동안 작업이 수행되지 않은 경
우 슬립 모드(절전 기능이 작동하는 상태)가 활성화될 때까지의 시간을 설정합니다. [Sleep Time]은 15분에
서 120분까지 15분 단위로 설정할 수 있습니다.

절차

1. 유틸리티 홈 화면에서        를 클릭합니다.

2. [Preferences]를 클릭합니다.

3. [Sleep Time]을 설정하십시오.

4. [Apply]를 클릭하여 입력을 확인하십시오.

5. [Close]를 클릭하면 원래 화면으로 돌아갑니다.

• 기본 설정: 30 분

MEMO
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날짜 및 시간 조정

기기는 날짜와 시간을 내부적으로 기억한 후 노즐 검사를 통해 인쇄합니다. 시간이 지남에 따라 날짜와 시간
이 부정확해지거나 시차가 있는 장소로 이사하는 경우에는 날짜와 시간을 조정하십시오.

절차

1. 유틸리티 홈 화면에서        를 클릭합니다.

2. [Preferences]를 클릭합니다.

3. [Date and Time]을 사용하여 날짜와 시간을 설정합니다.

• 컴퓨터의 날짜와 시간을 일치시키는 경우
[Use Date and Time Obtained from Computer] 확인란을 선택합니다.

• 날짜와 시간을 설정하는 경우
연도, 월, 일, 시, 분, 초를 수동으로 입력하십시오.

4. [Apply]를 클릭하여 입력을 확인하십시오.

5. [Close]를 클릭하면 원래 화면으로 돌아갑니다.
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언어 설정

절차

1. 유틸리티 홈 화면에서        를 클릭합니다.

2. [System Information]을 클릭합니다.

3. [Language]에서 사용할 언어를 설정합니다.

4. [Apply]를 클릭하여 입력을 확인하십시오.

5. [Close]를 클릭하면 원래 화면으로 돌아갑니다.

유틸리티를 종료합니다. 다시 시작하면 언어 변경이 적용됩니다.
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수동 헤드 클리닝 도구의 베이스 위치 설정

수동 헤드 클리닝 도구가 손상되거나 변형되어 교체되는 경우 베이스 위치를 설정하십시오.

전면 커버를 연 상태에서 포인터를 사용하여 주의 깊게 관찰하면서 베이스 위치를 조정할 수 있습니다.
그러나 이러한 설정이 구성된 상태에서 [OK]를 클릭하면 프린트 헤드 캐리지나 플랫 테이블이 움직이기 시작할 수 있습
니다. 따라서 전면 커버를 열었을 때 움직이는 부품에 손이 닿지 않도록 주의하여 작업하십시오.

IMPORTANT

절차

1. 개체를 제거한 후 Setup을 취소하십시오.

2. 유틸리티 홈 화면에서        를 클릭합니다.

3. [Preferences]를 클릭합니다.

4. [Adjust Manual Cleaning Tool Position]에서 [Execute]을 클릭합니다.

개체 Setup 상태에서는 [Execute]를 사용할 수 없습니다.

5. 수동 헤드 클리닝 도구의 위치를 조정하려면 유틸리티 창의 지침을 따르십시오.

(1) [This starts manual cleaning tool position adjustment.] 창이 나타나면 [OK]를 클릭하십시오.

(2) 전면 커버를 엽니다.

(3) 새로운 수동 헤드 클리닝 도구를 장착하십시오.

(4) 전면 커버를 닫습니다.

(5) [OK]를 클릭합니다.
프린트 헤드 캐리지와 플랫 테이블이 이동한 다음 수동 헤드 클리닝 도구의 베이스 위치 근처에 
포인터가 켜집니다.

(6) 포인터를 수동 헤드 클리닝 도구 참조 위치에 맞추려면            ,           ,            또는            를 클릭

      하십시오.

Good

No
Good

(7) [OK]를 클릭합니다.

프린트 헤드 캐리지와 플랫 테이블이 원래 위치로 돌아갑니다.
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(8) [Remove the manual cleaning tool.] 메시지가 나타나면 전면 커버를 열고 수동 헤드 클리닝 도구를 
제거하십시오.

(9) [OK]를 클릭합니다.

(10) 전면 커버를 닫습니다.

6. [Close]를 클릭하면 원래 화면으로 돌아갑니다.
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포인터 위치 조정

포인터에 의해 설정된 인쇄 영역과 실제 인쇄가 어긋나는 경우 포인터의 인쇄 위치를 조정하십시오.

전면 커버를 연 상태에서 포인터를 사용하여 주의 깊게 관찰하면서 베이스 위치를 조정할 수 있습니다.
그러나 이러한 설정이 구성된 상태에서 [OK]를 클릭하면 프린트 헤드 캐리지나 플랫 테이블이 움직이기 시작할 수 있습
니다. 따라서 전면 커버를 열었을 때 움직이는 부품에 손이 닿지 않도록 주의하여 작업하십시오.

IMPORTANT

절차

1. 노즐 검사 시험지를 Setup합니다.

P. 31 노즐 드롭아웃 테스트 시험지 등록 및 설정

2. 유틸리티 홈 화면에서       를 클릭합니다.

3. [Preferences]를 클릭합니다.

4. [Position Adjustment]>[Adjust Pointer Position]에서 [Execute]를 클릭하십시오.

5. [This prints the position adjustment pattern.] 창이 나타나면 [OK]를 클릭하십시오.

위치 조정을 위한 패턴을 인쇄한 후 포인터가 인쇄된 패턴 근처를 비춥니다.

6. 포인터의 위치를 조정합니다.

(1) 내부 사각형 내부로 포인터를 이동하려면            ,           ,            및           을 클릭하십시오.
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(2) [OK]를 클릭합니다.

수정된 포인터 위치가 적용되고 서브 전원이 꺼집니다.
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인쇄 전 개체의 높이 확인

개체 Setup을 마치면 헤드 갭 센서(A)와 개체(B) 사이의 간격이 0.5 mm (0.02 in.)*1로 설정됩니다.

이 기기는 물체가 앞에서 뒤로(위 그림의 오른쪽에서 왼쪽으로) 이동하면서 인쇄합니다.

개체에 따라 미디어의 뒤틀림으로 인해 개체를 고정한 테이프가 떨어지는 등의 요인으로 인해 설치 후 높이
가 변경될 수 있습니다. 이러한 경우 개체가 헤드 갭 센서에 접촉하여 손상될 수 있습니다.

개체를 고정하기 어려운 경우, 경험이 없는 작업자가 기기를 사용하는 경우 등 이와 유사한 상황에서는 
[Operation before Printing] 설정을 구성하여 인쇄하기 전에 개체의 높이를 확인하는 것이 좋습니다. 그러
나 이 설정을 활성화하면 인쇄가 시작되기까지의 시간이 늘어납니다. 사용자 경험 수준과 개체의 상태에 따
라 이 설정을 적절하게 구성합니다.

절차

1. 유틸리티 홈 화면에서         를 클릭합니다.

2. [Preferences]를 클릭합니다.

3. [Check Media Height before Starting Printing] 확인란을 선택합니다.

4. [Apply]를 클릭하여 입력을 확인하십시오.

5. [Close]를 클릭하면 원래 화면으로 돌아갑니다.

• 기본 설정: Cleared

MEMO

*1 [Flat Table Lowering Amount] 설정이 없는 경우
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측정 단위 변경

유틸리티에 표시되는 단위를 설정합니다. 

절차

1. 유틸리티 홈 화면에서        를 클릭합니다.

2. [System Information]을 클릭합니다.

3. [Units]에서 [Length]와 [Temperature]를 설정합니다.

4. [Apply]를 클릭하여 입력을 확인하십시오.

5. [Close]를 클릭하면 원래 화면으로 돌아갑니다.

디스플레이 단위 설정에 대한 변경 사항은 유틸리티를 다시 시작하면 적용됩니다.

• 기본 설정

• [Length]: mm
• [Temperature]: ℃

MEMO

관련된 링크
・ P. 35 유틸리티 시작/종료
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프린터 정보 보기

이는 일련 번호, 잉크 종류 등 이 기기의 정보를 보는 방법입니다.

Roland DG Connect로 [Nickname]을 설정할 수 있습니다.

MEMO

절차

1. 유틸리티 홈 화면에서        를 클릭합니다.

2. [System Information]를 클릭하고 [Machine Information]를 확인하십시오.

다음 정보를 확인하실 수 있습니다.:

• [Model]: 모델명
• [Nickname]: 기기의 별칭
• [Serial Number]: 기기의 일련 번호
• [Ink Type]: 잉크 유형
• [Firmware Version]
• [MAC Address]

3. [Close]를 클릭하면 원래 화면으로 돌아갑니다.
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네트워크 정보 보기

IP 주소, 기본 게이트웨이 등의 네트워크 정보를 보려면 다음 절차를 따르십시오. 

절차

1. 유틸리티 홈 화면에서         를 클릭합니다.

2. [System Information]을 클릭하고 [Network]를 확인하십시오.

다음 정보를 확인하실 수 있습니다.:

• [Obtain IP Address Automatically]: DHCP를 통한 IP 주소 자동 획득을 활성화/비활성화
합니다.

• [IP Address]
• [Subnet Mask]
• [Default Gateway]

3. [Close]를 클릭하면 원래 화면으로 돌아갑니다.

• 네트워크 설정 방법에 대한 자세한 내용은 Changing the Network Settings을 참조하십시오.

MEMO
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유틸리티 버전 확인

최신 버전의 유틸리티는 Roland DG Connect를 통해 지속적으로 사용됩니다. 네트워크 문제 등 필요한 
경우 유틸리티 버전을 확인하십시오.

절차

1. 유틸리티 홈 화면에서         를 클릭합니다.

2. [System Information]을 클릭하고 [Version]을 확인하십시오.

여기에서 유틸리티 버전을 확인할 수 있습니다.
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네트워크 설정 변경

이 섹션에서는 고정 IP 주소로 기기를 사용할 때 설정을 구성하는 방법에 대해 설명합니다.

Step 1: 네트워크 주소 결정

여기에 나열된 설정은 단지 예일 뿐입니다. 본 설명서에 제시된 절차와 설정은 모든 환경에 적용되는 것은 
아닙니다. 사용 중인 컴퓨터가 여러 네트워크 장치 및 인터넷에 연결되어 있는 환경에서 부적절한 설정은 전
체 네트워크에 큰 영향을 미칩니다. 설정에 대한 자세한 내용은 네트워크 관리자에게 문의하십시오.

컴퓨터와 이 기기를 네트워크에 연결하기 위한 IP 주소, 서브넷 마스크 및 기본 게이트웨이를 결정합니다.

절차

1. IP 주소를 결정합니다.

• 컴퓨터: 192.168.0.XXX
• 프린터: 192.168.0.YYY

"XXX" 및 "YYY"는 1부터 254까지의 숫자를 나타냅니다. 다른 네트워크 기기의 숫자와 다른지 
확인하십시오.

2. 서브넷 마스크를 결정합니다.

• 컴퓨터: 255.255.255.0
• 프린터: 255.255.255.0

컴퓨터와 이 기기에 동일한 번호를 사용하십시오.

3. 기본 게이트웨이를 결정합니다.

•  컴퓨터: 192.168.0.AAA
•  프린터: 192.168.0.AAA

"AAA"는 1부터 254까지의 숫자를 나타냅니다. 이 숫자를 설정할 필요가 없을 수도 있으므로 네
트워크 관리자에게 문의하십시오.
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Step 2: IP 주소 변경

절차

1. 유틸리티 홈 화면에서        를 클릭합니다.

2. [System Information]을 클릭합니다.

3. [Network]에서 [Obtain IP Address Automatically] 확인란을 선택 취소합니다.

4.  Step 1: 네트워크 주소 결정에서 결정된 시스템 네트워크 주소를 입력합니다.

5. [Apply]를 클릭합니다.

6. [Close]를 클릭하면 원래 화면으로 돌아갑니다.

7. Roland DG Connect Hub를 시작하십시오.

8. [Settings]을 클릭한 후 [Auto printer registration] 확인란을 선택 취소합니다.

9. [Settings]>[Printer settings]를 클릭합니다.

10. [+]를 클릭하고 주소 필드에 Step 1 :네트워크 주소 결정에서 결정된 IP 주소를 입력합니다.

11. [Verify]를 클릭한 후 [Apply]를 클릭하십시오.

12. [OK]를 클릭합니다.

재설치 중에 컴퓨터와 기기를 연결할 수 없는 경우(예: 고정 IP 주소를 사용하여 기기를 재배치하는 경우) 재설
정 버튼을 눌러 자동 IP 주소 획득으로 전환하십시오.

MEMO
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1. 서브 전원을 끄십시오. 
2. 종이 클립이나 이와 유사한 것을 사용하여 재설정 버튼(A)을 5초 이상 누르십시오.

재설정 버튼을 누르면 짧은 신호음이 들립니다. 이 시점부터 이 버튼을 5초 이상 누르고 있으면 짧은 신호음
이 두 번 들리고 기기가 재설정됩니다.
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Step 3: 컴퓨터 네트워크 설정

절차

1. [관리자] 또는 [관리자] 그룹의 구성원으로 Windows에 로그온합니다.

2. 네트워크 연결 화면을 표시합니다.

• Windows 11
a. [시작]>[설정]을 클릭합니다.
b. [네트워크 및 인터넷]>[전화 접속]을 클릭합니다.
c. [네트워크 및 공유 센터]를 클릭합니다.
d. [이더넷] 또는 [Wi-Fi]를 클릭합니다.

•  Windows 10
a. [시작]>[설정]>[네트워크 및 인터넷]을 클릭합니다.
b. [네트워크 및 공유 센터]를 클릭합니다.
c. [인터넷] 또는 [Wi-Fi]를 클릭합니다.

3. [속성]을 클릭합니다.

[사용자 계정 컨트롤] 창이 나타나면 [계속]을 클릭하십시오.

[이더넷 속성] 또는 [Wi-Fi 속성] 창이 나타납니다.

4. [인터넷 프로토콜 버전 4(TCP/IPv4) 속성]을 선택한 후 [속성]을 클릭합니다.

[인터넷 프로토콜] 확인란이 선택 취소된 경우 선택합니다.
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5. [다음 IP 주소 사용]을 선택하고                                            에서 결정된 컴퓨터 네트워크 주소를 입력
       합니다.

Step 1: 네트워크 주소 결정 

시스템 설정
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6. [OK]를 클릭합니다.

7. 네트워크 설정을 위해 열려 있는 모든 창을 닫습니다.
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Step 4: FlexiDESIGNER 설정 구성

절차

1. Roland DG Connect Hub를 실행 합니다.

2. 연결할 기기를 선택하고 [VersaWorks 6] 옆에 있는 [Open]을 클릭합니다.

3. FlexiDESIGNER에 연결하도록 기기를 설정합니다.
VersaWorks는 연결 가능한 프린터를 자동으로 검색하고 등록합니다. 그러나 검색 결과 프린터가
0대이거나 5대 이상인 경우 수동으로 프린터를 등록해야 합니다.

• 감지된 프린터 수가 1~4인 경우

a. 감지된 프린터를 확인하고 [OK]를 클릭하십시오.
b. [Do you want to install the virtual printer driver?(가상 프린터 드라이버를 설치하시겠습

니까?)] 메시지가 표시되면 [Yes(예)]를 클릭합니다.
이 메시지는 통신에 사용할 프린터 드라이버를 나타내는 것이 아닙니다. 응용 프로그램에서 
직접 인쇄할 때 사용할 가상 프린터 드라이버를 나타냅니다.

c. [사용자 계정 컨트롤] 창이 나타나면 [예](또는 [허용])을 클릭하십시오.
d. [프린터 추가 마법사] 창이 나타나면 [계속]을 클릭합니다.

메인 화면에 기기 정보가 표시되면 등록이 완료됩니다.
• 프린터가 감지되지 않거나 5대 이상의 프린터가 감지되는 경우

a. 프린터의 IP 주소를 입력하고 [OK]를 클릭하십시오.
[Model Name], [Firmware Version] 등의 항목이 표시됩니다.

프린터가 표시되지 않으면 LAN 케이블 연결 상태를 확인하십시오.

MEMO

b. [별칭]을 설정하십시오.
별칭을 설정하지 않은 경우 모델명이 표시됩니다.

c. [확인]을 클릭합니다.
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d. [가상 프린터 드라이버를 설치하시겠습니까?] 메시지가 표시되면 [예]를 클릭합니다.
이 메시지는 통신에 사용할 프린터 드라이버를 나타내는 것이 아닙니다. 응용 프로그램에서
직접 인쇄할 때 사용할 가상 프린터 드라이버를 나타냅니다.

e. [사용자 계정 컨트롤] 창이 나타나면 [예](또는 [허용])을 클릭하십시오.
f. [프린터 추가 마법사] 창이 나타나면 [계속]을 클릭합니다.

연결된 프린터의 정보가 [프린터 목록]에 나타납니다.
g. [확인]을 클릭합니다.

메인 화면에 기기 정보가 표시되면 등록이 완료됩니다.
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본 기계는 정밀기기입니다. 본 기기의 성능을 최대한 발휘하려면 다음 중요 사항을 반드시 준수하십시오. 이
를 준수하지 않으면 성능이 저하될 뿐만 아니라 오작동이나 고장이 발생할 수 있습니다.

프린터 본체

• 본 기기는 정밀기기입니다.
• 기기에 충격을 가하거나 과도한 힘을 가하지 마십시오.
• 커버, 잉크 카트리지 슬롯 또는 기타 기기 내부 영역에 불필요하게 손이나 손가락을 넣지 마십시오.

• 적절한 위치에 설치하십시오.
• 지정된 온도와 상대습도를 갖는 장소에 기기를 설치하십시오.
• 양호한 작동 조건을 제공하는 조용하고 안정적인 장소에 기기를 설치하십시오.

• 프린트 헤드와 UV-LED 장치는 민감한 장치입니다.
• 개체를 불필요하게 만지거나 인쇄된 개체를 긁어내지 마십시오. 주의해서 다루지 않으면 손상될 수 

있습니다.
• 건조하게 방치하면 프린트 헤드가 손상될 수 있습니다. 기기는 자동으로 건조를 방지하지만 부적절

하게 작동하면 이 기능이 작동하지 않을 수 있습니다. 본 설명서에 명시된 대로 올바르게 작동하십
시오.

• 잉크 카트리지를 제거한 채로 기기를 떠나지 마십시오. 프린터에 남아 있는 잉크로 인해 프린터 헤드
의 노즐이 굳어 막힐 수 있습니다.

• 일상적인 유지보수는 물론, 상태에 따른 다양한 유지보수도 수행해야 합니다. 본 설명서를 잘 읽고 
적절한 시기에 적절한 유지보수를 수행하십시오.

• 프린트 헤드는 소모성 부품입니다. 정기적인 교체가 필요하며, 교체 빈도는 사용 상황에 따라 다릅
니다.

잉크 카트리지

• 잉크 카트리지는 다양한 유형으로 제공됩니다.
• 프린터와 호환되는 유형을 사용하십시오. 또한 Roland DG Corporation의 정품만을 사용하시기 

바랍니다.
• 잉크 카트리지에 충격을 가하지 말고 잉크 파우치를 분해하지 마십시오.

• 잉크 카트리지를 떨어뜨리거나 세게 흔들지 마십시오. 충격으로 인해 내부 파우치가 파손되어 잉크
가 새어 나올 수 있습니다.

• 절대로 분해하려고 시도하지 마십시오.
• 절대로 잉크를 리필하지 마십시오.
• 잉크가 손이나 옷에 묻은 경우 가능한 한 빨리 씻어내십시오. 그대로 방치하면 제거가 어려워질 수 

있습니다.
• 보관

• 잉크 카트리지에 인쇄된 만료 날짜 전에 잉크를 모두 사용하십시오.
• 직사광선이나 강한 조명을 받지 않는 장소에 잉크 카트리지를 보관하십시오.
• 잉크 카트리지를 개봉하지 않은 상태로 온도 5℃(41℉) 이상 40℃(104℉) 미만, 

상대 습도 20~80% RH의 통풍이 잘 되는 곳에 보관하십시오.
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자동 유지보수 기능 및 참고사항

이 기기에는 정기적으로 유지보수를 자동으로 수행하는 기능이 있습니다. 이 기능은 프린트 헤드 건조를 
방지하는 작업과 같은 작업을 수행하므로 다음과 같습니다.

• 항상 메인 전원을 켜두십시오.
• 커버가 하나 이상 열려 있는 상태에서 기기를 사용하지 마십시오.
• 잉크 카트리지를 제거한 채로 기기를 떠나지 마십시오.
• 빈 잉크 카트리지를 두고 기기를 떠나지 마십시오.
• 배출되는 폐 잉크의 양을 확인하십시오.

수리, 부품 교체 등의 작업 중에는 사용자 설명서에 기재되지 않은 조작을 절대로 하지 마십시오. 반드시 공인 대리점에 
문의하십시오.

IMPORTANT

드레인 팩, 사용한 클리닝 스틱, 교체 부품(와이퍼, 펠트 와이퍼, 캡탑, 냄세제거제용 필터) 및 배출된 폐 잉크나 잉크가 
묻은 천은 해당 지역의 현행법에 따라 적절하게 폐기하십시오.
배출된 폐 잉크는 가연성이며 독성 성분을 포함하고 있습니다. 배출된 폐 잉크나 배출 폐 잉크로 오염된 천은 절대로 소
각하거나 일반 쓰레기와 함께 폐기하지 마십시오. 또한 배출된 폐 잉크를 하수구, 강, 하천에 버리지 마십시오. 그렇게 
하면 환경에 부정적인 영향을 미칠 수 있습니다.

IMPORTANT
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유지보수 유형 및 시기

본 기기를 최적의 조건에서 사용하려면 적절한 시기에 적절한 유지보수를 수행하는 것이 중요합니다.

정기적인 유지보수
매일 또는 정기적으로 필요한 유지보수 항목입니다.

시기 항목 참조

업무 시작 전

잉크 카트리지 혼합(화이트 잉크) P. 163 잉크 카트리지 유지보수

프린트 헤드 점검 및 클리닝 P. 64 노즐 드롭아웃 테스트

P. 66 일반 헤드 클리닝 수행
업무 종료 후 기기 청소 P. 164 기기 청소

메시지가 나타날 때
수동 헤드 클리닝 P. 168 수동 헤드 클리닝
UV-LED 장치 청소 P. 174 UV-LED램프 청소

고급 유지보수
문제가 발생할 경우 수행되는 유지보수입니다. 이러한 유지보수 중 일부는 많은 양의 잉크를 소모하므로 
설명을 잘 읽어본 후 적절한 시점에 작업을 수행하십시오.

시기 항목 참조

노즐 막힘이나 노즐 변형이 발생
한 경우

잉크 리뉴얼을 통한 각 유형의 
청소

P. 160 노즐 막힘이나 노즐 변형이 발생한
경우

색상이 고르지 않은 문제가 발생
하는 경우(화이트잉크)

각 종류의 청소를 통한 잉크 혼합 P. 161 색상이 고르지 않은 문제가 발생할
경우(화이트 잉크)

소모품 교체
소모품 교체를 위한 품목입니다. 설명을 잘 읽어보신 후, 적절한 시점에 작업을 수행해 주십시오.

시기 항목 참조

메시지가 나타날 때

드레인 팩 P. 188 드레인 팩 교체
와이퍼 P. 192 와이퍼 교체
펠트 와이퍼 P. 194 펠트 와이퍼 교체
캡탑 P. 196 캡탑 교체

매년 또는 기기 근처에서 냄새가 
나는 경우

냄세제거제 필터 P. 202 냄세제거기 필터 교체

기본 유지보수 지식
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장기간 사용하지 않을 때

잉크 잔량이 많은 잉크 카트리지를 미리 삽입하십시오.
잉크가 부족하면 기기에서 정기적으로 자동 유지보수를 수행할 수 없습니다. 기기를 이 상태로 두면 프
린트 헤드가 오작동할 수 있습니다. 기기를 장기간 사용하지 않을 경우에는 잉크가 많이 남아 있는 잉크 
카트리지를 삽입하십시오.

최소 2주에 한 번 서브 전원을 켜십시오.
최소 2주에 한 번씩 서브전원을 켜십시오. 전원을 켜면 기기는 프린트 헤드가 마르지 않도록 하는 등의 
작업을 자동으로 수행합니다. 기기를 오랫동안 사용하지 않으면 프린트 헤드가 손상될 수 있으므로 자동 
작업을 수행하려면 전원을 켜야 합니다.

기기를 일정한 온도와 상대 습도로 유지하십시오.
기기를 사용하지 않을 때에도 온도 5~40℃(41~104℉), 상대습도 20~80%(결로 없을 것)를 유지하십시
오. 그렇게 하지 않으면 오작동이 발생할 수 있습니다.

서브 전원을 꺼도 폐 잉크는 발생합니다.
서브 전원이 꺼진 상태에서도 유지보수 작업이 수행됩니다. 일반적으로 드레인 팩을 새 것으로 교체한 
후 배출된 폐 잉크를 가득 채우는 데는 약 11개월이 소요됩니다. 드레인 팩 구입에 대한 자세한 내용은 
공인 대리점에 문의하십시오.

드레인 팩을 재사용하지 마십시오. 그렇게 하면 배출되는 폐 잉크의 양을 관리할 수 없게 되어 넘칠 수 있습니다.

IMPORTANT

관련된 링크
・ P. 188 드레인 팩 교체
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노즐 막힘이나 노즐 변형이 발생한 경우

노즐 막힘이나 노즐 변형이 발생한 경우 조치를 취하는 절차입니다. 일부 작업에서는 많은 양의 잉크가 소모
됩니다. 또한 프린트 헤드 자체가 손상되기 쉽기 때문에 필요 이상으로 이러한 작업을 수행하지 마십시오.

절차

1. 일반 헤드 클리닝 수행
이 작업을 2~3회 수행한 후에도 문제가 해결되지 않으면 다음 단계를 진행하십시오.

2. 미디엄 헤드 클리닝 수행
이 작업을 2~3회 수행한 후에도 문제가 해결되지 않으면 다음 단계를 진행하십시오.

3. 파워풀 클리닝 수행
이 작업을 2~3회 수행한 후에도 문제가 해결되지 않으면 다음 단계를 진행하십시오.

4. 수동 헤드 클리닝 수행
이 작업을 한 번 수행한 후에도 문제가 해결되지 않으면 다음 단계를 진행하십시오.

5. 잉크 리뉴얼 수행
잉크 리뉴얼으로 문제가 해결되지 않으면 공인 대리점에 문의하십시오.

기본 유지보수 지식

160 소개



색상이 고르지 않은 문제가 발생할 경우(화이트 잉크)

화이트 잉크에 색상 불균일이 발생한 경우 조치를 취하는 절차입니다. 일부 작업에서는 많은 양의 잉크가 
소모됩니다. 또한 프린트 헤드 자체가 손상되기 쉽기 때문에 필요 이상으로 이러한 작업을 수행하지 마십시
오.

절차

1. 잉크 카트리지 유지보수 수행
잉크 카트리지를 완전히 혼합한 후에도 문제가 해결되지 않으면 다음 단계를 진행합니다.

2. [Ink Circulation] 수행

(1) 유틸리티 홈 화면에서        를 클릭합니다.

(2) [Maintenance]>[Ink Circulation]에서 [Execute]를 클릭합니다.

잉크 경로의 잉크가 순환됩니다. 이 작업을 한 번 수행한 후에도 문제가 해결되지 않으면 다음 
단계를 진행하십시오.

3. 파워풀 클리닝 수행
잉크 순환을 2~3회 수행한 후에도 문제가 해결되지 않으면 다음 단계를 진행하십시오.

4. 잉크 리뉴얼 수행
이 작업을 한 번 수행한 후에도 문제가 해결되지 않으면 다음 단계를 진행하십시오.

5. 미디엄 헤드 클리닝 수행
이 작업을 2~3회 수행한 후에도 문제가 해결되지 않으면 공인 대리점에 문의하십시오.

기본 유지보수 지식
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잉크 카트리지 유지보수

잉크에 성분이 침전되면 정상적인 색상으로 인쇄할 수 없습니다. 잉크가 잘 섞이도록 잉크 카트리지를 빼낸 
후 잉크 카트리지 양쪽 끝에서 약 5 cm (1.97 in.)의 간격의 수평으로 50회(약 20초) 흔든 후 다시 삽입하십
시오.
잉크 카트리지를 흔들어 보세요:

• 모든 잉크: 새 제잉크로 교체하는 경우.
• 화이트 잉크: 매일(업무 시작 전)

화이트 잉크의 성분은 분리되어 침전되는 경향이 있습니다. 매일 작업을 시작하기 전에 반드시 이 카트
리지를 흔들어 주십시오. 잉크를 그대로 두면 침전된 잉크의 성분이 굳어져 오작동이나 기타 문제가 발
생할 수 있습니다.

• 잉크 카트리지를 흔들기 전에 토출구 주변의 잉크를 닦아내십시오. 잉크를 닦아내지 않으면 잉크 카트리지를 흔들 
때 잉크가 튀길 수 있습니다.

• 잉크 카트리지 흔들기가 끝나면 즉시 잉크 카트리지를 다시 설치하십시오. 잉크 카트리지를 다시 장착하는 데 시간
이 걸리면 잉크가 이동하는 경로에 부정적인 영향을 미칩니다.

• 프린터를 사용하지 않더라도 일주일에 한 번씩 화이트 잉크 카트리지를 50회(약 20초) 흔들어 주십시오.

IMPORTANT

일일 또는 정기 유지보수
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기기 청소

일일 청소의 일환으로 기기 내부에 쌓인 먼지, 오물, 잉크나 오물을 닦아냅니다.

휘발유, 시너, 기타 인화성 물질은 절대 사용하지 마세요.
화재가 발생할 수 있습니다.

경고

• 본 기기는 정밀 기기이므로 먼지나 오물에 민감합니다. 매일 청소를 수행하십시오.
• 기기에 기름을 바르거나 윤활유를 바르지 마십시오.
• 이 작업을 수행하기 전에 인쇄할 개체를 모두 제거하십시오.

MEMO

절차

1. 전면 커버를 엽니다.

플랫 테이블 위에 있는 개체나 지그를 제거하십시오.

2. 다음 그림에 표시된 위치를 청소합니다.

A UV-LED 장치, 프린트 헤드 캐리지 표면 물에 희석한 중성세제를 적신 천이나 물기를 짜낸 부드
럽고 마른 천으로 닦아 닦아주십시오.

B 플랫 테이블 주변

C 냄세제거제 주변

먼지나 오물이 기기에 쌓이면 개체에 달라붙을 가능성이 높습니다.

MEMO

3. 청소가 끝나면 전면 커버를 닫으십시오.

일일 또는 정기 유지보수
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일반 헤드 클리닝

절차

1. 노즐 검사 시험지를 Setup합니다.

P. 31 노즐 드롭아웃 테스트 시험지 등록 및 설정

2. 유틸리티의 홈 화면에서           [Cleaning]을 클릭하십시오.

3. [Head Cleaning]에서 [Normal Cleaning]을 선택한 후 [Execute]을 클릭합니다.

[Cleaning in progress.] 및 남은 청소 시간 예상 시간이 유틸리티의 홈 화면에 표시됩니다.

4. [Nozzle Drop-out Test]에서 [Output]을 클릭합니다.

테스트 패턴 인쇄가 시작됩니다.

5. 인쇄가 완료되면 전면 커버를 엽니다.

6. 테스트 패턴에 노즐 막힘이나 노즐 변형이 있는지 확인하십시오.

누락된 블록은 노즐 막힘을 나타냅니다. 접혀 있거나 기울어진 블록은 노즐 변형을 나타냅니다.

일일 또는 정기 유지보수
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• 문제가 지속되면 일반 헤드 클리닝을 다시 수행해 보십시오.
• 일반 헤드 클리닝을 여러 번 수행한 후에도 노즐 막힘, 노즐 변형 등의 문제가 지속되면 다른 클리닝 방법을

사용하십시오.
P. 160 노즐 막힘이나 노즐 변형이 발생한 경우

MEMO

7. 전면 커버를 닫습니다.

노즐 막힘이나 노즐 변형이 발생하지 않으면 인쇄 준비가 완료된 것입니다.

8. [Close]를 클릭하면 원래 화면으로 돌아갑니다.

일일 또는 정기 유지보수
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수동 헤드 클리닝

수동 헤드 클리닝이 필요한 경우

다음과 같은 증상이 나타나는 경우
아래와 같은 증상이 발생하고, 일반 헤드 클리닝부터 파워풀 클리닝까지의 과정으로 해결되지 않는 경우에
는 수동 헤드 클리닝을 권장합니다.
와이퍼 교체도 이러한 증상을 개선하는데 효과적일 수 있습니다.

노즐 막힘 또는 노즐 변형 잉크 떨어짐 긁힘 자국

먼지나 기타 이물질이 프린트 헤드에 달라
붙어 올바른 잉크 배출을 방해합니다.

잉크가 프린트 헤드에 달라붙은 먼지나
때로 가득 차서 미디어에 떨어집니다.

프린트 헤드에 먼지나 이물질이 쌓이는 현상
입니다.

• 수동 헤드 클리닝에 사용된 클리닝 스틱과 클리닝 액을 모두 사용한 경우 공인 대리점에 문의하십시오.
• 프린트 헤드는 소모성 부품이므로 사용 빈도나 사용 조건에 따라 교체해야 합니다.

MEMO

관련된 링크

・ P. 192 와이퍼 교체

일일 또는 정기 유지보수
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수동 헤드 클리닝

수동 헤드 클리닝의 경우 수동 헤드 클리닝 도구를 사용하여 프린트 헤드를 자동으로 청소합니다. 그런 다
음 와이퍼, 스크레이퍼 및 캡탑 주변을 수동으로 청소하십시오.

반드시 지침에 따라 작업을 수행하고, 지침에 명시되지 않은 부분은 절대로 만지지 마십시오.
기기가 갑자기 움직이면 부상을 입을 수 있습니다.

경고

이 절차에 대한 중요 참고 사항

• 프린트 헤드가 건조되는 것을 방지하려면 자동 헤드 클리닝 후 10분 이내에 수동 헤드 클리닝을 완료하십시오. 10분
후에 경고음이 울립니다.
• 제공된 클리닝 스틱 이외의 다른 도구를 사용하지 마십시오. 면봉이나 기타 보풀이 발생하는 품목은 프린트 헤드를

손상시킬 수 있습니다. 클리닝 스틱을 모두 사용한 경우 공인 대리점에 문의하십시오.
• 클리닝 세션마다 새 클리닝 스틱을 사용하십시오. 클리닝 스틱을 재사용하면 인쇄 품질이 저하될 수 있습니다.
• 청소에 사용한 클리닝 스틱을 클리닝 액에 넣지 마십시오. 그렇게 하면 클리닝 액의 품질이 저하됩니다.
• 가능한 압력을 약하게 가하면서 부드럽게 쓰다듬듯이 닦아 줍니다. 절대 문지르거나 긁거나 하지 마십시오.

청소 중 경고음이 울리는 경우
프린트 헤드가 마르는 것을 방지하기 위해 자동 클리닝이 완료된 후 약 10분 후에 알람이 울립니다. 유틸리티에 표시된 
메시지에 따라 작업을 수행하십시오.

충격을 가하거나 떨어뜨려 변형될 수 있는 수동 청소 도구를 사용하지 마십시오. 대신, 청소하기 전에 교체하십시오.
변형된 수동 헤드 클리닝 도구를 사용하면 수동 헤드 청소가 제대로 수행되지 않거나 기기가 손상될 수 있습니다.

IMPORTANT

필수항목

클리닝 스틱 클리닝 액 수동 헤드 클리닝 도구

이 절차에 대한 참조 비디오를 보려면 다음 링크를 사용하십시오. 전반적인 작업 흐름을 이해하려면 이 비디오를 시청
하는것이 좋습니다.
https://youtu.be/VmDmhUXBdNA

MEMO

절차

1. 인쇄할 개체를 제거합니다.

2. 수동 헤드 클리닝 도구가 기기 내부에 보관되어 있는 경우 꺼내십시오.

3. 전면 커버를 닫습니다.

4. 다음 방법 중 하나를 사용하여 수동 헤드 클리닝 메뉴에 액세스합니다.

일일 또는 정기 유지보수
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• 알림:    을 클릭하고 [The time for manual cleaning has arrived.]의          를 클릭합니다.

• 유틸리티 홈 화면에서          [Cleaning]을 클릭한 후 [Manual Cleaning]의 [Execute]를 클릭
합니다.

수동  헤드 클리닝 작업 절차는 유틸리티에 표시됩니다. 화면의 지시사항을 주의 깊게 읽고 작업을 수행하십시오.

MEMO

5. 보호 장비(장갑, 안경)를 착용하십시오.

보호 장비를 착용한 후 유틸리티에서 [Next]를 클릭합니다.

6. 수동 헤드 클리닝 도구를 준비하십시오.

(1) 클리닝 스틱에 다량의 클리닝 액을 바르십시오.

(2) 수동 헤드 클리닝 도구에 클리닝 스틱을 장착합니다.

클리닝 스틱을 끝까지 밀어 넣습니다.

일일 또는 정기 유지보수
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클리닝 스틱을 설치한 후 유틸리티에서 [NEXT]를 클릭합니다.

7. 전면 커버를 엽니다.

8. 수동 헤드 클리닝 도구 고정 나사를 사용하여 그림에 표시된 위치에 수동 헤드 클리닝 도구를 고정합니다.

수동 헤드 클리닝 도구 고정 나사는 분실하지 않도록 보관하십시오.

9. 전면 커버를 닫습니다.

전면 커버를 닫은 후 유틸리티에서 [Next]를 클릭하십시오.
프린트 헤드 근처에서 자동 헤드 클리닝을 수행하십시오.

10. 유틸리티에 [Automatic cleaning has finished.]가 표시되면 전면 커버를 열고 수동 헤드 클리닝 도구를 제거
하십시오.

• 프린트 헤드를 청소한 후 클리닝 스틱을 사용하여 와이퍼, 스크레이퍼 및 캡탑을 청소하십시오.
• 수동 헤드 클리닝 도구는 냄세제거제 앞에 보관하는 것이 좋습니다.

 IMPORTANT

11. 전면 커버를 닫습니다.

수동 헤드 클리닝 도구를 제거하십시오. 전면 커버를 닫은 후 유틸리티에서 [Next]를 클릭하십시오. 
프린트 헤드 캐리지는 왼쪽으로 이동합니다.

12. 전면 커버를 엽니다.

일일 또는 정기 유지보수
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13. 와이퍼, 스크레이퍼, 캡탑을 청소하려면 아래 지침을 따르십시오.

(1) 수동 헤드 클리닝 도구에서 클리닝 스틱을 제거합니다.

(2) 와이퍼의 오른쪽 측면과 상단을 청소하십시오.

(3) 스크레이퍼를 청소하십시오.

(4) 캡탑 주변의 네 면을 청소합니다.

(5) 클리닝 스틱의 넓은 표면을 사용한 다음 다른 위치로 이동하고 클리닝 스틱을 캡탑에 가볍게 눌러 먼지를 
      흡수하십시오.

(6) 전면 커버를 닫습니다.

전면 커버를 닫고 유틸리티에서 [Next]을 클릭하십시오.

14. 청소가 완료되면 [Close]를 클릭하여 원래 화면으로 돌아갑니다.

일일 또는 정기 유지보수
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15. 노즐 검사 시험지를 Setup합니다.

P. 31 노즐 드롭아웃 테스트 시험지 등록 및 설정

16.     [Cleaning]을 클릭합니다.

17. [Nozzle Drop-out Test]에서 [Output]을 클릭합니다.

테스트 패턴 인쇄가 시작됩니다.

18. 인쇄가 완료되면 전면 커버를 엽니다.

19. 테스트 패턴에 노즐 막힘이나 노즐 변형이 있는지 확인하십시오.

누락된 블록은 노즐 막힘을 나타냅니다. 접혀 있거나 기울어진 블록은 노즐 변형을 나타냅니다.

• 문제가 지속되면 수동 헤드 클리닝을 다시 수행하십시오.
• 수동 헤드 클리닝을 여러 번 수행한 후에도 노즐 막힘, 노즐 변형 등의 문제가 지속되면 [Ink Renewal]을 

수행하십시오.

MEMO

노즐 막힘이나 노즐 변형이 발생하지 않으면 인쇄 준비가 완료된 것입니다.

20. [Close]를 클릭하면 원래 화면으로 돌아갑니다.

일일 또는 정기 유지보수
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관련된 링크

・ P. 182 잉크 리뉴얼

일일 또는 정기 유지보수
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UV-LED 램프 청소

UV-LED 램프 청소가 필요한 경우
UV-LED 장치는 잉크 접착에 중요한 구성 요소입니다. 정기적이고 적절한 유지보수가 필요합니다. UV-
LED 장치는 적절한 타이밍에 청소하는 것이 중요합니다.

[The time for manual cleaning of the UV lamp has arrived.]가 나타나는 경우
항상 안정적인 인쇄 상태를 유지하기 위해 사용 조건에 따라 UV 램프를 청소해야 하는 시기를 알려줍니다. 
이 알림을 받으면 반드시 UV 램프 청소를 수행하십시오.

잉크 미스트가 많이 흩뿌려져 기기 내부가 더러워진 경우
프린트 헤드를 인쇄 표면에서 멀리 떨어진 상태로 자주 인쇄하거나 잉크가 인쇄 표면에서 튀어나온 위치로 
방출되는 경우 매일 이 청소를 수행하십시오. 흩어진 잉크 미스트가 굳어지면 오작동이 발생할 수 있습니다.

UV-LED 램프의 조사창 표면이 더러운 경우(다음 그림 참조)

일일 또는 정기 유지보수
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UV-LED 램프 청소 방법

이 절차에 대한 중요 참고 사항

• 이 작업을 수행하기 전에 인쇄할 개체를 모두 제거하십시오.
• 프린트 헤드가 건조되는 것을 방지하려면 이 절차를 10분 이내에 완료하십시오. 10분 후에 경고음이 울립니다.
• 청소에 사용되는 천, 알코올 같은 물품은 제품에 포함되어 있지 않습니다.

IMPORTANT

필수항목

무수 에탄올 또는 이소프로필 알코올 천(푹신하지 않은 것)

인쇄가 완료된 후 바로 청소를 수행하지 마십시오. (인쇄가 완료된 후 약 15분 정도 기다립니다.)
UV-LED 램프 주변은 뜨겁기 때문에 화상을 입을 수 있습니다.

주의

무수에탄올, 이소프로필알코올을 사용할 경우에는 해당 제품의 사용시 주의사항을 반드시 지켜주십시오.
화재, 환기, 발진 등의 항목에 주의하십시오.

주의

무수 에탄올이나 이소프로필 알코올만 사용하십시오.
무수 에탄올이나 이소프로필 알코올 이외의 화학 물질(또는 유사한 물질)을 사용하면 UV-LED 램프가 손상될 수 있습니다.

주의

보송보송하지 않은 천을 사용하여 부품을 닦아내십시오. 금속 등 단단한 재질을 사용하지 않습니다.
보풀이 많은 천이나 금속 등 단단한 재질을 사용하면 UV-LED 램프가 손상될 수 있습니다.

주의

절차

1. 개체를 제거한 후 전면 커버를 닫습니다.

2. 다음 방법 중 하나를 사용하여 수동 헤드 클리닝 메뉴에 액세스합니다.

• 알림:      을 클릭하고 [The time for manual cleaning of the UV lamp has arrived.]의 

         를 클릭합니다. 

일일 또는 정기 유지보수
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• 유틸리티 홈 화면에서       를 클릭하고 [Maintenance] 아래 [UV Lamp Manual Cleaning]의
    [Execute]를 클릭합니다.

프린트 헤드 캐리지가 중앙 근처로 이동합니다.

3. 전면 커버를 열고 유지보수 커버를 제거합니다.

4. 그림에 표시된 위치(잉크 슬롯 옆)를 터치하여 정전기를 방전시킵니다.

5. 보호 장비(장갑, 안경)를 착용하십시오.

6. [OK]를 클릭합니다.

프린트 헤드 캐리지와 플랫 테이블이 움직입니다.

7. 무수 에탄올이나 이소프로필 알코올을 천에 적신 후 이 천으로 UV-LED 램프의 조사창 표면을 닦아냅니다.
모든 먼지가 제거될 때까지 약 10회 왕복 동안 각 UV 램프를 천으로 닦습니다.

먼지를 닦아낸 후 [Next]를 클릭합니다.

8. 유지보수 커버를 장착한 다음 전면 커버를 닫습니다.

9. [Finish]를 클릭합니다.

프린트 헤드 캐리지가 원래 위치로 돌아갑니다.

일일 또는 정기 유지보수
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미디엄 헤드 클리닝

노즐 막힘 및 노즐 변형과 같은 문제가 일반 헤드 클리닝으로 해결되지 않는 경우, 보다 강력한 [Medium 
Cleaning]을 수행하여 프린트 헤드 노즐의 막힘을 제거하십시오.

미디엄 헤드 클리닝은 일반 헤드 클리닝보다 잉크를 더 많이 소모합니다. 너무 자주 수행하면 프린트 헤드가 손상되기 쉽기 
때문에 필요 이상으로 클리닝을 수행하지 마십시오.

MEMO

절차

1. 노즐 검사 시험지를 Setup합니다.

2. 유틸리티 홈 화면에서           [Cleaning]을 클릭하십시오.

3. [Head Cleaning]에서 [Medium Cleaning]을 선택한 후 [Execute]를 클릭합니다.

[Cleaning in progress.] 및 남은 청소 시간 예상 시간이 유틸리티 홈 화면에 표시됩니다.

4. [Nozzle Drop-out Test]에서 [Output]을 클릭합니다.

테스트 패턴 인쇄가 시작됩니다.

5. 인쇄가 완료되면 전면 커버를 엽니다.

6.  테스트 패턴에 노즐 막힘이나 노즐 변형이 있는지 확인하십시오.

누락된 블록은 노즐 막힘을 나타냅니다. 접혀 있거나 기울어진 블록은 노즐 변형을 나타냅니다.

문제 발생 시 수행할 유지보수
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• 문제가 지속되면 미디엄 헤드 클리닝을 다시 수행해 보십시오.
• 미디엄 헤드 클리닝을 2~3회 실시한 후에도 노즐 막힘, 노즐 변형 등의 문제가 지속되면 보다 강력한 

[Powerful Cleaning]을 수행하십시오.

MEMO

노즐 막힘이나 노즐 변형이 발생하지 않으면 인쇄 준비가 완료된 것입니다.

7. 전면 커버를 닫습니다.

8. [Close]를 클릭하면 원래 화면으로 돌아갑니다.

관련된 링크
・ P. 180 파워풀 클리닝

문제 발생 시 수행할 유지보수
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파워풀 클리닝

노즐 막힘 및 노즐 변형과 같은 문제가 미디엄 헤드 클리닝으로 해결되지 않는 경우 보다 강력한 [Powerful 
Cleaning]를 수행하여 프린트 헤드 노즐의 막힘을 제거하십시오.

파워풀 클리닝은 미디엄 헤드 클리닝보다 더 많은 잉크를 소모합니다. 너무 자주 수행하면 프린트 헤드가 손상되기 쉽기 
때문에 필요 이상으로 클리닝을 수행하지 마십시오.

MEMO

절차

1. 노즐 검사 시험지를 Setup합니다.

2. 유틸리티 홈 화면에서           [Cleaning]을 클릭하십시오.

3. [Head Cleaning]에서 [Powerful Cleaning]을 선택한 후 [Execute]를 클릭합니다.

[Cleaning in progress.] 및 남은 청소 시간 예상 시간이 유틸리티 홈 화면에 표시됩니다.

4. [Nozzle Drop-out Test]에서 [Output]을 클릭합니다.

테스트 패턴 인쇄가 시작됩니다.

5. 인쇄가 완료되면 전면 커버를 엽니다.

6. 테스트 패턴에 노즐 막힘이나 노즐 변형이 있는지 확인하십시오.

누락된 블록은 노즐 막힘을 나타냅니다. 접혀 있거나 기울어진 블록은 노즐 변형을 나타냅니다.

문제 발생 시 수행할 유지보수
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• 문제가 지속되면 파워풀 클리닝을 다시 수행해 보십시오.
• 파워풀 클리닝을 여러 번 수행한 후에도 노즐 막힘, 노즐 변형 등의 문제가 지속되면 [Manual Cleaning]을 

수행하십시오.

MEMO

노즐 막힘이나 노즐 변형이 발생하지 않으면 인쇄 준비가 완료된 것입니다.

7. 전면 커버를 닫습니다.

8. [Close]를 클릭하면 원래 화면으로 돌아갑니다.

관련된 링크
・ P. 167 수동 헤드 클리닝

문제 발생 시 수행할 유지보수
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잉크 리뉴얼

이는 노즐 막힘이나 노즐 변형을 복구하고 어떤 방법으로도 고칠 수 없는 잉크 농도를 복원하는 데 사용
됩니다.

잉크 경로에 있는 잉크를 교체하려면 많은 양의 잉크가 소모된 후 폐 잉크로 배출됩니다. 이 작업을 자주 수행하지 마십
시오.

IMPORTANT

절차

1. 노즐 검사 시험지를 Setup합니다.

2. 유틸리티 홈 화면에서        를 클릭합니다.

3. [Maintenance]에서 [Ink Renewal]의 [Execute]를 클릭합니다.

[Ink Renewal] 기능을 시작합니다.

4. 잉크 리뉴얼이 완료되면 [Nozzle Drop-out Test]에서 [Output]을 클릭합니다.

5. 인쇄가 완료되면 전면 커버를 엽니다.

6. 테스트 패턴에 노즐 막힘이나 노즐 변형이 있는지 확인하십시오.

누락된 블록은 노즐 막힘을 나타냅니다. 접혀 있거나 기울어진 블록은 노즐 변형을 나타냅니다.

• 노즐 막힘이나 노즐 변형이 발생하지 않으면 인쇄 준비가 완료된 것입니다.
• 여전히 노즐 막힘이나 노즐 변형이 발생하는 경우 공인 대리점에 문의하십시오.

7. 전면 커버를 닫습니다.

8. [Close]를 클릭하면 원래 화면으로 돌아갑니다.

문제 발생 시 수행할 유지보수
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잉크 배출

정기적으로 수행되는 잉크 배출을 미리 수행하십시오. 데모 등 즉시 인쇄를 수행하려는 경우에는 미리 수행
하십시오.

[Ink Discharge]는 일반 유지보수 시 자동으로 수행되므로 사용자가 실행할 필요가 없습니다.

MEMO

절차

1. 유틸리티 홈 화면에서        를 클릭합니다.

2. [Maintenance]에서 [Ink Discharge]의 [Execute]를 클릭합니다.

[Ink Discharge] 기능을 시작합니다.

문제 발생 시 수행할 유지보수
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잉크 부족 경고

잉크가 모두 소모되면 인쇄가 일시 중지되고 [Ink Cartridge Error]가 나타납니다.
잉크가 모두 소모되면 유틸리티 홈 화면에     이 표시되고, 알림에는 [Ink has run out.]이 표시됩니다. 
가능한 한 빨리 모두 소모된 빈 잉크 카트리지를 교체하십시오.

• K: Black
• C: Cyan
• M: Magenta
• Y: Yellow
• Pr: Primer
• Wh: White

[Ink has run out.]가 표시된 잉크 카트리지는 절대로 재사용하지 마십시오.

[Ink has run out.]가 표시되더라도 카트리지에 소량의 잉크가 남아 있을 수 있습니다. 이러한 잉크 카트리지는 잉크를 
빼낼 수 없는 상태이므로 이러한 상태에서 사용하면 공기가 잉크 경로로 유입되어 오작동이 발생할 수 있습니다.

IMPORTANT

잉크 카트리지 교체
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잉크 카트리지 교체

잉크, 클리닝 액 또는 배출된 폐 잉크를 다음 장소에 보관하지 마십시오.

• 화염에 노출된 모든 장소
• 고온이 발생할 수 있는 모든 장소
• 표백제나 기타 산화제, 폭발성 물질 근처
• 어린이의 손이 닿는 모든 위치

화재는 위험할 수 있습니다. 어린이가 우발적으로 섭취하면 건강에 위험을 초래할 수 있습니다.

경고

카트리지 교체에 관한 중요 참고 사항

• 카트리지를 동일한 유형과 색상의 품목으로 교체하십시오.
• 화살표가 있는 쪽이 위로 향하도록 카트리지를 삽입합니다.
• 카트리지를 한 번에 하나씩 천천히 삽입하고 제거하십시오.
• 카트리지를 끝까지 단단히 삽입하십시오.

• 절대로 다른 종류의 품목을 혼합하지 마십시오.
• 잉크 카트리지를 제거한 채로 기기를 떠나지 마십시오. 프린트 헤드의 노즐이 막힐 수 있습니다.

IMPORTANT

[Ink has run out.]가 표시된 잉크 카트리지는 절대로 재사용하지 마십시오.

[Ink has run out.]가 표시되더라도 카트리지에 소량의 잉크가 남아 있을 수 있습니다. 이러한 잉크 카트리지는 잉크를 
빼낼 수 없는 상태이므로 이러한 상태에서 사용하면 공기가 잉크 경로로 유입되어 오작동이 발생할 수 있습니다.

IMPORTANT

절차

1. 전면 커버를 엽니다.

2. 빈 잉크 카트리지를 당겨 빼냅니다.

3. 새 잉크 카트리지를 가볍게 흔듭니다.
보관 중에 잉크 성분이 침전될 수 있습니다. 잉크에 성분이 침전되면 정상적인 색상으로 인쇄할 수 
없습니다. 잉크가 잘 섞이도록 잉크 카트리지를 삽입하기 전에 잉크 카트리지 양쪽 끝에서 약 5 cm 
(1.97 in.)의 간격의 수평으로 각 잉크 카트리지를 50회(약 20초) 흔듭니다.

4. 잉크 카트리지를 잉크 슬롯에 삽입합니다.

잉크 카트리지 교체
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화살표나 돌출부가 위로 오도록 잉크 카트리지의 방향을 맞춘 다음 그림에 표시된 방향으로 잉크 
카트리지를 끝까지 삽입합니다.

5. 전면 커버를 닫습니다.

잉크 카트리지 교체
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드레인 팩 교체

인쇄 후 프린트 헤드에 남은 잉크 또는 헤드 청소에 사용된 잉크를 배출된 폐 잉크라고 합니다. 배출된 폐 
잉크는 드레인 팩에 수집되며, 지정된 양에 도달하면 유틸리티에 교체 메시지가 표시됩니다.

드레인 팩 교체에 대한 메시지에는 두 가지 유형이 있습니다. 표시되는 메시지는 배출된 폐 잉크의 양에 
따라 다릅니다.

1.  [When output, cleaning, and other operations are completed, discard the discharged fluid.]
현재로서는 드레인 팩의 사용 한계에 도달하지 않았습니다. 예를 들어 교체용 드레인 팩을 쉽게 구할 수 
없는 경우에도 계속 사용할 수 있습니다. 그러나 드레인 팩은 가능한 한 빨리 교체해야 합니다.

2. [Replace the drain pack.]
이는 드레인 팩의 사용 한계에 도착했음을 나타냅니다. 이 오류가 나타나면 더 이상 드레인 팩을 사용할 
수 없습니다.

기기가 배출된 폐 잉크의 총량을 계산하고 있습니다. 배출된 폐 잉크의 양이 드레인 팩 용량에 거의 도달하
면 기기는 이를 교체하라는 메시지를 표시합니다. 배출된 폐 잉크를 다음 절차에 따라 처리하지 않으면 배
출된 폐 잉크의 양이 재설정되지 않으며 배출된 폐 잉크의 제어가 불가능해집니다.

표시된 메시지의 지시에 따라 드레인 팩을 교체하십시오.

또한, 기기를 장기간 사용하지 않을 경우 아래 절차에 따라 드레인 팩을 교체하십시오.

절대로 화염 근처에 드레인 카트리지나 잉크를 두지 마십시오.
화재가 발생할 수 있습니다.

경고

드레인 카트리지를 제거하기 전에 유틸리티에 메시지가 표시될 때까지 기다리십시오.
이 절차를 따르지 않으면 배출된 폐 잉크가 튜브 밖으로 흘러나와 유출되어 손이나 바닥을 더럽힐 수 있습니다.

주의

드레인팩을 임시 보관할 때에는 밀봉된 용기나 비닐봉지에 담아 보관하시면 됩니다.
유출이나 증기 누출로 인해 화재, 냄새 또는 신체적 고통이 발생할 수 있습니다.

주의

• 드레인 팩을 재사용하지 마십시오.
그렇게 하면 배출되는 폐 잉크의 양을 관리할 수 없게 되어 넘칠 수 있습니다.

• 해당 지역의 현행법에 따라 배출된 폐 잉크를 적절하게 폐기하십시오.
배출된 폐 잉크는 가연성이며 독성 성분을 포함하고 있습니다. 배출된 폐 잉크를 소각하거나 일반 쓰레기와 함께 버리
지 마십시오. 또한 하수구, 강, 하천에 버리지 마십시오. 그렇게 하면 환경에 부정적인 영향을 미칠 수 있습니다.

IMPORTANT

유지보수를 위한 부품 교체
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필수항목

드레인 팩

이 절차에 대한 참조 비디오를 보려면 다음 링크를 사용하십시오. 전반적인 작업 흐름을 이해하려면 이 비디오를 시청하는
것이 좋습니다.
https://youtu.be/Uw8XZQpKlv8

MEMO

절차

1. 전면 커버를 열고 유지보수 커버를 제거합니다.

2. 보호 장비(장갑, 안경)를 착용하십시오.

3. 드레인 카트리지를 제거합니다.
손으로 드레인 카트리지의 하단을 지탱할 수 있을 때까지 드레인 카트리지를 당겨 빼냅니다. 그리고 
핸들과 하단을 잡고 이 카트리지를 제거합니다.

드레인 카트리지를 떨어뜨리거나 충격을 가하지 마십시오. 드레인 카트리지 돌출부 손상으로 인해 기기에서 드레
인 카트리지를 인식할 수 없으며, 드레인 카트리지를 설치한 경우에도 [The drain cartridge was re-moved.] 메
시지가 계속 표시됩니다.

IMPORTANT

유지보수를 위한 부품 교체

소모품 교체 189

https://youtu.be/Uw8XZQpKlv8


4. 두 위치의 후크를 풀어 드레인 카트리지 뚜껑을 잠금 해제한 다음 엽니다.

5. 드레인 팩의 커버를 들어올려 드레인 카트리지에서 제거합니다.

드레인 팩의 측면을 잡고 잡아당기십시오. 플랩 부분을 잡고 당기면 찢어질 수 있습니다.

드레인 팩의 구멍에 닿으면 잉크가 뭍을 수 있습니다.

MEMO

6. 새 드레인 팩을 드레인 카트리지에 삽입합니다.

드레인 팩의 구멍(B)이 드레인 카트리지의 손잡이(A) 반대쪽에 오도록 드레인 팩을 삽입합니다.

유지보수를 위한 부품 교체
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7. 드레인 카트리지 뚜껑을 닫습니다.

드레인 카트리지 뚜껑의 구멍과 드레인 팩의 구멍을 맞춘 다음 손잡이 쪽에서 뚜껑을 닫습니다. 
뚜껑이 카트리지와 같은 높이가 아닌 경우 뚜껑 둘레를 살짝 눌러 카트리지에 맞춥니다.

8. 드레인 카트리지를 기기에 삽입합니다.

드레인 카트리지 바닥에 손을 대고 수평 또는 손잡이 쪽을 약간 올린 상태에서 천천히 밀어 넣습니다.

9. 유지보수 커버를 장착한 다음 전면 커버를 닫습니다.

10. [Has the drain pack been replaced with a new one?] 메시지가 나타나면 [Yes]를 클릭하여 메시지를 
닫으십시오.

드레인 팩 구입에 대한 자세한 내용은 공인 대리점에 문의하십시오.

유지보수를 위한 부품 교체
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와이퍼 교체

와이퍼는 프린트 헤드를 청소하는 데 사용되는 구성 요소입니다.

와이퍼 교체 시기가 되면 [The time for wiper replacement has arrived.]라는 안내가 나타납니다. 알림
이 나타나면 교체합니다.

와이퍼 구입에 대한 자세한 내용은 공인 대리점에 문의하십시오.

반드시 지침에 따라 작업을 수행하고, 지침에 명시되지 않은 부분은 절대로 만지지 마십시오.
기기가 갑자기 움직이면 부상을 입을 수 있습니다.

경고

와이퍼 교체 중 경고음이 울리는 경우
프린트 헤드가 건조되는 것을 방지하기 위해 작업 시작 후 약 30분 후에 알람이 울립니다. 유틸리티에 표시되는 메시지에 
따라 작업을 수행하십시오.

IMPORTANT

필수항목

와이퍼 핀셋

이 절차에 대한 참조 비디오를 보려면 다음 링크를 사용하십시오. 전반적인 작업 흐름을 이해하려면 이 비디오를 시청하는
것이 좋습니다.
https://youtu.be/JGrvlQDaxfc

MEMO

절차

1. 인쇄할 개체를 제거합니다.

2. 유틸리티 홈 화면에서      을 클릭하면 메시지가 표시됩니다.

3. [The time for wiper replacement has arrived.] 아래의           를 클릭하십시오.

[Wiper Replacement] 창이 나타납니다.

4. 보호장비(장갑, 안경)를 착용한 후 [OK]를 클릭하십시오.

프린트 헤드 캐리지가 와이퍼 교체가 가능한 위치로 이동합니다.

5. 화면의 지시에 따라 아래 절차에 따라 와이퍼를 교체하십시오.

(1) 전면 커버를 엽니다.

(2) 후크(①)를 분리하고 와이퍼를 위로(②) 당겨 빼냅니다.

유지보수를 위한 부품 교체
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(3) 그림과 같이 새 와이퍼를 삽입합니다.

점선으로 표시된 경사 부분이 뒤쪽에 오도록 와이퍼를 설치하십시오.
(4) 와이퍼를 후크에 장착합니다.

(5) [Next]를 클릭합니다.

6. 작업이 완료되면 전면 커버를 닫으십시오.

7. [Finish]를 클릭합니다.
프린트 헤드 캐리지가 원래 위치로 돌아온 다음 헤드 청소가 시작됩니다. 헤드 청소가 완료되고 
짧은 비프음이 두 번 울리면 작업이 완료된 것입니다.

유지보수를 위한 부품 교체
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펠트 와이퍼 교체

펠트 와이퍼는 프린트 헤드를 청소하는 데 사용되는 구성 요소입니다.

펠트 와이퍼 교체 시기가 되면 [The time for felt wiper replacement has arrived.]라는 안내가 나타납니다. 
알림이 나타나면 교체합니다.

펠트 와이퍼 구입에 대한 자세한 내용은 공인 대리점에 문의하십시오.

반드시 지침에 따라 작업을 수행하고, 지침에 명시되지 않은 부분은 절대로 만지지 마십시오.
기기가 갑자기 움직이면 부상을 입을 수 있습니다.

경고

펠트 와이퍼 교체 중 경고음이 울리는 경우
프린트 헤드가 건조되는 것을 방지하기 위해 작업 시작 후 약 30분 후에 알람이 울립니다. 유틸리티에 표시되는 메시지에 
따라 작업을 수행하십시오.

IMPORTANT

필수항목

펠트 와이퍼 핀셋

이 절차에 대한 참조 비디오를 보려면 다음 링크를 사용하십시오. 전반적인 작업 흐름을 이해하려면 이 비디오를 시청하는
것이 좋습니다.
https://youtu.be/dQCQqWV16kA

MEMO

절차

1. 인쇄할 개체를 제거합니다.

2. 유틸리티 홈 화면에서      을 클릭하면 메시지가 표시됩니다.

3. [The time for felt wiper replacement has arrived.] 아래의            를 클릭하십시오.

[Felt Wiper Replacement] 창이 나타납니다.

4. 보호장비(장갑, 안경)를 착용한 후 [OK]을 클릭하십시오.

프린트 헤드 캐리지가 펠트 와이퍼 교체가 가능한 위치로 이동합니다.

5. 화면의 지시에 따라 아래 절차를 수행하여 펠트 와이퍼를 교체하십시오.

(1) 전면 커버를 엽니다.

(2) 후크를 분리하고(①) 펠트 와이퍼를 위로(②) 당겨 빼냅니다.

유지보수를 위한 부품 교체
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(3) 새 펠트 와이퍼를 삽입합니다.

(4) 펠트 와이퍼를 후크에 장착합니다.

(5) [Next]를 클릭합니다.

6. 작업이 완료되면 전면 커버를 닫으십시오.

7. [Finish]를 클릭합니다.
프린트 헤드 캐리지가 원래 위치로 돌아온 다음 헤드 청소가 시작됩니다. 헤드 청소가 완료되고 짧은 
비프음이 두 번 울리면 작업이 완료된 것입니다.

유지보수를 위한 부품 교체
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캡탑 교체

캡탑은 프린트 헤드가 건조되는 것을 방지하는 보호 부품입니다.

캡탑 교체 시기가 되면 [The time for cap top replacement has arrived.] 안내가 나타납니다. 안내가 나
타나면 교체해 주십시오.

캡탑 구매에 대한 자세한 내용은 공인 대리점에 문의하십시오.

반드시 지침에 따라 작업을 수행하고, 지침에 명시되지 않은 부분은 절대로 만지지 마십시오.
기기가 갑자기 움직이면 부상을 입을 수 있습니다.

경고

캡탑 교체시 경고음이 울리는 경우
이 작업은 교체, 청소, 확인의 세 가지 절차로 구성됩니다. 프린트 헤드가 건조해지는 것을 방지하기 위해 교체 시작 후 
약 30분, 청소 후 확인 시작 후 약 5분 후에 경고음이 울립니다. 이 경고음이 들리면 유틸리티 창에 표시된 메시지에 따라 
작업을 수행하십시오.

IMPORTANT

캡탑 교체에는 잉크 튜브를 제거하는 과정이 포함됩니다. 제거된 튜브가 자외선에 노출되면 잉크가 튜브 내부에서 경화될 
수 있습니다.
캡탑 주변이 어두운 경우에는 UV 광선을 방출하지 않는 조명(파장 450nm 이하의 조명)을 사용하십시오.

MEMO

필수항목

캡탑 타이 (2)*1

*1 교체용 캡탑과 함께 제공되는 3개의 타이 중 2개를 사용하십시오. 나머지 타이는 예비용입니다.

이 절차에 대한 참조 비디오를 보려면 다음 링크를 사용하십시오. 전반적인 작업 흐름을 이해하려면 이 비디오를 시청하는
것이 좋습니다.
https://youtu.be/ufzWC3gW55o

MEMO

절차

1. 인쇄할 개체를 제거합니다.

2. 유틸리티 홈 화면에서      을 클릭하면 메시지가 표시됩니다.

3. [The time for cap top replacement has arrived.] 아래의            를 클릭하십시오.
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[Cap Top Replacement] 창이 나타납니다.

4. 보호 장비(장갑, 안경)를 착용한 후 [Next]를 클릭하십시오.

프린트 헤드 캐리지가 캡탑 교체가 가능한 위치로 이동합니다.

5. 화면 지침에 따라 아래 절차에 따라 캡탑을 교체하십시오.

(1) 전면 커버를 엽니다.

전면 커버를 열고 [Next]를 클릭합니다.
(2) 캡탑이 부착된 파운데이션을 오른쪽으로 밀어주십시오.

파운데이션을 계속 누른 상태로 [Next]를 클릭합니다.
(3) 캡탑을 제거합니다.

• 캡탑은 그림에 표시된 세 지점에 고정되어 있습니다. 캡탑을 아래로 누르고 왼쪽으로 
밀어서 빼냅니다.

• 캡탑이 제거되면 캡탑을 잡고 있던 파운데이션을 풀어주십시오.

캡탑을 제거한 후 [Next]를 클릭하십시오.
(4) 캡탑 하단 홈에 삽입된 스프링을 제거합니다.

스프링을 올바르게 제거할 수 없는 경우 살짝 비틀어 보십시오. 이렇게 하면 스프링을 더 쉽게 
제거할 수 있습니다.
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홈에서 스프링을 제거한 후 [Next]를 클릭하십시오.
(5) 튜브의 윗부분을 잡고 튜브에서 캡탑을 제거합니다.

튜브가 기기 안으로 떨어지지 않도록 주의하십시오.
튜브가 기기 안으로 떨어져서 제거할 수 없는 경우 공인 대리점에 문의하십시오.

IMPORTANT

튜브에서 캡탑을 제거한 후 [Next]를 클릭하십시오.
(6) 스프링을 압축합니다.

i. 파운데이션에서 스프링을 제거합니다.
ii. 타이로 스프링을 압축합니다.

유지보수를 위한 부품 교체
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iii. 스프링을 파운데이션에 장착합니다.
(7) 새 캡탑에 튜브를 장착합니다.

i. 캡탑의 두 돌출부가 뒤쪽을 향하도록 캡탑을 잡습니다.
ii. 슬리브가 튜브 안으로 깊숙이 밀려나지 않도록 튜브 끝부분의 슬리브(A)를 캡탑에 삽입

합니다.

튜브를 삽입한 후 [Next]를 클릭하십시오.
(8) 스프링을 압축하고 있는 타이를 제거합니다.

스프링의 힘이 갑자기 캡탑에 가해지지 않도록 스프링을 천천히 풀어줍니다.

IMPORTANT

(9) 캡탑을 잡은 상태에서 캡탑 하단(A)과 파운데이션의 홈(B)에 스프링을 삽입합니다.

스프링을 삽입한 후 [Next]를 클릭합니다.
(10) 파운데이션을 오른쪽으로 밀어 넣습니다.
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파운데이션을 잡은 상태로 [Next]를 클릭하십시오.
(11) 캡탑을 파운데이션에 장착합니다.

캡탑이 수평 위치에 있는 상태에서 캡탑을 아래(①)로 누르고 오른쪽(②)으로 밉니다.

올바르게 장착하려면

• 캡탑은 그림에 표시된 세 위치에 고정되어 있습니다.
• 캡탑과 파운데이션이 평행합니다.

MEMO

캡탑을 장착한 후 [Next]를 클릭하십시오.
(12) 작업이 완료되면 전면 커버를 닫아주십시오.

6. [Next]를 클릭합니다.
프린트 헤드 캐리지가 원래 위치로 돌아온 다음 헤드 청소가 시작됩니다. 헤드 청소가 완료되고 짧은 
경고음이 두 번 울리면 다음 단계로 진행합니다.

7. 전면 커버를 열고 캡탑에 잉크가 묻어 있는지 확인하십시오.
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캡탑에 잉크가 없으면 5-(7)단계에서 설명한 대로 튜브가 삽입되지 않았을 수 있습니다. 캡탑을 
다시 제거하고 연결상태를 확인하십시오.

8. 전면 커버를 닫은 후 [Finish]를 클릭하십시오.

프린트 헤드 캐리지가 원래 위치로 돌아온 다음 헤드 청소가 시작됩니다. 헤드 청소가 완료되고 짧
은 비프음이 두 번 울리면 작업이 완료된 것입니다.
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냄세제거기 필터 교체

냄세제거기 필터는 매년 교체하는 것이 좋습니다. 그러나 사용 횟수에 따라 탈취 성능이 저하됩니다. 기기 
근처에서 냄새가 나기 시작하면 사용 기간이 1년 미만이더라도 필터를 교체하십시오.

필터 취급

• 필터를 떨어뜨리거나 충격을 가하면 파손될 수 있습니다. 조심해서 다루십시오.
• 필터 앞면과 뒷면을 만지거나 기울이면 활성탄이 손에 달라붙거나 바닥으로 떨어질 수 있습니다. 주변을 오염시키지 

않도록 취급하십시오. 또한 필요한 경우 장갑을 사용하십시오.

MEMO

필수항목

필터

이 절차에 대한 참조 비디오를 보려면 다음 링크를 사용하십시오. 전반적인 작업 흐름을 이해하려면 이 비디오를 시청하는
것이 좋습니다.
https://youtu.be/LXL6ymGf8u0

MEMO

절차

1. 서브 전원을 끄고 메인 전원을 끄십시오.

2. 전면 커버를 엽니다.

3. 냄세제거제 앞에 수동 헤드 클리닝 도구를 보관해 둔 경우에는 옮겨주십시오.

4. 필터 상단의 필터 홀더(A)를 들어올리고(①) 필터를 앞쪽으로 당겨(②) 제거합니다. 

필터 홀더 끝에 있는 고무를 잡고 필터를 들어 올리십시오.
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5. 원형 패턴이 있는 쪽이 자신을 향하도록 새 필터를 설치하십시오.

다음 그림에 표시된 방향으로 필터를 설치하십시오. 뒤로 설치하면 필터의 수명이 단축됩니다.

IMPORTANT
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인쇄 결과가 거친 경우

노즐 막힘이나 노즐 변형이 있습니까?
노즐 검사를 실시하여 노즐 막힘 또는 노즐 변형이 발생하지 않는지 확인하십시오. 노즐 막힘 또는 노즐 변형
이 있는 경우 헤드 클리닝을 수행하십시오.

P. 160 노즐 막힘이나 노즐 변형이 발생한 경우
인쇄 시 적절한 설정이 선택되어 있습니까?
인쇄 시 선택한 [Media Type] 및 [Print Quality]에 따라 인쇄 품질이 거칠어 보일 수 있습니다. 인쇄 시 설
정을 확인하십시오.
프린터 설치 장소가 적절합니까?
기울어지거나 흔들리거나 진동이 발생할 수 있는 위치에 기기를 설치하지 마십시오. 또한 직사광선에 노출
되는 장소에는 기기를 설치하지 마십시오.
그렇게 하면 노즐 막힘, 노즐 변형 또는 인쇄 품질 저하와 관련된 기타 문제가 발생하거나 오작동이 발생할 
수도 있습니다.
개체가 올바르게 장착되었습니까?
개체를 올바르게 장착하지 않으면 인쇄에 부정적인 영향을 미칠 수 있습니다. 다음을 확인하십시오.

• 개체가 제자리에 단단히 고정되어 있습니까?
• 개체의 높이 설정이 정확합니까?

관련된 링크
・ P. 160 노즐 막힘이나 노즐 변형이 발생한 경우
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인쇄물에 가로 밴딩이 발생하는 경우

노즐 막힘이나 노즐 변형이 있습니까?
노즐 검사를 실시하여 노즐 막힘 또는 노즐 변형이 발생하지 않는지 확인하십시오. 노즐 막힘 또는 노즐 변형이 
있는 경우 헤드 클리닝을 수행하십시오.

P. 160 노즐 막힘이나 노즐 변형이 발생한 경우
인쇄가 도중에 일시 중지되었습니까?
인쇄가 도중에 일시 중지된 후 인쇄를 다시 시작하면 인쇄 영역에 가로 줄무늬가 나타날 수 있습니다. 인쇄를 
일시 중지하지 마십시오.
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색상이 불안정하거나 고르지 않은 경우

잉크 카트리지를 설치하기 전에 흔들었습니까?

새 잉크 카트리지를 설치하기 전에 흔들 때 수평으로 약 5 cm (1.97 in.)의 간격으로 50회(약 20초) 흔듭니다.

화이트 잉크의 경우 하루 작업을 시작하기 전에 잉크 카트리지를 꺼내서 가로 방향으로 약 5 cm (1.97 in.)
의 간격으로 50회(약 20초) 흔든 후 다시 삽입하십시오.

잉크 카트리지를 흔들어 잉크를 혼합한 후에도 여전히 색상이 고르지 않습니까?
잉크 카트리지를 흔들어 잉크를 혼합한 후에도 화이트 잉크에서 색상 불균일 문제가 계속 발생하는 경우 색
상이 고르지 않은 문제가 발생할 경우(화이트 잉크)의 2단계 및 후속 단계를 수행하십시오.
작동 매개변수가 적절한 값으로 설정되어 있습니까?
[Printing Movement Range]에 따라 색상이 불안정할 수 있습니다. 설정을 변경한 경우 [Full Width]로 설
정해 보십시오.

P. 120 프린트 헤드 캐리지 이동 최소화
인쇄가 도중에 일시 중지되었습니까?
인쇄가 일시 중지된 경우 인쇄를 다시 시작하면 재 시작 부분의 색상이 변경될 수 있습니다. 인쇄를 일시 중지
하지 마십시오.
컴퓨터에서 데이터가 충분히 빨리 전송되지 않으면 인쇄가 일시 중지될 수도 있습니다. 인쇄가 진행되는 동안 
컴퓨터에서 다른 작업을 수행하지 않는 것이 좋습니다.
프린터가 수평이고 안정된 위치에 설치되어 있습니까?
기울어지거나 흔들리거나 진동이 발생할 수 있는 위치에 기기를 설치하지 마십시오. 그렇게 하면 인쇄 품질
이 저하될 수 있습니다.
UV-LED 램프의 조사창의 표면이 더럽습니까?
조사창의 표면이 더러우면 잉크 접착력과 인쇄물 품질이 저하될 수 있습니다. 오염 정도를 확인하고 적절한 
시기에 청소해 주십시오.

P. 175 UV-LED 램프 청소
운영 환경의 변화가 심한 장소에서 인쇄하고 있습니까?
인쇄가 진행되는 동안 온도나 습도의 변화가 크면 인쇄 도중에 색상이 변할 수 있습니다. 인쇄 시 온도와 습도가 
안정적인 장소에서 기기를 사용하십시오.
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인쇄 소재가 오염되는 경우

프린트 헤드가 더럽습니까?
다음과 같은 경우 인쇄 중에 인쇄할 개체에 잉크가 떨어질 수 있습니다.

• 프린트 헤드 주변에 섬유질 먼지(보푸라기)가 쌓입니다.
• 프린트 헤드가 개체와 접촉하고 잉크가 프린트 헤드에 달라붙습니다.

이런 경우에는 수동 헤드 클리닝을 수행하십시오.
설치 장소의 습도가 너무 낮나요?
35~80% RH(단, 결로가 없을 것)의 환경에서 사용하십시오.

관련된 링크

・ P. 167 수동 헤드 클리닝
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잉크 날림/노즐 막힘/잉크 번짐 또는 뚝뚝 떨어지는 현상이 발생하는 경우

개체에 정전기가 있습니까?

개체에 정전기가 있으면 프린트 헤드가 잉크를 올바르게 분사할 수 없습니다. 결과적으로 미스트 발생, 노
즐 막힘, 개체 오염, 잉크 번짐, 잉크 떨어짐 등의 문제가 발생할 수 있습니다.

정전기를 제거하고 정전기 발생을 방지하려면 다음 작업을 수행하십시오.

• 작업자의 정전기를 제거하십시오.
작업자는 정전기 발생에 강한 옷과 신발을 착용해야 하며, 개체를 만지기 전에 벽이나 기타 표면을 만져 
작업자의 정전기를 방전시켜야 합니다.

• 개체에서 정전기를 제거하십시오.
보호 시트나 필름을 대상물에서 떼어내면 대상물에 정전기가 발생하기 쉽습니다. 정전기 제거 브러시나 
정전기 방지 천을 사용하여 개체의 정전기를 방전시키십시오.

• 정전기 발생을 방지하려면 프린터 주변을 가습하십시오.
낮은 온도와 습도는 정전기 발생에 도움이 됩니다. 예를 들어 가습기로 실내를 가습하는 등 35~80% 
RH(결로 없을 것) 환경에서 기기를 사용하십시오.
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잉크 접착력이 좋지 않은 경우

프라이머를 사용하셨나요?
프라이머를 사용하면 잉크 접착력이 향상될 수 있습니다. FlexiDESIGNER에서 인쇄 데이터를 생성한 후 
[Print parameters]에서 "프라이머 사용"을 선택합니다.
인쇄면이 더러워졌나요?
인쇄 표면이 더러우면 잉크 접착력이 약해집니다. 대상물을 장착한 후, 무수에탄올이나 이소프로필알코올을 
사용하여 인쇄면의 기름기를 제거하십시오.
UV-LED 램프 조사창의 표면이 더럽습니까?
조사창 표면이 잉크 미스트나 기타 오염 물질로 더러워지면 UV 조사광이 감소되어 잉크 접착력이 저하될 수 
있습니다. UV-LED 램프 청소를 수행하십시오.
주변온도가 너무 낮나요?
실내 온도가 낮거나 에어컨 바람에 직접 노출되는 곳 등 기기 내부 및 주변 온도가 낮으면 잉크 접착력이 저
하될 수 있습니다. 인쇄하는 동안 주변 온도는 20~32 ℃ (68~89.6 ℉, 22 ℃ [71.6 ℉] 이상 권장)로 설정
되어야 합니다.
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정렬 마커를 사용한 인쇄 위치가 잘못 정렬되는 경우

개체가 너무 두꺼운가요?

두꺼운 개체를 올려놓은 후 정렬 마커의 이미징을 수행할 때, 동일한 인쇄 영역에서도 개체가 두꺼울수록 
플랫 테이블의 크기에 비해 이미징에서 더 확대됩니다. 이는 촬영할 때 멀리 있는 사람은 작게 보이고 가까
이 있는 사람은 크게 보이는 것과 같은 원리입니다.

얇은 개체 두꺼운 개체

a
c

b

ab
a’

c’
b’

b’ a’

정렬 마커는 최대 인쇄 영역의 힌색 라인(210 mm × 148 mm [8.26 in. × 5.82 in.]) 내부에 인쇄되기 때
문에 개체를 FlexiDESIGNER로 들여올 때 실제 크기(a, c)보다 큰 크기(a', c')로 인식되고 그에 따라 여백
이 줄어듭니다(b⇒b').

그러면 FlexiDESIGNER에서 인쇄 데이터를 생성할 때 개체의 실제 인쇄 크기보다 큰 크기를 기준으로 데이
터가 생성됩니다. 확대된 인쇄 영역에서 생성된 데이터는 실제 크기로 인쇄되므로 인쇄 위치가 어긋나거나 
확장되는 현상이 발생합니다.

따라서 두꺼운 물체에 인쇄할 경우에는 물체가 확대된다는 가정 하에 인쇄 데이터를 생성할 필요가 있습니
다. FlexiDESIGNER 화면에 비해 작은 인쇄 데이터를 생성하려면 다음을 참조하십시오.

• 두께가 10 mm (0.39 in.)이고 너비가 150 mm (5.90 in.)인 개체: 최대 약 6 mm (0.23 in.)
• 두께가 30 mm (1.18 in.)이고 너비가 150 mm (5.90 in.)인 개체: 최대 약 17 mm (0.66 in.)

이미징 위치와 인쇄 위치가 잘못 정렬되어 있습니까?

카메라 중앙 위치(a)에서 왼쪽/오른쪽/앞/뒤까지의 거리가 멀수록 오정렬이 커집니다(c와 c' 사이의 오정렬이 
b와 b' 사이의 오정렬보다 큽니다).

a ab c b’ c’

정렬 마커 및 인쇄할 개체를 이미징하는 경우 어긋나기를 원하지 않는 위치(d) 바로 위에서 이미징을 수행
하십시오. 그런 다음 물체를 측정하고 인쇄 크기(e)를 결정한 후 인쇄 데이터를 생성합니다.
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dd
e

e

이미징이 수행되는 위치가 높을수록 정렬 불량은 작아지지만 정렬 마커를 읽는 것이 더 어려워질 수 있습니다. 
최적의 이미징 높이는 카메라마다 다르므로 이미징을 여러 번 수행하여 오정렬 정도와 판독값 간의 적절한 균
형을 찾으십시오.
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정렬 마커를 읽을 수 없는 경우

이미지에서 정렬 마커의 초점이 맞지 않습니다.
이미지에서 정렬 표시의 초점이 맞지 않으면 판독이 불가능할 수 있습니다. 정렬 마커에 초점을 맞춰 이미징을 
수행합니다.
이미징을 수행하는 장소가 너무 밝거나 어둡습니다.
너무 밝은 곳에서 이미징을 수행하면 정렬 마커의 검정색 부분(A)을 인식할 수 없으며, 지나치게 어두운 곳
에서 이미징을 수행하면 흰색 부분(B)을 인식할 수 없습니다.

A B

지나치게 밝거나 어두운 장소에서 이미징을 수행하면 정렬 마커를 읽을 수 없으며 이미지 변환이 실패합니다.
정렬 마커에 빛나는 빛을 조정하여 이미징을 수행합니다.

• 플랫 테이블을 낮추거나 올려서 조정
• 방 밝기 조정
• 광원 위치 또는 프린터 위치 조정
• 카메라 노출 조정

4개의 정렬 마커 사이의 밝기 차이는 상당합니다.

각 마커에 대해 동일한 밝기 수준으로 4개의 정렬 마커 이미징을 수행하지 않으면 일부 위치가 인식되지 않을 
수 있습니다. 4개의 마커가 모두 인식되지 않으면 이미지 변환이 실패합니다.

4개의 정렬 마커의 밝기가 동일한지 확인하여 이미징을 수행합니다.

• 플랫 테이블을 낮추거나 올려서 조정
• 광원 위치 또는 프린터 위치 조정
• 광원에서 나오는 빛을 늘리거나 줄여 조정

정렬 마커와 테이프의 색상 차이는 미미합니다.
[Print White Alignment Marker Background] 확인란을 선택 취소한 경우 테이프 색상을 흰색으로 인식할 
수 없으면 이미지 변환이 실패합니다.
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[Print White Alignment Marker Background] 확인란을 선택한 후 정렬 표시를 다시 인쇄합니다.
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프린터 장치가 작동하지 않는 경우(인쇄되지 않는 경우)

인쇄 데이터에 문제가 있어 프린터가 작동하지 않습니다.
인쇄 데이터가 인쇄 영역보다 크면 인쇄할 수 없습니다. 인쇄 데이터와 인쇄 영역을 확인하고 너무 큰 것을 
변경하십시오.
유틸리티, 네트워크, 기기 또는 기타 기술적인 문제가 있어 프린터가 작동하지 않습니다.

절차

1. 유틸리티에서 알림/오류/치명적인 오류를 확인한 후 필요한 조치를 취하십시오.

2. 인쇄 데이터가 정상적으로 전송되었는지 확인하십시오.

[Send to Device] 대화 상자에서 사용할 기기가 선택되어 있는지 확인합니다.

3. BD-8이 두 대 이상인 경우 사용 중인 기계가 Roland DG Connect Hub에서 올바르게 선택되었는지 확인 
하십시오.

4. LAN 케이블 커넥터의 상태 LED가 녹색으로 켜져 있는지 확인하십시오.
LAN 케이블 커넥터의 상태 LED(A)가 녹색으로 켜지지 않으면 네트워크 연결이 제대로 이루어지지 
않은 것입니다. 네트워크 라우팅이 적절한지 확인하십시오. 컴퓨터와 기기를 동일한 허브에 연결하
거나 크로스 케이블을 사용하여 직접 연결해 보십시오. 이로 인해 출력이 가능해진다면 네트워크 자
체에 문제가 있다는 뜻입니다.

네트워크에서 데이터를 수신하는 동안 상태 LED 상단의 활동 LED가 주황색으로 깜박입니다.

MEMO

5. LAN 네트워크 설정이 올바른지 확인하십시오.
이더넷 커넥터의 상태 LED(녹색)가 켜져 있어도 인쇄할 수 없는 경우 IP 주소 및 기타 설정이 적절한
지 확인하십시오. 기기와 컴퓨터 모두의 설정이 적절해야 합니다.
설정을 다시 실행하여 IP 주소가 네트워크의 다른 장치의 IP 주소와 충돌하지 않는지, RIP 소프트웨
어에 대한 포트 설정이 시스템에 설정된 IP 주소를 지정하는지, 설정에 입력 오류가 없는지 등을 확
인합니다.

6. 서브 전원이 켜져 있는지 확인하십시오.

서브 전원 버튼이 빨간색으로 켜지지 않는지 확인하십시오.
P. 15 서브 전원 버튼의 램프로 표시되는 기기의 상태

기기 문제
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7. 전면 커버와 유지보수 커버가 닫혀 있는지 확인하십시오.

8. 서브 전원을 껐다가 다시 켠 후 인쇄 작업을 다시 수행하십시오.

여전히 인쇄할 수 없는 경우 공인 대리점에 문의하십시오.
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프린트 헤드 캐리지가 움직이지 않는 경우

프린트 헤드 캐리지가 플랫 테이블 위에서 멈췄습니다.
프린트 헤드가 마르지 않도록 아래 절차에 따라 프린트 헤드 캐리지를 대기 위치로 되돌립니다.
같은 문제가 다시 발생하면 공인 대리점에 문의하십시오.

절차

1. 유틸리티에서 알림/오류/치명적 오류를 확인한 후 필요한 조치를 취하십시오.

2. 서브 전원을 껐다가 다시 켜십시오.

• 프린트 헤드 캐리지가 홈 위치(오른쪽)로 이동하면 복구가 성공적으로 종료된 것입니다.
• 프린트 헤드 캐리지가 여전히 움직이지 않으면 다음 단계를 진행합니다.

3. 서브 전원을 끄고 메인 전원을 끈 다음, 메인 전원을 다시 켜고 서브 전원을 켜 보십시오.

• 프린트 헤드 캐리지가 홈 위치(오른쪽)로 이동하면 복구가 성공적으로 종료된 것입니다.
• 프린트 헤드 캐리지가 여전히 움직이지 않으면 다음 단계를 진행합니다.

4. 와이퍼와 펠트 와이퍼의 위치를 확인하십시오.

• 와이퍼나 펠트 와이퍼가 프린트 헤드에 닿은 경우 기기를 그대로 두고 공인 대리점에 문의
하십시오.

• 다음 그림과 같이 와이퍼(A)와 펠트 와이퍼(B)가 프린트 헤드*1에 닿지 않는 위치에 있는 경우 
다음 단계를 진행하십시오.

5. 아래 절차에 따라 프린트 헤드 캐리지를 이동하십시오.
이 작업은 프린트 헤드가 건조되는 것을 방지하기 위한 응급 조치입니다. 이 작업을 수행한 후 공인 
대리점에 문의하십시오.
(1) 서브 전원과 메인 전원을 끄고 전면 커버를 엽니다.

(2) 그림에 표시된 위치(잉크 슬롯 옆)를 터치하여 정전기를 방전시킵니다.

*1 위치가 점선보다 낮으면 프린트 헤드와 와이퍼 또는 펠트 와이퍼가 접촉되지 않습니다.
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(3) 프린트 헤드 캐리지를 손으로 오른쪽으로 천천히 이동합니다.

프린트 헤드 캐리지는 위치 ①에 도달하면 멈춥니다. 프린트 헤드 캐리지는 이 위치에서 약 15 
mm (0.59 in.) 더 이동한 후 위치 ②에 고정됩니다.

기기 문제
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플랫 테이블이 움직이지 않는 경우

높이 및 인쇄 영역 설정 시 플랫 테이블이 작동을 멈췄습니다. 

절차

1. 유틸리티에서 알림/오류/치명적 오류를 확인한 후 필요한 조치를 취하십시오.

2. 전면 커버와 유지보수 커버가 닫혀 있는지 확인하십시오.

3. 플랫테이블의 하부와 전후 가동부품을 확인하여 이물질이 끼이지 않는지 확인하십시오.
발견된 이물질을 제거하십시오.

4. 서브 전원을 껐다가 다시 켠 후 설정을 다시 구성하십시오.

기기 문제
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Roland DG Connect Hub에 프린터가 표시되지 않는 경우

Roland DG Connect Hub가 설치된 PC와 프린터가 동일한 서브넷에 있지 않습니다.

해당 PC와 프린터는 동일한 서브넷에 위치해야 합니다. 자세한 내용은 네트워크 관리자에게 문의하십시오.

Roland DG Connect Hub가 설치된 PC와 프린터는 동일한 서브넷에서 사용할 수 없습니다.

문제의 PC를 프린터에 직접 연결하십시오. 연결 및 설정에 대한 자세한 내용은 "설치 및 초기 설정"을 참조
하십시오.

관련된 링크
・ BD-8 설치 및 초기 설정

Roland DG Connect Hub가 "Loading"에서 변경되지 않는 경우

Windows 방화벽이 통신을 허용합니까?
방화벽 설정을 확인하십시오.

관련된 링크
・ 지원 사이트

네트워크 문제
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두껍고 투명한 물체에 인쇄하기

두께가 20 mm (0.79 in.) 이상인 투명한 물체는 더 자주 청소해야 합니다. 인쇄 중에 청소를 방지하려면 
다음과 같이 인쇄 데이터를 생성하십시오.

• 세로 방향으로 긴 인쇄 데이터를 생성한 다음 인쇄 영역을 세로로 배열하여 인쇄합니다.
너비가 100 mm (3.94 in.) 이하인 경우 청소할 때까지 시간을 늘릴 수 있습니다.

• CMYK 위 또는 아래에 화이트를 인쇄하는 경우 화이트 레이어와 CMYK 레이어를 별도로 인쇄하십시오. 
FlexiDESIGNER 소개: https://downloadcenter.rolanddg.com/BD-8

품질 개선 섹션
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개체의 색상에 영향을 받지 않고 인쇄(베이스에 화이트 색상 인쇄)하기

어두운 색상의 개체에 직접 인쇄할 경우 베이스를 숨기기 어려워지고 CMYK 색상이 제대로 발색되지 않
습니다. 또한, 투명한 물체는 빛이 물체를 통과할 수 있게 하여 CMYK 색상 전개가 불량해지는 결과를 
낳습니다. CMYK 발색을 좋게 하려면 베이스에 화이트 잉크로 인쇄하십시오.

JPEG 등의 사진 데이터 크기에 대해서는 화이트 레이어를 생성할 수 없습니다. FlexiDESIGNER에서 도형으로 마스크를 
씌우면 해당 도형에 맞는 화이트 레이어를 생성할 수 있습니다.

MEMO

절차

1. FlexiDESIGNER에서 CMYK 인쇄 데이터를 생성합니다.

여기에서 생성된 인쇄 데이터에는 베이스용 화이트 레이어를 생성할 필요가 없습니다.

2.         를 클릭합니다.

[Send to Device] 창이 나타납니다.

3. [Print parameters]를 클릭합니다.

4. [Quality] 탭의 [Quality Settings]에서 다음을 설정합니다.

• [Media Type]: 사용자의 선택
• [Print Quality]: 사용자의 선택
• [Mode]: [White⇒CMYK]

5. [Special Color Plate Generation]에서 [White Plate Generation] 확인란을 선택합니다.

6. [Generated Pattern]에서 다음을 선택합니다.

• [Print Area]: CMYK 레이어 아래에 화이트 레이어가 생성됩니다.
• [Outside Print Area]: CMYK 레이어 외부에 화이트 레이어가 생성됩니다.
• [Entire Image]: 전체 인쇄 영역에 대해 화이트 레이어가 생성됩니다.

7. 화이트 레이어의 크기를 조정하는 경우 [Size Correction]에서 [Yes]를 선택합니다.

[Size Correction]을 적용하면 화이트 레이어가 약간 작아집니다.

8. 창을 닫으려면 [OK]를 클릭합니다.

9. [Send to Device] 창에서 [Send]를 클릭하십시오.

인쇄 데이터가 프린터로 전송된 후 인쇄가 시작됩니다.

관련된 링크
・ FlexiDESIGNER 소개
・ P. 87 인쇄 매개변수(FlexiDESIGNER)

품질 개선 섹션
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고르지 않은 표면에 인쇄하기

예를 들어 인쇄 표면이 2 mm (0.08 in.) 이상 고르지 않은 경우 거리 모드로 인쇄합니다.

FlexiDESIGNER로 인쇄 데이터를 생성한 후 [Print parameters]를 클릭하고 [Quality] 탭의 [Quality 
Settings]>[Media Type]에서 [Generic Distance] 또는 [Generic Distance with Primer]를 선택합니
다.

품질 개선 섹션
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시판하는 애플리케이션 소프트웨어를 사용하여 인쇄하기

기존 데이터(.ai, .pdf 등)를 활용하거나 시중에서 판매하는 응용 프로그램 소프트웨어(Adobe Illustrator, 
CorelDRAW 등)를 사용하여 인쇄하는 인쇄 절차입니다.

절차

1. 시중에서 판매하는 응용 프로그램 소프트웨어를 사용하여 인쇄 데이터를 생성합니다.

VersaWorks로 가져올 수 있는 파일 형식(PDF, EPS 및 유사한 형식)으로 파일을 저장합니다.

2. 개체를 Setup합니다.

3. VersaWorks를 시작하려면 아래 절차를 따르십시오.

(1) Roland DG Connect Hub를 시작하십시오.

•  Windows 11
i. [시작]>[모든 앱]을 클릭합니다.
ii. 앱(프로그램) 목록에서 [Roland DG Corporation]>[Roland DG Connect Hub]를 

클릭합니다.
•  Windows 10

i. [시작]을 클릭합니다.
ii. 앱(프로그램) 목록에서 [Roland DG Corporation]>[Roland DG Connect Hub]를 

클릭합니다.
(2) 사용할 기기(BD-8)를 클릭합니다.

(3) VersaWorks의 [Open]을 클릭하십시오.

4. VersaWorks를 사용하면 다양한 설정을 구성하여 인쇄할 수 있습니다.

• 기기가 등록되지 않은 경우 설치 가이드를 참조하여 기기를 등록하십시오.
• VersaWorks 사용 방법에 대한 자세한 내용은 VersaWorks 도움말을 참조하십시오.

관련된 링크
・ BD-8 설치 설명서
・ VersaWorks 도움말

유용한 기능 섹션
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유틸리티 홈 화면에서      을 클릭하면 알림을 확인할 수 있습니다. 알림이 있으면 해당 번호가 아이콘에 
표시됩니다.

[When output, cleaning, and other operations are completed, discard the dis-
charged fluid.]

이 메시지는 배출된 폐 잉크가 일정량의 드레인 팩에 모일 때 나타납니다.

드레인 카트리지를 제거한 후, 유틸리티 창의 지시에 따라 배출된 폐 잉크를 폐기하십시오.

이 메시지가 표시되는 시점은 드레인 팩의 사용 한계에 아직은 도달하지 않은 것입니다. 예를 들어 교체용 
드레인 팩을 쉽게 구할 수 없는 경우에도 계속 사용할 수 있습니다.

그러나 드레인 팩이 수명 한계에 도달하면 [Replace the drain pack.]이 표시됩니다. 이 오류가 나타나면 
드레인 팩을 더 이상 사용할 수 없으므로 [When output, cleaning, and other operations are 
completed, discard the discharged fluid.]가 나타나면 가능한 한 빨리 배출된 폐 잉크를 폐기하십시오.

관련된 링크
・ P. 188 드레인 팩 교체

[The drain cartridge was removed.]

이 메시지는 드레인 카트리지를 제거하면 나타납니다.
배출된 폐 잉크의 폐기가 끝나면 가능한 한 빨리 드레인 카트리지를 설치하십시오.

이 메시지는 드레인 카트리지의 돌출부가 손상된 경우 나타납니다.
아래 원 안의 돌출부가 낙하 또는 기타 원인으로 손상된 경우 드레인 카트리지가 설치된 것으로 인식될 수 
없습니다.
드레인 카트리지를 새 것으로 교체하십시오.

[The time for manual cleaning has arrived.]

수동 청소를 수행해야 할 때 이 메시지가 나타납니다.

[The time for manual cleaning has arrived.]의          을 클릭하고 수동 헤드 클리닝을 수행합니다.

관련된 링크
・ P. 167 수동 헤드 클리닝

알림
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[Perform manual cleaning.]

[The time for manual cleaning has arrived.]가 표시된 후에도 수동 헤드 클리닝을 수행하지 않고 기기
를 계속 사용하면 이 메시지가 나타납니다.

이 알림이 표시되면 개체를 Setup할 수 없습니다.

[Perform manual cleaning.]에서           를 클릭하고 수동 헤드 클리닝을 수행합니다. 

Setup을 시도하면 [Manual Cleaning Required for Printing required] 메시지가 나타납니다. [OK]를 클릭
하면 수동 헤드 클리닝 화면으로 전환됩니다.

[The time for wiper replacement has arrived.]

와이퍼 교체 시기가 되면 이 메시지가 나타납니다.

와이퍼를 교체하려면 [The time for wiper replacement has arrived.] 옆의          를 클릭합니다. 

관련된 링크
・ P. 192 와이퍼 교체

[The time for felt wiper replacement has arrived.]

펠트 와이퍼 교체 시기가 되면 이 메시지가 나타납니다.

펠트 와이퍼를 교체하려면 [The time for felt wiper replacement has arrived.] 옆의          를 클릭합니다. 

관련된 링크
・ P. 194 펠트 와이퍼 교체

[The time for cap top replacement has arrived.]

캡탑을 교체할 시기가 되면 이 메시지가 나타납니다.

[The time for cap top replacement has arrived.] 옆의          를 클릭하고 캡탑을 교체합니다. 

관련된 링크
・ P. 196 캡탑 교체

[Print head protection mode has activated.]

이 메시지는 사용 중인 잉크가 Roland DG Corporation의 정품 잉크가 아닐 때 나타납니다.

최적의 성능을 얻으려면 Roland DG Corporation의 정품 잉크를 사용할 것을 권장합니다. 잉크를 구입
하려면 공인 대리점에 문의하십시오.

[The time for ink mixing has arrived.]

이 메시지는 화이트 잉크를 혼합해야 할 때 나타납니다.

알림
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절차

1. [The time for ink mixing has arrived.] 아래의            를 클릭합니다.

2. 화이트 잉크 카트리지를 빼내고 잉크 카트리지 양쪽 끝에서 약 5 cm (1.97 In.)의 수평 간격으로 50회(약 20초) 
흔든 후 다시 삽입합니다.

3. [Was the white ink mixed?] 창이 나타나면 [Yes]를 클릭합니다.

[The connection to the unit was lost.]

이 메시지는 다음 상황 중 하나가 감지될 때 나타납니다.

• 이 기기의 메인 전원이 꺼지는 경우
• 이 기기의 IP 주소가 변경되는 경우
• 이 기기와 컴퓨터를 연결하는 LAN 케이블이 분리되는 경우

이 기기의 상태를 확인한 다음 복구 작업을 수행하십시오. 메인 전원을 차단하면 자동 유지보수 기능이 
작동하지 않아 오작동이 발생할 수 있습니다. 항상 메인 전원을 켜두십시오.

[There is ink that has expired.]

이 메시지는 유효기간이 만료된 잉크 카트리지가 있는 경우 나타납니다. 

절차

1. 알림 창을 클릭합니다.

잉크 정보 창이 나타납니다.

2. 유효기간이 지난 잉크 카트리지를 교체하십시오.

관련된 링크
・ P. 185 잉크 카트리지 교체

[The time for manual cleaning of the UV lamp has arrived.]

수동 헤드 클리닝을 수행해야 할 때 이 메시지가 나타납니다.

[The time for manual cleaning of the UV lamp has arrived.]에 대해          를 클릭하고 UV 램프 청소를 
수행합니다.

관련된 링크
・ P. 174 UV-LED 램프 청소

알림
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[Ink Cartridge Error]

이 메시지는 다음 잉크 카트리지 오류 중 하나가 감지되면 나타납니다.

오류가 발생하면 화면에서 해당 잉크 종류 옆에     ,    ,     또는     아이콘이 표시됩니다.

MEMO

오류에 따라 적절한 조치를 취하십시오.

• 잉크가 부족한 경우
:[Ink has run out.]

잉크 카트리지를 새 것으로 교체하십시오.
• 잉크가 거의 남지 않은 경우

:[Remaining ink level low.]
잉크가 없으면 인쇄가 불가능합니다. 이 메시지가 나타나면 교체용 잉크 카트리지를 준비하십시오.

• 잉크의 유효기간이 지난 경우
:[There is ink that has expired.]

유효기간이 지난 잉크로 인쇄할 수 있더라도 다음과 같은 문제 및 오작동이 발생할 수 있습니다. 
이 메시지가 나타나면 잉크를 교체하는 것이 좋습니다.

• 잉크 카트리지에서 잉크가 새어 나옵니다.
• 잉크 점도가 증가하여 잉크 분사 문제가 발생합니다(이로 인해 출력 품질이 저하될 수 있습니다.).
• 잉크가 굳어 프린터가 오작동할 수 있습니다.

• 잉크 카트리지를 제거한 경우
   :[Ink cartridge was removed.] 
제거한 잉크 카트리지를 장착합니다.

• 잘못된 색상의 잉크 카트리지를 넣은 경우
:[Incorrect ink cartridge was loaded.]

잘못 장착된 잉크 카트리지를 제거한 다음 올바른 잉크 카트리지를 장착하십시오. 잉크 카트리지를 
제거하면    : [Ink cartridge was removed.]가 표시됩니다.

[Cover Open Error]

전면 커버, 유지보수 커버 또는 두 커버가 모두 열려 있는 경우 나타납니다.
안전을 위해 작동 중 커버를 열면 기기가 정지할 수 있습니다. 
모든 커버를 닫습니다.

[Manual Cleaning Tool Error]

수동 헤드 클리닝 중이 아닌 시점에 장착된 수동 헤드 클리닝 도구가 감지된 경우 표시됩니다. 수동 헤드 
클리닝 도구를 즉시 제거하십시오.

오류
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[Rotary Mode Mismatch Error]

로터리 축 유닛 장착/제거 메뉴를 사용하지 않고 로터리 축 유닛을 장착하거나 제거할 때(커넥터가 분리되
거나 연결되었을 때) 표시됩니다. 커넥터 연결 실패 시에도 표시됩니다.

로터리 축 유닛을 장착하거나 제거할 때는 반드시 [Preferences]>[Rotary Unit Attachment/Removal]에
서 수행하십시오. 또한 장착 시 커넥터를 단단히 연결하십시오.

[Flat Table Height Error]

이 메시지는 헤드 갭 센서가 개체에 닿을 때 나타납니다.

인쇄하지 않는 작업 중에 개체, 고정 테이프, 리테이너 등이 헤드 갭 센서에 접촉하면 표시됩니다.

Clearance 설정이 [Stop]인 경우 인쇄 중 개체의 높이 오류가 감지되면 표시되고 인쇄가 중지됩니다.

Clearance 설정이 [Readjust]일 때 인쇄 중 개체의 높이 오류가 감지되고 테이블을 [Maximum Value 
(Threshold)]로 낮춰도 문제가 해결되지 않으면 표시되고 인쇄가 중지됩니다. 

이러한 모든 경우에 개체가 올바르게 Setup되었는지 또는 개체의 크기가 장착할 수 있는 크기를 초과하지 
않는지 확인하십시오. 개체를 올바르게 Setup하거나 장착할 수 있는 크기의 인쇄 가능한 개체를 장착하십
시오.

[Print Data Larger Than Printing Area]

인쇄 데이터 대비 인쇄 영역이 충분하지 않은 경우 이 메시지가 표시됩니다.

인쇄 영역이나 인쇄 데이터를 변경하지 않고 인쇄를 계속하려면 [Yes]를 클릭하십시오. 인쇄 영역을 벗어나는 
부분은 인쇄되지 않습니다.

인쇄를 취소하려면 [No]를 클릭하십시오. 인쇄 영역을 더 넓게 만들거나 개체를 더 큰 개체로 교체한 다음 
데이터를 다시 전송하십시오.

[Insufficient Printing Area]

노즐 검사 테스트 또는 정렬 마커 인쇄의 테스트 패턴을 위한 인쇄 영역이 충분하지 않은 경우 이 메시지
가 표시됩니다.

인쇄를 취소하려면 [OK]를 클릭하십시오. 그런 다음 인쇄 영역을 다시 설정하십시오.

[Manual cleManual Cleaning Required for Printinganing required]

[Perform manual cleaning.]이 표시된 상태에서 사용자가 개체 Setup을 시도하면 이 메시지가 나타납
니다. [OK]를 클릭하면 수동 헤드 클리닝 화면으로 전환됩니다. 수동 헤드 클리닝을 수행하십시오.

[Replace the drain pack.]

이 메시지는 드레인 팩으로 배출된 폐 잉크의 양이 지정된 양에 도달하면 나타납니다.

드레인 카트리지 내부에 있는 드레인 팩을 교체합니다.

오류
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드레인 카트리지를 분리하면 오류 메시지가 [The drain cartridge was removed.]로 변경됩니다.

MEMO

오류
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[Service Call: ]

서비스 기술자의 수리가 필요한 복구 불가능한 오류가 발생한 경우에 표시됩니다. 유틸리티에 표시된 번호
를 확인한 후 메인 전원을 끄십시오. 전원을 끈 후 유틸리티 창에 표시된 번호를 공인 대리점에 알리십시오.

[Motor Error: ]

모터 오류가 발생했습니다.

작업을 계속할 수 없습니다. 서브 전원을 끄십시오. 그런 다음 오류의 원인을 제거한 후 즉시 서브 전원을 켜
십시오.

오류를 수정하지 않은 채 기기를 방치하면 프린트 헤드가 말라서 손상될 수 있습니다. 이 오류는 개체 또는 
수동 헤드 클리닝 도구가 잘못 장착되어 발생할 수 있습니다.

[Print Head Dry-out Error]

이 메시지는 프린트 헤드가 건조되는 것을 방지하기 위해 강제로 홈 위치로 이동할 때 나타납니다.

작업을 계속할 수 없습니다. 서브 전원을 껐다가 다시 켜십시오.

[Low Temperature Error: ]

기기의 내부 온도가 기기가 작동할 수 있는 온도 이하로 떨어졌습니다.

이 메시지는 시작 시 온도가 5 ℃ (41 ℉) 이하로 떨어지거나 작동 시 2 ℃ (35.6 ℉) 이하로 떨어지면 나타납
니다.

작업을 계속할 수 없습니다. 서브 전원을 끄십시오.

설치된 장소를 작동 가능한 온도 (20 ℃ ~ 32 ℃ [68 ℉ ~ 89.6 ℉])로 가져오고 기기가 실온에 도달한 다음 
전원을 켜십시오.

관련된 링크
・ P. 50 전원 공급

[High Temperature Error: ]

기기의 내부 온도가 기기가 작동할 수 있는 온도 이상으로 상승했습니다.

이 메시지는 시작 또는 작동 중(절전 모드에서 복구할 때) 온도가 42 ℃ (107.6 ℉) 이상으로 올라갈 때 나타
납니다.

작업을 계속할 수 없습니다. 서브 전원을 끄십시오.

설치된 장소를 작동 가능한 온도 (20 ℃ ~ 32 ℃ [68 ℉ ~ 89.6 ℉])로 가져오고 기기가 실온에 도달한 다음 
전원을 켜십시오.

관련된 링크
・ P. 50 전원 공급

치명적인 오류(Fatal Error)
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[Pump Stop Error]

이 메시지는 청소 등의 펌프 작동 중에 잉크 카트리지를 빼내고 이 상태로 10분 이상 방치하면 나타납니다.

작업을 계속할 수 없습니다. 서브 전원을 껐다가 다시 켜십시오.

[Emergency Stop Error]

비상 정지 버튼을 누르면 이 메시지가 나타납니다. 서브 전원 LED가 빨간색으로 켜집니다. 

절차

1. 비상정지 버튼이 눌린 원인을 제거합니다.

2. 비상 정지 버튼을 시계 방향으로 더 이상 회전하지 않을 때까지 돌린 후 버튼을 놓습니다. 

버튼을 몸쪽으로 당기면 버튼이 해제됩니다.

3. 서브 전원 버튼을 1초 이상 길게 누르면 서브 전원이 꺼집니다. 서브 전원을 켜려면 반복하십시오.
기기가 비상 정지 상태에서 복구됩니다.

4. 노즐 검사를 수행합니다.

필요에 따라 클리닝을 수행하십시오.

관련된 링크
・ P. 64 노즐 드롭아웃 테스트 수행
・ P. 160 노즐 막힘이나 노즐 변형이 발생한 경우

치명적인 오류(Fatal Error)
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기기를 설치 위치에서 이동할 때는 [Ink Circulation]을 수행하고 플랫 테이블과 프린트 헤드 캐리지를 고정한 
후 이동하십시오.

이동 준비부터 재설치까지의 절차

플랫 테이블 뒤에 물건을 떨어뜨린 경우에는 모든 전원 스위치를 끄고 물건을 찾으십시오.
그렇지 않으면 기기가 갑자기 움직여 부상을 입을 수 있습니다.

주의

이동에 관한 중요 사항

• 기기 이동 준비가 완료되면 즉시 기기를 이동하고, 기기를 이동한 후 최대한 빨리 기기의 전원을 켜십시오. 기기를 켜지 
않고 그대로 두면 침전된 잉크가 응고되어 프린트 헤드가 막히는 등의 문제가 발생할 수 있습니다.

• 기기를 이동할 때는 온도 5~40 ℃ (41~104 ℉), 상대습도 20~80 % (결로 현상이 없을 것)를 유지하십시오. 그렇게 하지 
않으면 오작동이 발생할 수 있습니다.

• 기기를 이동할 때 기기를 조심스럽게 다루고 수평을 유지하고(기울어지지 않도록) 기기가 다른 물체에 부딪히지 않도록 
하십시오.

• 차량으로 운반할 때에는 좌석 등 기울어진 면에 기기를 놓지 말고 수평 상태를 유지하십시오.

IMPORTANT

절차

1. 유틸리티 홈 화면에서        을 클릭합니다.

2. [Maintenance]>[Ink Circulation]에서 [Execute]를 클릭합니다.

이 작업은 잉크를 순환시킵니다. 이 절차는 몇 분 정도 걸립니다.

3. 아래 절차에 따라 플랫 테이블을 가장 낮은 위치로 이동시킵니다.
로터리 축 유닛의 장착/제거 메뉴를 사용하여 플랫 테이블을 내립니다. 로터리 축 유닛이 설치되어 
있는 경우 제거합니다.

P. 131 옵션 품목 제거/장착(OA-RA-8)
4. [Preferences]>[Rotary Unit Attachment/Removal]에서 [Execute]를 클릭합니다.

플랫 테이블은 중앙 위치를 중심으로 수직 방향으로 이동합니다.
5. 전면 커버를 엽니다.

6. [Attach or remove the rotary axis unit.] 창이 나타나면 [Next]를 클릭합니다.

7. [Close all the covers.]가 표시되면 전면 커버를 닫고 [Finish]를 클릭합니다.

플랫 테이블이 가장 낮은 위치로 이동합니다.

4. 서브 전원을 끄고 메인 전원을 끄십시오.

5. 전면 커버를 열고 유지보수 커버를 제거합니다.

6. 프린트 헤드 캐리지용 리테이너(A)와 플랫 테이블용 리테이너(B)를 제거합니다. 

제공된 육각 렌치를 사용하여 리테이너를 제거합니다.

기기 이동 준비
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7. 플랫 테이블을 밀어서 후면 지지대에 닿을 때까지 이동합니다.

플랫 테이블을 천천히 움직입니다.

IMPORTANT

8. 프린트 헤드 캐리지와 플랫 테이블을 리테이너로 고정합니다.

• 프린트 헤드 캐리지

볼트가 떨어지지 않도록 조심스럽게 작업하십시오.
볼트가 플랫 테이블 아래로 떨어진 경우 다음 지침에 따라 볼트를 집어 올리십시오.

1. 플랫 테이블을 손으로 앞뒤로 움직여 볼트를 찾으십시오.
볼트를 찾을 수 없는 경우 다음 작업을 수행하여 플랫 테이블의 밑면을 찾아보십시오.

2. 노즐 검사 시험지와 같은 얇은 미디어 설치 지침에 따라 플랫 테이블을 위로 이동합니다.

MEMO

a. 육각 렌치의 긴 면에 볼트를 놓습니다. 이 리테이너를 장착하는 데 사용된 볼트를 사용
하십시오.

b. 그림에 표시된 위치에 리테이너를 배치 합니다.

c. 볼트가 장착된 육각 렌치를 사용하여 리테이너의 오른쪽 상단을 임시로 조이십시오.

기기 이동 준비
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d. 나머지 세 곳을 임시로 조이십시오.
e. 리테이너를 오른쪽으로 밀면서 볼트를 완전히 조이십시오.

아래쪽 두 곳을 가볍게 조이십시오. 강하게 조이면 리테이너가 휘어질 수 있습니다.

IMPORTANT

• 플랫 테이블
a. 그림에 표시된 위치에 플랫 테이블용 리테이너를 배치합니다. 

돌출부(A)가 구멍에 맞도록 리테이너를 배치합니다.

b. 리테이너를 뒤로 밀면서 나사를 조입니다.
이 리테이너를 장착하는 데 사용된 나사를 사용하십시오.

기기 이동 준비
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9. 유지보수 커버를 장착한 다음 전면 커버를 닫습니다.

• 자석이 붙을 때까지 유지보수 커버를 밀어 넣습니다.
• 운송 중에 전면 커버가 열리지 않도록 마스킹 테이프 등으로 고정하십시오.

10. 전원 케이블과 이더넷 커넥터를 분리하십시오.

11. 가능한 한 신속하게 기기를 옮기십시오.

12. 기기를 이동한 후 즉시 설치하십시오.

13. 프린트 헤드 캐리지와 플랫 테이블 리테이너를 제거합니다.

(1) 전면 커버를 열고 유지보수 커버를 제거합니다.

(2) 프린트 헤드 캐리지용 리테이너와 플랫 테이블용 리테이너를 제거합니다.

8단계의 역순으로 제거하십시오.
(3) 제거한 리테이너(2개)를 그림에 표시된 위치에 설치합니다.

(4) 유지보수 커버를 장착하고 전면 커버를 닫습니다.

14. 메인 전원을 켜고 서브 전원을 켜십시오.

이것으로 이동 작업이 완료됩니다.

기기 이동 준비

이동 241
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외부 치수

a 911 mm (35.87 in.) d 586 mm (23.07 in.) g 768 mm (30.24 in.)

b 580 mm (22.83 in.) e 393 mm (15.47 in.) h 194 mm (7.64 in.)

c 26.2 mm (1.03 in.) f 32 mm (1.26 in.) i 173 mm (6.81 in.)

치수 도면
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플랫 테이블 치수

A: 로터리 축 유닛 고정용 M4 구멍(OA-RA-8)
로터리 축 유닛을 사용하지 않을 때는 지그를 고정하는 데 사용할 수 있습니다.

B: 흰색 라인 내의 구멍은 사용하지 마십시오.

C: M4 구멍(*로 표시된 6개 위치) 
    지그를 고정하는 데 사용할 수 있습니다.

a 0 mm (0 in.) g 182 mm (7.17 in.) m 19 mm (0.75 in.)

b 7.5 mm (0.30 in.) h 202 mm (7.95 in.) n 26 mm (1.02 in.)

c 15 mm (0.59 in.) i 225 mm (8.86 in.) o 50 mm (1.97 in.)

d 62 mm (2.44 in.) j 232.5 mm (9.15 mil) p 150 mm (5.9 in.)

e 82 mm (3.23 in.) k 8 mm (0.31 in.) q 174 mm (6.85 in.)

f 120 mm (4.72 in.) l 11 mm (0.43 in.) r 189 mm (7.44 in.)

치수 도면
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인쇄 방식 피에조 잉크젯 방식

인쇄할 수 있는 
최대 개체 크기

너비 최대 240 mm (9.4 in.)

길이 최대 178 mm (7 in.)

두께 최대 102 mm (4 in.)

중량 최대 3 kg (6.6 lb.)

최대 인쇄 폭/인쇄 길이 최대 210 × 148 mm (8.2 in. × 5.8 in.)

잉크 유형 ECO-UV (EUV5) 220 ml 카트리지

색상 5색 (cyan, magenta, yellow, black, white) + primer

잉크 경화 장치 내장 UV-LED 램프

인쇄 해상도 (인치당 도트 수) 최대 1,440 dpi

인터페이스 이더넷 (100BASE-TX/1000BASE-T, 자동 전환)

절전 기능 자동 절전 기능

전원 요구 사항 100 - 240 Va.c. 50/60 Hz 1.1 A

전력 소모 작동 시 약 90 W

절전 모드 시 약 30 W

소음 수준 작동 시 59 dB (A) 이하

대기 중 52 dB (A) 이하

크기(가로×세로×높이) 768 mm × 586 mm × 580 mm (30.3 in. × 23.1 in. × 22.9 in.)

중량 61 kg (134.5 lb.)

사용 환경 작동 시*1 온도: 20 - 32 ℃ (68 - 89.6 ℉) (22 ℃ [71.6 ℉] 이상 권장) 
습도: 35%RH - 80%RH (결로 없을 것)

미 작동 시 온도: 5 ℃ - 40 ℃ (41 ℉ - 104 ℉) 
습도: 20%RH - 80%RH (결로 없을 것)

제공 품목 전원 코드, 클리닝 액, 사용 설명서, 소프트웨어(FlexiDESIGNER VersaSTUDIO Edition, 
VersaWorks, Roland DG Connect) 등

*1 운영 환경
(1): 이 범위 내의 작동 환경에서 사용하십시오.

F
C

68 80.6 89.6
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